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Running Reports
User level JDE Knowledge Can Design Reports Technical Knowledge

Subscriber Not needed No None required

Quick Report Designer Minimal Yes Minimal

Ad Hoc Designer Yes Yes Some

Advanced Designer Yes Yes High

Data Access Studio lets Report Designers publish reports to Subscribers. Once a report is published to
you, you are a Subscriber to that report. As a Subscriber:

You see the list of reports published to you
You can run the reports as you need
You can change the report data selection if the Publisher of the report allowed it
You cannot modify and save the report
You cannot show columns that were hidden

Subscriber-only users
If you are a subscriber-only user, then you:

Need no JDE knowledge
Choose from reports that were published to you
Change report parameters (if applicable)
Run reports
Export or print the results

This section shows you how to run reports that are published to you in the following topics:

Run reports published to you

Change parameters and data selection

Run the report

Export and print
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Run Reports Published to You
Once you have signed in to Data Access Studio:

If you are a subscriber only user, you will see the report selection screen below:

If you are a designer, click File | Open | Reports Published to me... to see the report selection
screen:

You will see one line for each report that is published to you. This form presents the report folder, report
name, and date the report was published to you.

To Do this

Open a report without
running it

Left-click the report and click Open., you may double-click the row.

Close the Select
Reports window

Click Close or click the X in the upper right-hand corner of the window.
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To Do this

Refresh the list of
reports published to
you

Click Find.

Un-publish a report If you have this permission, left-click the report and click Delete. Note: if
you are not authorized to do this operation, this button will not appear on
this screen.

Change the subscribers
for reports

If you have this permission, click the Manage Subscribers button.

Run a report Left-click the report and click Run. The report will run with the default data
selection and parameters and present you with the final result.

Save the published
report to a private
report which you can
modify

Left-click the report and click Save To Layout. Once saved, Data Access
Studio will notify you that the save was completed. You will now have a
private report named the same thing as the report you copied.Note: if you
are not authorized to do this operation, this button will not appear on this
screen.
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Opening a Report
Here are some of the features of a report that are useful after opening a report and prior to running it.

Inspecting How to use Notes
If the report was published with instructions, the 'How to use' icon will be enabled.

Change Parameters and Data Selection
If you chose to open a report, you will have the opportunity to change the data selection (if allowed) and
report parameters for that report before you run it. You can then run the report and see the result.

Here is a sample report:
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To Do this

Enter a
parameter

Click on the box next to the parameter. Use the visual assist button  to help you to
select valid values. User the filter button  for advanced selections such as lists, not
in list, ranges, etc.

Change the
filter value of a
column

You may want to restrict the values you see in a certain column. If the column is
visible and the Change filter criteria permission is allowed, you can click the gray
box below the column label to enter filter criteria. See Filter Your Data for more
information. Note: If the publisher has disallowed filter changing, you will not be
able to modify the column filter.

Enter and Edit Comments
If a report includes any Comment calculations, users many have access to edit comments in published
reports.

If a user has access to edit comments, they will see cells in that column outlined as seen below.

If a user cannot edit comments that exist, they will still see comment content written by others.
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Entering Comments as a Subscriber
To update a comment, simply type into a comment cell and hit enter or click off. The comment will
immediately be saved for all viewers of that published report.

Audit information is available for all comment cells by hovering over a cell. The tooltip will display the
user who entered the comment and at what time.

Comment Refreshing in Published Reports
Comments are refreshed in a public report to ensure the latest comments are visible in the following
scenarios:

When a report is opened
When Run Report, Get Sample Data or Refresh is selected
When a user selects Right Click > Refresh Calculations
When a comment is saved (Clicking off a typed comment, selecting tab or selecting enter)

NOTE

Be aware that updating an existing comment cell with new text will immediately remove previous
text.


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NOTE

If it has been more than 5 minutes since one of the above actions was performed, the comments
will refresh upon entering a comment cell.


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Run the Report
Once you have entered report parameters and filters, you can get sample data or run the full report. As
the report runs you will see the progress bar fill.

To Do this

See a small preview of the data without
actually running the entire report

Click the  Get Sample Data button.

Run the report over all the data Once you have entered the necessary parameters and are
ready to run the report, click  Run Report.

Stop an in progress report Click the  Cancel button. Note: you may only the click
the  Cancel button if it is enabled.
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Export and Print
Once your run completes, you will see the progress bar completely filled. You will also see the results of
your report. From here you can print or export your data.

To Do this

Print your
report

Click File > Print. Data Access Studio will format your output to PDF and show you a
preview. You can then print from the resulting PDF document.

Export your
report data to
Excel

Click  on the main toolbar. Once you export, Data Access Studio will export,
format, and save the report data to your default export directory. Data Access Studio
will then, by default, open the result of the export for you to review, save, etc.

If you have the Export menu on the main menu bar for the report you are running, then you may export
the data in the report as follows:

To Do this

Export your report data to Excel Click Export > All Grid Data > To Excel...

Export your report data to a web page
format

Click Export > All Grid Data > HTML...

Export your report data to a PDF (Adobe
acrobat) format

Click Export > All Grid Data > PDF...

Export your report data to Access or other
similar third party software

Click Export > All Grid Data > To Tab Separated
Values...

Export your report data to Oracle BI
Publisher or a similar third party software

Click Export > All Grid Data > XML...

Export your report data to Access or another
similar third party software requiring CSV
format

Click Export > All Grid Data > To CSV...

Export only selected rows or columns Select the columns or rows you want to export. Click
Export > Selected Grid Data and select your output
format.
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Drill Down
Drill downs are links between cells in one table to another table. For instance, the account balance can
drill down into a set of General Ledger entries. Data Access Studio supports drill downs as follows:

Master file drill downs
General Ledger drill downs
User-defined drill downs

Drills downs support multiple rows and drill down on summary values as well. E.g. if you want to drill into
a rollup summary value on a Balance Sheet, right-click the summary value and select Drill Down >
Transactions by account - Account Ledger DAS will show all the transactions that rolled up into that
summary value automatically.

Master file drill downs
For any cell that has a master file behind it (for instance, address book number, item number, etc.), you
can right-click the cell. On the popup menu, you will see Drill Down. When you click the drill down
selection, DAS will open the master file and show you the details for the item you selected. If you select
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multiple rows in the source table, when you click the drill down option, DAS will show you master file
records for all the items you selected.

General Ledger drill downs
See Account Ledger Drill Down.
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Account Ledger Drill Downs
These drill downs are automatically available on any new or pre-existing report over the above tables.

DAS provides many pre-defined General Ledger drill downs including the following:

Account Balances (F0902): GL over any Net Posting column, Relative Period, or Period Amount
column
Asset Balances (F1201): GL over any Net Posting column, Relative Period, or Period Amount column
Purchase Orders (F4311): GL over Order Number and Amount Received columns

Account Balances (F0902)
For any report that runs over the Account Balances table (F0902)--which includes Financial Quick
Reports, you can drill into amounts. To drill down into an amount, right-click the amount and select Drill
down > Transactions by account - Account Ledger:

DAS will open the account ledger and show you the transactions and transaction totals for the item you
drilled into. Note that you can drill into a summary as shown above or into a detail cell.
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Asset Balances (F1202)
For any report that runs over the Asset Balances table (F1202)--which includes Fixed Asset Quick Reports,
you can drill into amounts. To drill down into an amount, right-click the amount and select Drill down >
Transactions by account - Account Ledger.

Purchase Order (F4311)
For any report that runs over the Purchase Order Detail (F4311), you can drill into amounts. To drill down
into a purchase order, right-click the Order Number and select Drill down > Inventory transactions -
Account Ledger. DAS will show you the two balancing entries for the order in the Account Ledger
(F0911). The amounts shown in the Account Ledger should match up to the Amount Received column in
the Purchase Order header.

NOTE

For these pre-built drilldowns, filters such as Account ID, Century, Fiscal Year, Period Number,
Ledger Type, Posting Code, Sub-ledger and Sub Type will be included to help outline the proper
transactions to return. One reason an account might not tie out when you drilldown is if the Posting
Edit code (F0901.PEC) from the Account master table for that account is set to "S" or "Subledger &
type required-blnk".

The reason is because these 'S' accounts will pass down a blank filter in the SBL and SBLT columns.
This will filter out some or all of the transaction records for these accounts.

To resolve this issue, create a custom drilldown instead to ensure these subledger columns are not
filtered out of the drilldown transaction results.


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Quick Reports
User level JDE Knowledge Can Design Reports Technical Knowledge

Subscriber Not needed No Minimal

Quick Report Designer Minimal Yes Minimal

Ad Hoc Designer Yes Yes Some

Advanced Designer Yes Yes High

Data Access Studio empowers users with limited JDE knowledge to create a wide variety of practical
business reports. The Quick Report user typically possesses finance, payroll, sales, etc. knowledge, but
does not necessarily know where JDE stores this information.

The Quick Report system guides you through business language and options so that you can create the
reports you need.

You can access the Quick Report menu as follows:

1. Select File > New > Wizard from the menu or the report wizard button on the tool bar.
2. Select the desired Quick report from the dropdown.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 22 / 480



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 23 / 480

Financials
The Financials Quick Report allows a finance user to create reports such as:

Balance Sheet

Income Statement

Trial Balance

Budget vs. Actual

Business Unit comparison

Period, quarter, yearly comparison

and more

To get started, sign in then:

Click File | Quick Report | Financials

The Quick Report lets you specify what kind of report you want and how you want to create it.
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To Do this

Enter information on a particular tab Click the desired tab. See topics that
follow.

Create the Financial Balances report with the parameters you
specified

Click  Create report.

To exit the designer Click the back button.
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Specify Type of Financial Report
The first step in defining your report is to select what type financial report you want. Enter this
information on the Main tab:

In this version, all reports are based on the Posted balances file in JDE.

To Do this

Type of your report (Required) Select the type of financial report that you want to create. After
selecting the basic types, you can use the rest of the wizard to
customize it further (for example, you can split an Income
Statement into multiple periods or compare actuals vs. budget).

Name your report (Required) Click on the edit box next to Report name and type a descriptive
name for your report. This is a mandatory step.

If your business organizes
accounts with the category
code information in the JDE
Chart of Accounts

Click the check box labeled: I need category codes from the chart
of accounts.
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To Do this

If you need to access category
codes in the JDE Business Unit
table

Click the check box labeled: I need category codes from the
business unit master information.

Reverse sign on revenue
accounts

Depending on your JD Edwards setup, for an Income Statement or
Trial Balance, you usually will check the Reverse sign on revenue
accounts

Reverse sign on liability
accounts

Depending on your JD Edwards setup, for a Balance Sheet or Trial
Balance, you may need to reverse the sign on liability accounts by
check Reverse sign on liability accounts.

Once you are finished, click the Periods tab.
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Specify Financial Periods
You can show amounts by period, quarter, year, or Year-To-Date period. You can also compare period
amounts to amounts in previous periods or years.

To Do this

Select how to organize the
periods in your report

Pick from any of the checkboxes: Fiscal period, YTD, Fiscal quarter,
Fiscal QTD, and/or Fiscal year.

Compare a period to
previous periods

Change the Compare to previous number to the number of periods you
want to compare against. Set the option box next to the number to
Fiscal period.

Compare a period to the
same period in previous
years

Change the Compare to previous number to the number of years you
want to compare against. Set the option box next to the number to
Fiscal year.

Compare a quarter to
previous quarters

Click the Organize by option box. Select Fiscal quarter. Change the
Compare to previous number to the number of quarters you want to
compare against. Set the option box next to the number to Fiscal
Quarter.

Compare a quarter to the
same quarter in previous
years

Click the Organize by option box. Select Fiscal Quarter. Change the
Compare to previous number to the number of years you want to
compare against. Set the option box next to the number to Fiscal year.

Compare a year to
previous years

Click the Organize by option box. Select Fiscal year. Change the
Compare to previous number to the number of years you want to
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To Do this

compare against. Set the option box next to the number to Fiscal year.

Compare a Year-To-Date
amount to previous Year-
To-Date amounts

Click the Organize by option box. Select YTD. Change the Compare to
previous number to the number of years you want to compare against.
Set the option box next to the number to Fiscal year.

Split period values (such
as Budget vs. Actuals)

Check the Split column values by criteria. Once checked, see Financial
Column Rollup to specify how to split the period values.

Change the Caption for
the period columns

Select the desired caption setting from the Caption drop down.

Caption Options
The table below provides the caption types available when creating a Quick Report and examples of how
they will be generated.

Caption
Type

Organize by:
Period
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
Quarter
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
QTD
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
Year
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
YTD Fiscal
Period
Period: 8
Fiscal Year
Start:
4/1/2024

Description
and Year

<Description>
<Year>
August 2024

<Description>
<Year>
Quarter 3 2024

<Description>
<Year>
QTD 3 2024

<Year>
2024

<Description>
<Year>
YTD November
2024

Description
and Fiscal
Year

<Description>
<FiscalYear>
August 2024

<Description>
<FiscalYear>
Quarter 3 2024

<Description>
<FiscalYear>
QTD 3 2024

<FiscalYear>
2024

<Description>
<FiscalYear>
YTD November
2024

Period
Number
and Fiscal
Year

<Period>
<FiscalYear>
8 2024

<Description>
<FiscalYear>
Quarter 3 2024

<Description>
<FiscalYear>
QTD 3 2024

<FiscalYear>
2024

<Period>
<FiscalYear>
8 2024
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Caption
Type

Organize by:
Period
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
Quarter
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
QTD
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
Year
Period: 8
Fiscal Year
Start:
1/1/2024

Organize by:
YTD Fiscal
Period
Period: 8
Fiscal Year
Start:
4/1/2024

Period
Month
Description
and Year

<PeriodMonth>
<Year>
August 2024

<Description>
<Year>
Quarter 3 2024

<Description>
<Year>
QTD 3 2024

<Year>
2024

<PeriodMonth>
<Year>
YTD August
2024

Date Range <StartDate> -
<EndDate>
8/1/2024 -
8/31/2024

<StartDate> -
<EndDate>
7/1/2024 -
9/30/2024

<StartDate> -
<EndDate>
7/1/2024 -
8/31/2024

<StartDate> -
<EndDate>
1/1/2024 -
12/31/2024

<StartDate> -
<EndDate>
4/1/2024 -
11/30/2024

Start Date <StartDate>
8/1/2024

<StartDate>
7/1/2024

<StartDate>
7/1/2024

<StartDate>
1/1/2024

<StartDate>
4/1/2024

End Date <EndDate>
8/31/2024

<EndDate>
9/30/2024

<EndDate>
8/31/2024

<EndDate>
12/31/2024

<EndDate>
11/30/2024

Description,
Year, Days
in Period

<Description>
<Year>
<DaysInRange>
August 2024 31

<Description>
<Year>
<DaysInRange>
Quarter 3 2024
92

<Description>
<Year>
<DaysInRange>
QTD 3 2024 62

<Year>
<DaysInRange>
2024 365

<Description>
<Year>
<DaysInRange>
YTD November
2024 244

Variable Definitions for Quick Reports

NOTE

The <Description>, <Period>, and <PeriodMonth> variables will be omitted from the column
caption when organizing by Year.
The <Description> variable will be used instead of <Period> and <PeriodMonth> in the column
caption when organizing by Quarter or Quarter-To-Date.


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Variable Name Definition

Description Returns either the month (ex: Period 2 = September if fiscal year starts in August),
period to date selection with the month (ex: YTD September), quarter number or
blank for year columns.

Period Returns the period number. If organizing by Quarter or QTD this returns the first
period in the quarter (ex. Quarter 2 = 4).

PeriodMonth Returns the calendar month linked to that period number (ex: Period 4 = April
even when fiscal year starts on months other than January) and includes any
prefix the same way the Description variable does.

PeriodMonthShort Returns the same as PeriodMonth except that months are shortened to 3
characters.

FiscalYear Returns the fiscal year.

Year Returns the calendar year.

StartDate Returns the start date of the selected range.

EndDate Returns the end date of the selected range.

DaysInRange Returns the difference in days between the start date and end date for the
selected range.

NOTE

The <Description> and <PeriodMonth> variables will return blank when organizing by Year or Year
+ Adjustment Periods (available only from the Relative Period calculation).
The <PeriodMonth> and <PeriodMonthShort> variables will return the same value as
<Description> when organizing by Quarter or Quarter-To-Date.


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Specify Financial Row Rollup
The next step is to define how you want to organize your row information. You have three choices
depending on your needs:

User Defined List - Manually define each account rollup

Chart of Accounts - Use the JDE Chart of Accounts to define the account hierarchy

Account Group - Rollup accounts by the object accounts

User Defined List
The User Defined List option gives you a flexible way to define manually how you want your financial
information displayed. Each row in the grid below represents how to rollup detail information into one
line. Initially, you must add each row you need. Once you are finished, you can save your list so that you
and others may re-use the work you did.

The editor in this grid lets you:

Define as many rows as you want

Define the criteria you need for each row

Sample screen shot showing a user-defined list
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See the topic Make a List for directions on how to define the rows you want to rollup.

Account Group
Use this option if you want to roll up simply by the object account. Select how you want to see the roll-
ups labeled (Display rows as).
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Financial Column Rollup - Optional
The Columns tab lets you show side-by-side comparisons of financial information. For instance, suppose
you wanted to show a side-by-side comparison of Actual amounts and Budget amounts. In this example,
you would enter two lines in the grid: one for Actual and one for Budget.

The editor lets you:

Define as many side-by-side categories as you want

Define the criteria you need for each category

To show side-by-side comparisons of Do this

Business units Add a line for each business unit you want to compare.
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To show side-by-side comparisons of Do this

Companies Add a line for each company.

Ledger types Add a line for each ledger type.

Category code Add a line for each category code criteria.

etc...

See the topic Make a List for directions on how to define the rows that specify your side-by-side
comparison.
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Financial Excel Embedding
Special Settings
The Special Settings tab lets you set preferences for your financial report.

To Do this

Change how you
want to prompt for
date

Select By date or By period from the pull down box.

Change the text for
prompting date
information

Either select one of the pre-defined prompts: As of or For the period ending
from the pull down box. Or you may type in your own date prompt text.

Define the accounts
to reverse sign

For financial statements to balance in JDE, you must negate the values of the
Revenue accounts. Define the revenue accounts in your system here by any
criteria you choose (object range, category code, etc.). Once set, DAS will
remember the setting as you create new financial reports.

Define the balance
sheet accounts

For balance sheet accounts, you must add the beginning balance to get the
cumulative actual amount of the account. Define the balance sheet accounts in
your system here by any criteria you choose (object range, category code,
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To Do this

etc.). Once set, DAS will remember the setting as you create new financial
reports.

Limit which object
accounts your
financial report
shows

Enter a begin object account (OBJ) value and an end object account value that
define the inclusive range that you want to display in your report.

Exclude zero
balances from the
report

Check to exclude 0 balances. Uncheck to include zero balances.

Present your
financial report with
Excel capabilities

Check Excel presentation.
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Create a Fixed Assets Report
The Capital Asset Management Quick Report allows a user to create reports over fixed assets.

To get started, sign in then:

Click  | Quick Report | Fixed Assets

The Quick Report lets you specify what kind of report you want and how you want to create it.

To Do this

Enter information on a particular tab Click the tab. See topics that
follow.

Create the Fixed Assets report with the parameters you
specified

Click  Create Report.

To exit the designer Click the back button.
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Specify What Data You Require
The first step of defining your report is to name your report and choose to include/exclude asset master
information or business unit information. Enter this information on the Main tab:

In this version, all reports are based on the Posted balances file in JDE.

To Do this

Name your report (Required) Click on the edit box next to Report name and type a
descriptive name for your report. This is a mandatory step.

If you need asset master information
in your report

Click the check box labeled: I need information from the
asset master.

If you need to access category codes
in the JDE Business Unit table

Click the check box labeled: I need category codes from the
business unit master information.

Once you are finished, click the Columns tab.
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Specify Financial Periods
You show amounts by Year-To-Date period. You can also compare period amounts to amounts in
previous periods or years.

To Do this

Compare to previous
Fiscal periods

Change the Compare to previous number to the number of periods you
want to compare against. Set the option box next to the number to Fiscal
period.

Compare to previous
Fiscal quarters

Change the Compare to previous number to the number of quarters you
want to compare against. Set the option box next to the number to Fiscal
quarter.

Compare to previous
Fiscal years

Change the Compare to previous number to the number of years you
want to compare against. Set the option box next to the number to Fiscal
year.

Compare to previous
YTD Fiscal periods

Change the Compare to previous number to the number of periods you
want to compare against. Set the option box next to the number to YTD
Fiscal period.
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To Do this

Compare to previous
Fiscal QTDs

Change the Compare to previous number to the number of quarters you
want to compare against. Set the option box next to the number to Fiscal
QTD.

Change the Caption for
the period columns

Select the desired caption setting from the Caption drop down:
Description and Year, Period Number and Year, or Period Month
Description and Year.

Split period values (such
as Actuals and Budgets)

Check the Split column values by criteria. Once checked, see Financial
Column Rollup to specify how to split the period values.
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Specify Fixed Asset Row Rollup
The next step is to define how you want to organize your row information. You have two choices
depending on your needs:

User Defined List - Manually define each asset rollup

Asset Group - Rollup accounts by the object accounts

User Defined List
The User Defined List option gives you a flexible way to define manually how you want your information
displayed. Each row in the grid below represents how to rollup detail information into one line. Initially,
you must add each row you need. Once you are finished, you can save your list so that you and others
may re-use the work you did.

The editor in this grid lets you:

Define as many rows as you want

Define the criteria and formulas you need for each row

Sample screen shot showing a user-defined list
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See the topic Make a List for directions on how to define the rows you want to rollup.

Asset Group
Use this option if you want to roll up simply by the asset class. Select how you want to see the roll-ups
labeled (Group by).
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Special Special Asset Settings
The Special Settings tab lets you set preferences for your financial report.

To Do this

Change how you want to
prompt for date

Select By date or By fiscal period and year from the pull down box.

Change the text for
prompting date information

Either select one of the pre-defined prompts: As of or For the period
ending from the pull down box. Or you may type in your own date
prompt text.

Exclude zero balances from
the report

Check to exclude 0 balances. Uncheck to include zero balances.

Present your financial
report with Excel
capabilities

Check Excel presentation.
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Create a Job Cost Report
A Job Cost Report setup is similar to what is found in other Financial quick reports, but line item setup is
done for jobs and by selecting specific ledger types. A key difference for a Job Cost report is that it is
primarily focused on showing the job/project inception to date performance instead of a standard
financial account inception to date or year to date outlook.

Specify What Data You Require
The first step of defining your report is to name your report and choose to include/exclude asset master
information or business unit information. Enter this information on the Main tab:

To Do this

Name your report (Required) Click on the edit box next to Report name and type a
descriptive name for your report. This is a mandatory step.

If you need chart of account information
in your report

Click the check box labeled: I need category codes from
the chart of accounts.

If you need to access category codes in
the JDE Business Unit table (F0006)

Click the check box labeled: I need category codes from
the business unit master information.
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To Do this

If you need to reverse signs on your
revenue or liability accounts

Click the check box labeled: Reverse sign on revenue
accounts or Reverse sign on liability accounts.

If you need access to the JDE Extended
Job Master (F5108)

Click the check box labeled : I need category codes from
the extended job master.

The following columns are added from the Account Master:

DL01, LDA, PEC, BILL, CRCD, UM, ANS, BPC, CO, MCU, OBJ, SUB, R001, R002, R003, R004, R005, R006,
R007, R008, R009, R010, R011, R012, R013, R014, R015, R016, R017, R018, R019, R020, R021, R022, R023

The following columns are added from the Business Unit Master:

STYL, DL01, AN8, MCU, CO, RP01, RP02, RP03, RP04, RP05, RP06, RP07, RP08, RP09, RP10, RP11, RP12,
RP13, RP14, RP15, RP16, RP17, RP18, RP19, RP20, RP21, RP22, RP23, RP24, RP25, RP26, RP27, RP28, RP29,
RP30, PECC, CT, MCUS, BTYP, PC, AN8O, D1J, D2J, D3J, D4J, D5J, D6J

The following columns are added from the Extended Job Master:

BSCT, BSFY, BTCT, BTFY, RCS1, RCS2, RCS3, JCF6, JCF7, JCF8, JCF9, JCF0

Specify Job Cost Columns
You can show amounts by fiscal year and Year-To-Date. You can also compare period amounts to
amounts in previous periods or years.
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To Do this

Select period
type(s)

Click the Select period type(s) option box. Select Job to Date Fiscal Period,
and/or Fiscal Year.

Compare to
previous Fiscal

Change the Compare to previous number to the number of periods you want to
compare against. Set the option box next to the number to Fiscal Period.
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To Do this

periods

Compare to
previous Fiscal
quarters

Change the Compare to previous number to the number of quarters you want to
compare against. Set the option box next to the number to Fiscal quarter.

Compare to
previous Fiscal
years

Change the Compare to previous number to the number of years you want to
compare against. Set the option box next to the number to Fiscal Year.

Change the
Caption for the
period columns

Select the desired caption setting from the Caption drop down:
Description and Year
Period Number and Year
Period Month Description and Year
Date Range
Start Date
End Date
Description, Year, Days in Period

Split periods into
sub columns
(e.g. Actuals and
Budgets)

Check the option box labeled: Split periods into sub columns (e.g. Actuals and
Budgets). This option is selected by default. It gives you the opportunity to create
a list of Actuals and Budgets, allowing you to change the criteria of your ledger
types. Once checked, see Financial Column Rollup to specify how to split the
period values. Uncheck the option box if you do not wish to split periods into sub
columns.

Specify Job Cost Row Rollup
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The next step is to define how you want to organize your row information. You have three choices
depending on your needs:

User Defined List - Manually define each account rollup
Chart of Accounts - Use the JDE Chart of Accounts to define the account hierarchy
Job Cost Code - Rollup values by the job cost code

Group by Job Cost Code
Use this option if you want to roll up simply by the object account. Select how you want to see the roll-
ups labeled (Group By).

This is the default selection for Job Cost reports and allows for filtering of Jobs (F0006.MCU) and Projects
(F0006.MCUS).

User Defined List
The User Defined List option gives you a flexible way to define manually how you want your financial
information displayed. Each row in the grid below represents how to rollup detail information into one
line. Initially, you must add each row you need. Once you are finished, you can save your list so that you
and others may re-use the work you did.

The editor in this grid lets you:
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Define as many rows as you want
Define the criteria you need for each row

Sample screen shot showing a user-defined list

See the topic Make a List for directions on how to define the rows you want to rollup.

Chart of Accounts
Use the Chart of Accounts option to create a Job Cost report using the Chart of Accounts calculation
column.
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Special Settings
The Special Settings tab lets you set preferences for your financial report.
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To Do this

Change how you want to
prompt for date

Select By date or By fiscal period and year from the pull down box.

Change the text for
prompting date information

Either select one of the pre-defined prompts: As of or For the period
ending from the pull down box. Or you may type in your own date
prompt text.

Exclude zero balances from
the report

Check to exclude 0 balances. Uncheck to include zero balances.

Present your financial
report with Excel
capabilities

Check Excel presentation.
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Design Ad Hoc Reports
User level JDE Knowledge Can Design Reports Technical Knowledge

Subscriber Not needed No Minimal

Quick Report Designer Minimal Yes Minimal

Report Designer Yes Yes Some

Advanced Designer Yes Yes High

Ad Hoc Report Design is one of the strengths of Data Access Studio. Data Access Studio empowers you
to deliver a large variety of reports in a timely manner by:

Allowing you to visually create your report with sample data

Presenting real-time data exactly as you see it in JDE

Applying automatic performance improvements

Enforcing read-only queries so you can design with confidence

To create Ad Hoc Reports in Data Access Studio you need to know how to:

Get the Data You Need

Fetch and Filter Data

Edit Your Report

Format Your Layout

Calculations

Find Trends in Your Data

Export and Print Results

Publish Your Report to Others
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Create a New Report
To create a new report, click the New Reportbutton on the home page:

This will take you to the New Reports page. Create a new report using any of the methods below.

To Do this

Create a new Dashboard Select the button next to Dashboard. See the Dashboard Design
Manual for more information on how to create a dashboard
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To Do this

Create a new Quick Report Select a report from the drop down menu. See Financials, Create a
Fixed Assets Report, or Create a Job Cost Report.

Create a new report from a
JDE table or view

Select the Next button to choose a table and build a report.

Create a new report from a
custom join

See Create a Table Join from Scratch.

Create a new report from
external data

See External Data.
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Create a new report from JDE table or view

To Do this

Open a table Type a table name (e.g. F0411) into the box. Click the Open icon.

Change the data source where
you open the table
(EnterpriseOne only)

Click the Data Source option box. Select from list of available
data sources. Note: if the administrator revokes this permission,
you will not see the Data Source option box.
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Get the Data You Need
Data Access Studio can open any JDE table, business view, or logical for which you have access. From the
home page, use the universal search to find what you need:

To Do this

Search by Name Click on the Search box and type in a JDE table or business view name. This
automatically brings up all Search results related to the query. Browse the list
of results in the grid. Click a result to open.

Search by
Description

Click on the Each box and type in a keyword or phrase. This automatically
brings up all search results related to the query. Browse the list of results in the
grid. Click a result to open.

Narrow/Expand
search options

Check the option boxes next to the Search options to show results for My
Workspace, Public Workspace, Templates, JDE Tables, Dashboards.
Uncheck to hide.

Open a recently
opened table

When the Search box is not populated, the home page automatically displays
Recently Opened reports, templates, and or tables. Click any item in the list to
open.
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Open a Table for First Time
When you open a table or business view, Data Access Studio will close the form above and open a new
window for the item you want to query.

For example, let's say you opened the JDE Work Order Master File (F4801). You would see a form that
resembles the following:

When Data Access Studio opens a table for the first time, notice the following:

The description, object, and data source appear in the title of the window.

The quick menu with Run Report, Get Sample Data, etc. shows at the top of the grid.

All columns are shown with the default Description style. The column descriptions come from the
JDE data dictionary. E.g. you see the column header Order Number instead of the cryptic DOCO.
See the Customize the Look and Colors of Your Report topic for more information on how to change
the column caption and other styles.

The grid in the form initially has no data in it. Add filter criteria and click  Get Sample Data.
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Supported JDE Data Formats
As of 8.0.10, DAS supports all JDE data types. Here is a list of the common JDE data types.

String Data
All JDE String data is supported including variable string data and single characters.

Numeric data
All JDE Numeric data types are supported. DAS automatically applies all JDE formatting functions
including such things as currency conversions.

JDEDATE
DAS supports JDE's date-only JDEDATE datatype. This will be displayed as a Date/Time column set at
midnight. The 'E1 time to DateTime' calculation can be used to convert a JDEDATE and an associated JDE
time formatted numeric time column to a Date/Time column.

JDEUTIME
Many modules of JDE (especially the grower module) support the JDEUTIME column. The JDEUTIME
column is a date/time column where the date/time is stored in the database as UTC (Coordinated
Universal Time). This universal date/time can be displayed in the user's time zone (with an optional
associated daylight savings rule) or any other time zone.

Please see the Report Time Zone topic for more information.

Blob
JDE Supports binary large object columns for the storage of non-relational data. DAS supports
interpreting such columns as text, images, or as a file download.
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External Data
External Data provides a complete solution that allows you to combine data from different sources into
one report, supporting the following features:

Ability to create reusable connections to external data sources
Security layer over external data access, including the use of Modern Authentication (OAuth 2)
32-bit and 64-bit connections
Client-side and server-side (reusable) connections
Additional data access drivers for performance and convenience
Seamless integration into existing Folders, Publishing, and Scheduling functionality
Ability to join within an External Data source
Ability to perform a Table Lookup to External Data sources
Allow reports to reference database tables by administrator maintained table aliases.
Allow filtering by schema for tables seen by developers.
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Manage External Connections
Data Access Studio lets you connect to any 32-bit or 64-bit data source. Furthermore, you can use your
connection in any report to combine information from that connection with the rest of the data in your
report.

To work with your external connections, click the  button (External Data Connections) on the main
toolbar. Alternatively, click File > New > External Data.

The External Data Connection page shows all available connections. The default connections view
contains connections grouped by the location of the connection (Client or Server). Each connection has a
user-defined name, the data source type, the connection information, the Identity (Single or Per User),
the Authentication type and the Search Status.

NOTE

Additional columns, such as bit-ness (32-bit or 64-bit), audit information (date, user, and version)
and the updated date can all be viewed by right-clicking on a column header and choosing Hide
and Show Columns from the context menu.


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Search Status
DAS users can search for table names of selected External Connections on the home page of DAS. See
Create a new Connection for details. For a connection to be searched, a search cache must be generated
first. Each user has the option to generate or exclude search caches for client connections. DAS
Administrators must be on the DAS Server to generate search caches for server connections. Unless
excluded from search, a search cache for a connection will be automatically generated upon the
connection being created or edited.

In the Search Status column of the grid, one of these statuses will be displayed: Excluded, Searchable, or
Not Generated.

User Actions
To Do this

Add new
connection

Click the  New button. In the properties form, choose whether the
connection will be client or server-side, along with the bit-ness (32-bit or 64-
bit) of the connection which must match the bit-ness of your data source.

Create a report over
an existing
connection

Highlight the connection and click  Open Connection button. See Create
Report Over External Data Connection.

Copy an existing
connection

Highlight the desired connection and click  Copy. Specify the new name
and adjust any other property for the new connection. If running on the DAS
server, it will be possible to copy a client connection to a server connection (or
vice-versa).

Edit an existing
connection

Highlight the desired connection. If the connection is a client-side connection,
click  Edit to edit it. Server-side connections can only be edited on the DAS
server. See Editing a Connection.

Delete a connection Highlight the desired connection or connections (multi-select with CTRL or
SHIFT keys). Click  Delete. Note: Server-side connections can only be

NOTE

Microsoft Excel and Access connections support both 32-bit and 64-bit regardless of the bit-ness
used when creating the connection. These connections will work on any Office install (32-bit or 64-
bit).


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To Do this

deleted on the DAS server.

Refresh the
connections list

Click the Refresh button.

Save customized
grid

You can customize the External Data Grid (re-order columns, group by different
columns, sort, etc.). To save your customized grid, click the  Save button. To
restore the grid to the default layout click the  Restore button.

Update credentials The  Authenticate button will be enabled for connections that use modern

authentication (OAuth 2.0) or per-user authenticated server-side connections.
Clicking on this button will allow you to update the login credentials for your
connection.

Regenerate Search
Cache

Select one or more Client or Server connections, then click the 

Regenerate button. Only selected connections are regenerated. To generate
Server connections you must be on the Server. Note: the search cache does not
include DataBox connections.

Exit this page Click the  Back button.

Administration
Some operations are restricted to DAS Administrators, such as copying Server connections since this
requires updates to the DAS security policy. In addition, creating a Server connection must be done on
the DAS server.
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Creating a new External Data connection
When creating a new External Data connection, you'll need to know the provider you want to use to
connect to your data and the type of authentication you want to use.

Additionally, there are advanced properties that can be used to limit table/schema access and simplify
longer table/schema names.

Client connections
Client connections are private connections that can only be used by the user who created the
connection. Private reports that use this connection can be published to others, but the other users
would need have a client connection with the same name for the report to work.

Authentication
DAS supports 2 different authentication types for client connections, Provider and OAuth 2.0.
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Provider Authentication
This type of authentication uses the authentication method as defined by the configuration specified by
the data provider.

OAuth 2.0 Authentication
OAuth 2.0 uses modern authentication methodologies which can include multi-factor support.
Additional configuration settings are required for this type of authentication. See Creating an External
Data connection using modern authentication

Other connection options
In addition to the options above, you can see other options such as Data Source selection, bit-ness and
adding tables for home page searching. (See Other External Data options)
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Other External Data options
Choosing your Provider

A new connection will show an empty Connection String. Click on the  button to show the list of
available providers. This form gives you many ways to connect to a data source.

First, select the Data Provider.

DAS supports ADO.NET, ODBC and OLE DB providers that have good SQL-like query support. DAS
provides good support for Oracle, MS SQL Server, DB2, Microsoft-specific drivers (e.g. Excel), and several
CData drivers. The list you see here will depend on which database drivers you have installed. The data
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provider you pick can also have performance advantages. In general, the native drivers will outperform
the generic ODBC or OLE DB drivers.

Once you have selected the appropriate driver, you can select your data source.

32-bit and 64-bit connections
Any data source that you connect to (client-side or server-side) will be either 32-bit or 64-bit. This bit-
ness of the connection must match the bit-ness of your data source driver.

Searchable connections
DAS users can search for table names of External Connections on the home page of DAS. For a
connection to be searched, the Searchable feature must be enabled.

To enable this feature, check the Searchable checkbox. Once enabled, the search cache will be
automatically generated when the connection is saved.

IMPORTANT

If the property form does not show when clicking the  button, try changing to a different bit-ness.


NOTE

Microsoft Excel and Access connections support both 32-bit and 64-bit regardless of the bit-ness
used when creating the connection. These connections will work on any Office install (32-bit or 64-
bit).


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Connect to an Excel file
A common requirement is to report over an Excel file. DAS makes this easy.

Create a Connection
1. From the External Data Connection page, select New Connection See Create a New Connection.

2. Click on the button in the connection string textbox to set up the connection.

3. Select Microsoft Excel File as the data source. Click OK.
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4. Enter the path to your Excel file in the Excel file name field. Test the connection to make sure it is
valid by clicking Test Connection. Click OK.

5. You may keep the system-assigned name (i.e. the path) or provide your own name in the
Connection Name textbox. Please note that once a connection is saved, you cannot change the
connection name.

Specify a Query timeout (seconds) other than the provider connection default if desired.

External Data Connections are included in the home page search by default, so if you want to
exclude this connection from search uncheck the Searchable option.

Click Ok.
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6. Select the sheet/table you want. When the sheet/table is selected, a preview of the data is shown to
the right.

7. Click Open to create the new report. Once the new report opens, you can edit and save the report
with a name of your choice.
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Creating a Connection using modern
authentication (OAuth 2)
Understanding OAuth Requirements for your Provider
OAuth 2 is the industry-standard protocol for modern authorization. DAS supports this authentication
standard by leveraging Access Tokens and Scopes. For more information on OAuth, see the OAuth 2
standard .

When a user authenticates against a resource by providing their username, password and typically an
MFA (multi-factor authentication) method, an Access Token is generated. Access Tokens are the result of
a successful login challenge but contain no user or authorization information.

When configuring your OAuth 2 connection, you need to provide a list of applicable Scopes. These
scopes limit an application's access to the user's account. During a login challenge, these scopes are
presented to the user in the consent screen similar to the following:

Using Access Tokens and Scopes
We allow referencing the Access Tokens within your connection properties by using the pre-defined
token <OAUTH_TOKEN> and Scopes by surrounding the scope's name by angle brackets (e.g.
<name>).

https://oauth.net/2/
https://oauth.net/2/
https://oauth.net/2/
https://oauth.net/2/
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Different providers may require specific Scopes for access. DAS attempts to handle connections in a
generic way by leveraging Scopes within the provider's connection string. Since each provider has
different properties, you'll need to understand which Scopes are required for that provider.

For user-based connections, at the minimum, you'll need the Access Token and the User Id to be set in
the connection string. For example, if the provider has an Access Token property (typically within their
OAuth section), you would set the value of that property to the pre-defined token <OAUTH_TOKEN>.

To get the User Id, you'll need to request access to that information as a Scope. In many instances, you'll
request the email scope. You will request this scope in the Integration section of your settings. You'll
then use the name of the scope for the token (<email> in this case) in the provider's property for the
User Id.

Creating the connection
You can create an external data connection using OAuth 2 on either the client or the server. First choose
the OAuth 2 Authentication Type, then edit the Connection String by clicking the  button.

Configuring a Provider (NetSuite example)
Below is an example for configuring a NetSuite provider using the SuiteAnalyticsConnect driver.

Note the highlighted fields. These tokens will be replaced with the authenticated values returned from
the login challenge. This provider uses the OAuth2Token property in the Custom Properties section, and
also requires the User ID to be set for OAuth authentication.

Here we set the OAuth2Token property to the <OAUTH_TOKEN> token, and since the User ID must also
be set, we use the value returned from the email scope.

NOTE

Server-side connections will have additional authentication features.

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These tokens are defined by the token name, surrounded by angle brackets (e.g. <name>) and will be
replaced within the connection string when the report is run or the data source is opened.

Integration settings
Once the OAuth 2 Authentication Type is selected, the  OAuth tab will be shown. These settings are

required for OAuth 2 authentication.

IMPORTANT

These settings will be given to you by the provider administrator.




03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 76 / 480

Authenticating the connection
Once the connection is configured and saved, the  Authenticate button will be enabled on the

External Data Connections toolbar. You can click this button to begin the authentication challenge or
open the connection. Once the challenge passes, you can use your connection until the Access Token
expires. At this point, you will need to login again to continue using the connection.

NOTE

Scopes are a property of the OAuth 2 authentication settings. These scopes are defined by the
provider and can be used within the Connection String of the External Data connection, such as in
the example above.


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Create Report Over External Data Connection
Once you have defined a connection, double-click the connection to browse the contents of the data
source.

When you select a connection, DAS shows tables in that data source. If available, DAS will group by
schema. Selecting a table will preview the top 100 rows of data in that table.

Clicking Open will open the data source in a new tab. This is where you can filter and sort the data, and
ultimately create a report. Closing the tab without saving will return you back to the preview tab -
allowing you to effectively browse data without creating report objects.
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Editing a Connection
You can change the connection properties by highlighting the connection and clicking the  Edit
button.

DAS will show the connection properties for the selected connection.

To change or update the provider settings, click on the ellipse button on the Connection String.

You can change any field the Provider form allows for your connection. In the example below, we could
change the Excel workbook or the location of the workbook by modifying the Excel file name field.

Most Connection Properties also have an Advanced button. Press this button to configure low-level
parameters of the connection that may not otherwise appear on the main dialog.

NOTE

You can also edit the Connection String inside the text box for quick updates. However, changing
the provider must be done by clicking the  button.


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Bringing Back Data from an External Connection
External data connections can be used as the report data source or as a data source for a Table Lookup
calculation. The basic query and retrieval methods used for JDE data sources will be the same for these
connections. The data sources differ in terms of authentication and general reliability. This article will
cover some of these considerations.

Excel File Locking
A very common data source for reports in Data Access Studio are Excel files using the Microsoft Access
Runtime (ACE OLEDB) driver. One of the most common issues with this data source is that querying it
will fail when the file is open in Excel. This is a limitation of the ACE OLEDB driver and is not something
that can be changed by ReportsNow. To work around this limitation, make sure Excel files are closed or
the files are marked in Windows as read-only before they are opened and before running a report that
uses them as a data source.

Authentication Prompts for OAuth 2 and Per-User Server
Connections
Certain external data connections require interactive authentication by end users. This includes any
connection that has its authentication type set to OAuth 2 and server side connections that are
configured to authenticate for each user (per-user server connections). For such connections, the user
may be prompted to authenticate when the report is opened or when the connection is first used during
a run of the report. The user only needs to successfully sign-in to a data source once and, after that, DAS
will store these credentials until the credentials fail (either due to an OAuth token expiration or a
password change).

The data sources that require authentication will be listed under the 'Authenticate' dropdown on the
report's, ProReport's, or dashboard's tool bar. This will show for both private and published reports
within Data Access Studio. If the dropdown does not exist, then the report does not use connections that
require authentication.
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Controlling When Authentication Prompts Occur
External data Connections used by the main report and the main report's variables must always be
authenticated by the user when the report is opened. However, if the report uses a Table Lookup
calculation, the user can choose to authenticate the connection when the report is opened or when the
Table Lookup calculation is run. This can be controlled by the 'Authentication timing' option in the Table
Lookup and Burst calculation settings.

The 'Authentication timing' setting has two options.

On report open - Indicates to authenticate the connection when the report is opened. This is the
default setting.

NOTE

ProReports and dashboards published to mobie will not show the 'Authenticate' dropdown because
mobie published objects only connect to the single mobie database. Instead, the authentication
described here will occur when reports backing mobie-based ProReports and dashboards are run
during the web publishing process.


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When first used - Indicates to authenticate when the connection is first used.

Use the When first used option for report-level table lookups and bursts that are not always required
when running. For example, there might be a drilldown to a report that uses an OAuth connection that
only applies for certain business units. Such a burst would be a good candidate for the When first used
option where only the users accessing those business units would need to authenticate.
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Creating a Join in a non-JDE Data Source
DAS allows you to create join definitions for tables that are within an External Data source.

1. Click File | New | Custom join.

2. Click Connection. Select the External data connection.

3. Define the rest of the join as normal (See Create a Table Join from Scratch).
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Table Alias Mappings
The Table Alias Mappings functionality in Data Access Studio (DAS) assigns aliases to database tables,
enhancing the representation of tables in reports. This feature enables the presentation of data in a more
user-friendly manner and promotes portability.

Automatic Mapping and Manual Intervention
The Table Alias Mappings functionality in Data Access Studio (DAS) assigns a simple, unambiguous table
alias name to each database table referenced for an external data connection. The report is then built
against these aliases. These table aliases are registered (usually automatically) with the connection and
map to the actual table names. Then, in the future, if a table is moved to a new schema or database (or
even if the name changes), then just the connection mapping is updated instead of changing the report.

When users open new tables for an external data connection, DAS will automatically attempt to create a
table alias with a unique name. If it is unable to determine a unique name, the administrator of the
connection can manually create an entry in the Table Alias Mappings tab to supply a unique alias name
for users to use when referencing the desired table.

When DAS shows available tables for an external data connection, it uses an automatic discovery process
to query the database for all known tables. If the data provider does not provide a catalog of tables to
open, it is possible to leverage this mapping system to manually populate the catalog. In such cases, an
administrator of the connection can create a table alias mapping for the desired table so that it becomes
available to end users when they open the connection.

Mass Updating Table Qualifications
To mass update a set of table qualifications in table alias mappings, please select all the tables that you
want updated. Then either right-click and select Update Qualification or click the same button on the
toolbar.

NOTE

The "administrator" of the connection is going to be the owner if it is a client connection (such as a
report developer) or the DAS Administrator if it is a server connection.


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When the dialog pops up you are presented with two text boxes with checkboxes by each one. Please
select the checkboxes for the value that you want updated.

To eliminate the schema qualification, the database qualification, or both, simply check the box to
update the selected part of the qualification and leave the textbox empty. Leaving the textbox empty
while the update box is checked will remove that part of the qualification from the table name when the
OK button is pressed. There's no need to manually include quotes for either value; they will be
automatically applied when you click the OK button.

Example Usage
To illustrate the benefits of this functionality, consider the following scenario: a table named TestTable
within the Test schema, residing in the AdventureWorks2019 database.
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In reports, the table will be referenced solely as TestTable, without explicitly mentioning the original
table name or schema. However, if the user needs to switch to the production version of the table, they
can conveniently access the connection edit dialog and modify the mapping to point to the desired prod
table without affecting reports built off of the TestTable table.

Remarks



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 88 / 480

To incorporate table aliases into your existing reports/table lookups please refer to table alias conversion
documentation for more info.

If table mappings are not automatically quoted or if the qualified schema needs to be changed, please
refer to our advanced options documentation on how to set these options up.
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Table Alias Conversion
Reports created prior to 8.0.14 did not use the Table Alias Mapping system but instead directly reference
the actual qualified table names. Reports/table lookups generated from version 8.0.14 onwards will
automatically incorporate table aliases. However, for reports created before this version, there is a
straightforward method to convert them for table alias usage.

The conversion process will attempt to convert all of the report's table joins and table lookup
calculations to use table aliases. For example, an old report might have a column reference [Prod].
[TestTable].[ColA]. After conversion, this reference will instead be [TestTable].[ColA]. If the external
connection did not already contain an alias mapping for [Prod].[TestTable], a mapping will be created
(e.g. [Prod].[TestTable] --> [TestTable]).

If the table name is already used by the connection but mapped to a different qualified table name (ex.
[Dev].[TestTable] --> [TestTable]), a new unique alias will be added (ex. [Prod].[TestTable] -->
[Prod_TestTable]). The updated column reference in this example would then be [Prod_TestTable].
[ColA].

Converting Reports and Table Lookups
Upon conversion, the report will open in a new tab to provide users with the option to close it without
saving, preserving the original report. To convert a report join or table lookup calculations, please follow
the steps below:

1. Open desired report
2. Click on Design > Table Join
3. Click on Advanced Options in the top right corner
4. Click on Convert to use simple table alias

NOTE

Reports that are not converted will still continue to work and can be modified like normal. However,
if the external table that the report relies on changes in the future it will require manual intervention
to fix.


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5. Verify that the report is still working as intended

Considerations Before Converting
While we recommend converting reports to utilize table aliases, it is essential to consider a few factors
before proceeding. It is important to understand that the column references of a report are often used
by other objects to connect or 'bind' to the report. For example, a dashboard may have a chart that is
bound to a report's column. If the report's column reference changes, the dashboard will no longer be
able to bind to the report. Therefore, it is crucial to understand the impact of converting a report before
proceeding.

Systems that can bind to a report's column reference include:

Dashboards
ProReports
Burst Calculations

In cases where the report has viewers (dashboards or ProReports) referencing the report being
converted, users will receive a warning before initiating the conversion. The converted report will open in
a new tab with a unique name to ensure that viewers remain unaffected. After testing the converted
report, users should go into each viewer that is linked to the old report and then change it to the newly
converted report. Since the report was opened with a new unique name, this will give users ample time
to make necessary adjustments and address any potential issues.

There are no warning dialogs for burst dependencies. You will want to use the Burst/Drilldown Cross
Reference  report to identify any burst dependencies. If there are any burst dependencies, you will want

https://support.reportsnow.com/hc/en-us/articles/17841266375827-Burst-Drilldown-Cross-Reference
https://support.reportsnow.com/hc/en-us/articles/17841266375827-Burst-Drilldown-Cross-Reference
https://support.reportsnow.com/hc/en-us/articles/17841266375827-Burst-Drilldown-Cross-Reference
https://support.reportsnow.com/hc/en-us/articles/17841266375827-Burst-Drilldown-Cross-Reference
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to test and update the burst calculation after the conversion if the burst call referenced any of the
changed columns.

Remarks
While the report/table lookup may already be using table aliases, if it is not using the most simplified
version for that table then the option to convert to use simple table alias will show up under the
advanced options.
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Allowed Schemas
Allowed Schemas secure your external data connections by implementing access restrictions to a
specific set of schemas. By defining which schemas are accessible, you can effectively control access to
sensitive data.

Usages
To illustrate this feature, let's consider an example using the SQL sample database known as
AdventureWorks. Within this database exist various schemas such as Person, HumanResources, Sales, and
more. By leveraging the Allowed Schemas feature, you can restrict the connection to only grant access
to the Person and HumanResources schemas. Consequently, users utilizing this connection will be unable
to access other schemas, such as Sales. This security measure not only enhances data protection but also
streamlines the exploration of table contents, as irrelevant tables are excluded from view.

Showing Table from a Restricted Schemas
If there is a table that is in not in one of the allowed schemas, but users still need access to it.Then simply
by creating a table alias mappings to the restricted table, this will allow users of the connection to access
the restricted table.

Microsoft SQL Server
This section pertains to Microsoft SQL Server connections that do not explicitly specify database (also
known as a catalog). In this case, when the visual assist button is clicked to display all available schemas,
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it will present schemas from all databases that are available to the user. By selecting only a desired set of
schemas, users can avoid seeing all schemas. This is particularly crucial when performing joins, as joins
can only be executed within a single connection. Using a connection with no default database allows
users to perform joins between different databases through a single connection, since joins must always
be performed on a single database connection.

To illustrate, consider the following practical example: users can easily create joins between tables in
[ProductionDB].[HumanResources] and [TestDB].[HumanResources].

Remarks
Despite the connection being locked to a predefined set of schemas, administrators of a connection
retain the ability to introduce a table alias mapping to a table within a restricted schema. By doing so,
the associated table can now be utilized within the connection.
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External Data Connections Advanced Options

Custom Schema Discovery

DAS queries databases metadata tables to discover the tables that can be opened. These settings allow
advanced configuration of this process. This will also effect how qualified table names are created for
table alias mappings. The following are a few of the known scenarios where the Schema Discovery
option should be utilized:

If the table alias mappings should not be added on certain parts to the qualified table name.
An example of this is when a database provider adds the current user's role name as the
schema. This means a user running in another role could not use the report. Assuming the
provider supports running without this qualification (like Oracle NetSuite®), use this
configuration to not allow the schema to be added.

If DAS does not recognize what the schema or catalog name should be.
An example illustrating this situation occurs when reviewing the automatically generated table
alias mappings, which may lack proper qualification. This could manifest in various ways,
ranging from the absence of qualification to instances where the database column is used as
the schema, and vice versa.

To utilize this feature select the Use Custom Column Names to turn it on.

WARNING

The following options impact how DAS finds and queries tables in a database. Misconfiguration
here can cause reports that use the connection to fail.



NOTE

This option will not need to be utilized for most external connections.

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The columns that correctly identifies what should be used for these comes from the database's
metadata. To identify the correct column name for the text box, navigate to External Data Connections
and open the connection to access all the tables. Then right click on a column and select Hide and
Show Columns. A dialog should pop up similar to what is shown below; the example is from a Microsoft
SQL Server connection.
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Then from this screen you can see what the column alias is to use for these text boxes. In this case, for
the schema column it would be TABLE_SCHEMA and for the database it would be TABLE_CATALOG.

Any textbox that is left empty, that part of the table qualification will not be used by DAS to query data.
The database textbox cannot be filled out if the schema textbox is left empty, since qualification goes
[DATABASE].[SCHEMA].[TABLE]. However, the database textbox can be empty while schema is filled out.

Oracle NetSuite® Connections
NetSuite is a known example of the first scenario that was listed above in Custom Schema Discovery of
when to use the Custom Column Names option and to not qualify the generated table aliases. Because
it is known, DAS will configure this options automatically upon creation.

Custom Quotes

NOTE

This option will not show up for most external connections. If visible, any input provided in the
custom quotes text boxes will be used to automatically quote all tables generated for table alias
mappings and will be used on column names during database queries.


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This option will show if we do not know what default quoting to use for the external connection. The
known quotes for external connections are the following:

1. Microsoft SQL Server
2. Microsoft Access
3. Oracle
4. DB2
5. MySQL
6. Oracle NetSuite®
7. Any CData provider
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Drill Downs and Bring Backs
Frequently, the data you will need for your report will reside in different (yet related) tables. To simplify
navigating and combining data into your report, DAS provides two related features: Drill downs and
Bring Backs.

Drill Downs
Drill Downs are the ability to open a related data in a different table as a new query. To execute a Drill
Down, hover over a grid cell. If the grid cell turns to an underlined hyperlink, then a drilldown is
available. Left-click or right-click the cell. Select the desired drill down from the available list by clicking
it. The Drill Down, by its nature, is an interactive activity (as opposed to an automated activity).

For instance, if you were looking in the Account Ledger (F0911) and wanted to see all transactions for a
batch in a new window, you would right-click the batch number and select the Drill down ->
Transactions by Batch - Account Ledger. DAS will then open and tile a new window that shows the
transactions for the batch you selected. For each batch you want to check, you must interactively right-
click and follow the Drill Down.

Bring Backs
Bring backs are the cousin of the Drill Down. If a cell has a Drill Down, then the cell also has a Bring Back.
Instead of opening a new window, the Bring Back literally brings back the data into your existing report.
This has the advantage of effectively doing all the drill downs in one shot rather than individually for
each row -- which is ultimately better for reporting purposes. The Bring Back will arrange your existing
report automatically to handle the new data. You can always click Undo to undo the effects of a Bring
Back.

For instance, if you were looking in the Account Ledger (F0911) and wanted to see all transactions for a
batch in your report, you would right-click the batch number and select the Bring back -> Transactions
by Batch - Account Ledger. DAS will then group your report by unique batches and return the
transactions for the batches back to your report. Your report now has all the batch transactions in it for
you to query.

Types of Drill Downs and Bring Backs
DAS has two types of Drill Downs and Bring Backs:

Standard
Specialized

Each of these is described below.
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Standard Bring Backs
Standard bring backs include all master tables, UDCs, and anything that has an associated description.
There are thousands of data items that fall into this class such as Address Book Number, Business Unit,
Company, etc.

For this class of Bring Backs, the bring back brings back additional information about the item.

Example 1 - Address Book Master Information
If you right-click any address book number cell in your grid you will see: Drill Down / Bring Back ->
Address Book Master. When you select this option, the description for the address book number will be
returned to your grid. Simply double-click the new calculation (which is a Table Lookup calculation - see
Get Related Data from Another Table) and edit the columns to bring back - add Search Type for
instance. In this manner, you can effectively bring back any master table data you need very quickly.

Example 2 - second UDC description
Sometimes you want the second UDC description for a UDC item. Use Bring Backs to get this. Right-click
a UDC value your grid: Drill Down / Bring Back -> User Defined Code Values. When you select this
option, the description and second description for the UDC will be returned to your grid. You can also
double-click the new calculation (which is a Table Lookup calculation - see Get Related Data from
Another Table) and edit the columns to bring back.
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Specialized Drill Downs and Bring Backs
Data Access Studio provides the following JDE-specific Drill Downs and Bring backs:

Drill Down / Bring back Description

Account balance ->
Account ledger

Gets Account ledger (F0911) transactions for a period balance. Right-click
amount cell on Quick Report (Relative Period) reports or Account Balances
table (F0902).

Asset account balances -
> Account ledger

Gets Account ledger (F0911) transactions for a period balance. Right-click
amount cell on Quick Report (Relative Period) reports or Account Balances
table (F1202).

Purchase order ->
Account ledger

Gets Account ledger (F0911) transactions for a purchase order. Right-click
Purchase Order Detail file (F4311) document number cell.

GL Document ->
Transactions for
document

Gets all transactions for a given GL Document. Right-click Account ledger
(F0911) document number cell.

Batch Number ->
Transactions for batch

Gets all transactions for a given GL Batch number. Right-click Account
ledger (F0911) batch number cell.

Account ledger ->
Accounts Payable

Gets the de-duplicated AP records for the corresponding GL records.
Right-click Account ledger (F0911) document number or amount cell.

Account ledger ->
Accounts Receivable

Gets the de-duplicated AR records for the corresponding GL
records.Right-click Account ledger (F0911) document number or amount
cell.

Account ledger ->
Account balances

Gets the period posting values for a set of Account ledger transactions.
Right-click Account ledger (F0911) amount cell.

Account ledger -> Work
Order

Gets the work order data for the Account ledger sub-ledger. Right-click
Account ledger (F0911) sub-ledger cell (where row is sub ledger type W).

Account ledger ->
Address Book

Gets address book master data for the Account ledger sub-ledger. Right-
click Account ledger (F0911) sub-ledger cell (where row is sub ledger type
A).

Work Order -> Parent
Work Order

Gets the parent work order for given Work Order. Right-click Work Order
Master file (F4801) parent work order number cell.
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Fetch and Filter Data
Once you open the JDE table, the second step is to get some sample data. Data Access Studio is a visual
report writing system. Getting sample data helps users visualize the report as they design it. Refer to the
following Data Access Studio main tool bars:

Find and Find Progress toolbar: 

Quick menu toolbar:

To Do this

See sample data
with no filter

Click the  Get Sample Data button.

See sample data
with a filter

Enter filter information in the Filter Boxes underneath each Column Header. Click
the  Get Sample Data button.

See sample data
with count of
total records

Enter filter information in the Filter Boxes underneath each Column Header. Click
the  Find with Count button. Note that if the administrator restricts this
capability, you will not see the  Find with Count button. Note that if you do
not specify filter information prior to pressing the  Find with Count button,
Data Access Studio will issue a performance warning.

Load another
page of records

Click the  Get More Data button.

Go to previous
page of records
in grid

Scroll to the top using the vertical scroll bar.

Load all records
for query

Click the  Run Report button. As the report runs, you will see Counting
Records, Selecting Records, and then the progress bar loading the records.
When the load is done the Progress Indicator will show a full progress bar.

Go to the first
row

Scroll to the top using the vertical scroll bar or click CTRL-Home on your
keyboard.
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To Do this

Cancel a large
row load

When you load records, the  Cancel button on the toolbar will be enabled.
When enabled, you may click the  Cancel button to stop the record load. The
status bar will indicate that the grid is partially loaded.

Refresh
calculations
without re-
fetching data

Select  Refresh button on the toolbar. This will re-evaluate all

calculations except Table Lookup, Chart of Accounts, and/or Burst without re-
fetching report data from the server.
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Filter Your Data
Data Access Studio provides a robust and simple way to get the data you need. When you open a table,
each column has a Filter Box directly beneath the column caption:

When you click on the filter box, you will see the  Filter Helper button. If the column has a Visual
Assist, you will also see the  Visual Assist button.

To filter for Do this

Direct text Click the Filter Box and type in the number, string, or date you need
to find.

Values in the Visual Assist Click the  Visual Assist button. Select from the valid values. Click
 Ok.

A list of values Click  and select List. In the list form, type the values you need on
each line and click  Ok.

Values you want to exclude
from your query

Click  and select Not in list. In the list form, type the values you
want to exclude on each line and click  Ok.

Items that begin with specific
text

Click  and select Begins with. In the list form, type the "begins
with" text on each line and click  Ok.

Items that contain specific text Click  and select Contains. In the list form, type the "contains" text
on each line and click  Ok.

Items that end with specific
text

Click  and select Ends with. In the list form, type the "ends with"
text on each line and click  Ok.

Items that fall into a range Click  and select Range. See Filter a Range topic.
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To filter for Do this

Items that fall into a range
relative to today

Click  and select Today. See Filter a Range Relative to Today's Date
topic.

Items that fall into a range
relative to now

Click  and select Now. See Filter a Range Relative to Now topic.

Items that are blank Click  and select Blank.

Items that are not blank Click  and select Not Blank.

Items that match a Report
Parameter value

If your report has Report Parameters, you can filter using these
values. Click , expand Variables and select the parameter you want
to apply.

Items that match information
about the signed-on user

For World and Enterprise One users, Click  and select one of the
following under the 'Variables' sub-menu.

Filter Operators and Special Tokens
Syntax Meaning

* ALL

! NOT

; OR

: AND

>= Greather Than or Equal

<= Less Than or Equal

> Greater Than

< Less Than

<BLANK> Blank Values

<TODAY> Today's Date

<NOW> Today's Date including the Current Time
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Syntax Meaning

<UTCNOW> Today's Date including Universal Coordinated Time

<DATE MM/dd/yyyy
HH:mm:ss>

Specific Date that includes time. While the specification uses MM/dd/yyyy,
the display will be according to the user's preferences.
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Filter a Range
When you select the Range filter option, Data Access Studio will prompt you with the following form:

To filter Do this

From a specific value Check the box next to From. Uncheck the box next to Through. Select the
From option. Type in the value in the edit box. Click  Ok.

From and excluding a
specific value

Check the box next to From. Uncheck the box next to Through. Select the
From and excluding option. Type in the value in the edit box. Click  Ok.

Through a specific
value

Check the box next to Through. Uncheck the box next to From. Select
Through option. Type in the value in the edit box. Click  Ok.

Through and excluding
a specific value

Check the box next to Through. Uncheck the box next to From. Select
Through and excluding option. Type in the value in the edit box. Click 
Ok.

Between two values Check the box next to From. Check the box next to Through. Select From
option. Select Through option. Type values in both edit boxes. Click  Ok.
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Filtering using the Calendar
Overview
The calendar filter visual assist allows for easy filtering of date only and date/time data.

Date/Time Filtering
If the column being filtered is displaying time, the calendar visual assist will show a start/end time
element as well. To filter a single date/time, uncheck the 'end' time filter and select the '=' or 'Not' filter
operator for the desired time.
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Filter a Range Relative to Today's Date
Overview
The Today Range Filter lets you specify date ranges relative to today's date. This is very useful if you want
your report to always run on a set time window relative to today's date. For example, you can set up a
range that runs between today and three months ago. Every time you run the report, the report will
always show only the dates that fall into the window relative to the time the report was run.

TODAY is resolved relative to the time zone of the user running the report. This time zone can also be
overridden by the report. This might mean that this filter will show yesterday or tomorrow relative to
your local time zone if the report's resolved time zone is different.

When you select the Today filter option on a date column, Data Access Studio will prompt you with the
following form:

To filter Do this

From a specific
offset

Check the box next to From. Uncheck the box next to Through. Select From
option. Enter a positive or negative offset. Select Days, Months, or Years
option. Click  Ok.

From and excluding
a specific offset

Check the box next to From. Uncheck the box next to Through. Select From
and excluding option. Enter a positive or negative offset. Select Days,
Months, or Years option. Click  Ok.

Through a specific
offset

Check the box next to Through. Uncheck the box next to From. Select
Through option. Enter a positive or negative offset. Select Days, Months, or
Years option. Click  Ok.

NOTE

See NOW/UTCNOW for filtering related to now.

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To filter Do this

Through and
excluding a specific
offset

Check the box next to Through. Uncheck the box next to From. Select
Through and excluding option. Enter a positive or negative offset. Select
Days, Months, or Years option. Click  Ok.

Between two offsets Check the box next to From. Check the box next to Through. Select From
option. Select Through option. Enter a positive or negative offset. Select Days,
Months, or Years option. Click  Ok.

<TODAY> filtering on a JDEUTIME Column
DAS automatically transforms a <TODAY> variable to a range filter for the day.

<TODAY> becomes ‘Greater than today at midnight AND less than tomorrow at midnight’
!<TODAY> becomes ‘Less than today at midnight OR greater than or equal to tomorrow at
midnight’
><TODAY> becomes ‘Greater than or equal to tomorrow at midnight’
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Filter a Range Relative to Now
Overview
NOW and UTCNOW become point-in-time values. NOW and UTCNOW are computed once for the
entire report right before the report runs. NOW and UTCNOW refer to the same point in time. NOW and
UTCNOW support offsets by day, hour, minute, or second.

NOW is resolved relative to the time zone of the user running the report. This time zone can also be
overridden by the report.

For example:

<NOW 4.12:00:00> is current time in the report’s local time zone offset by four days, 12 hours.
<UTCNOW -6:00> is current time in UTC offset by negative six hours.

When you select the Now filter option on a date column, Data Access Studio will prompt you with the
following form:

Filtering with Time on Date/Time Columns
Since DAS filtering uses the common time separator (:) as the AND operator, we must include date
ranges that include time inside a DATE token.

<DATE mm/dd/yyyy hh:mm:ss>

This DATE token takes a Date/Time string in Culture Invariant format (that is, U.S.-biased
month/day/year hour:minute:second format).

NOTE

See TODAY for filtering related to today.

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Operands such as >, >=, <, <= can be used with the DATE token to indicate greater than, greater than
or equal to, less than, less than or equal to.

Filtering a Single Date/Time
<DATE 02/06/2006 12:16:09>

Normal:

Editing:

Filtering a Date/Time by Range
>=<DATE 02/01/2006 06:00:00>:<=<DATE 02/28/2006 18:00:00>

Normal:

Editing:

Editing a Date Filter

NOTE

The DATE token is only visible while editing. After exiting the field, the format of the filter will match
the user’s preferences.

Date Ranges can only be applied to single columns.





03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 114 / 480

If the ellipsis button is clicked inside a Date/Time field, a date visual assist will be displayed and allow for
a date or date range to be selected. You can click a start date and drag the mouse to an end date in
order to select a range of dates.

Set the start time and end time for a particular date or date range below the calendar.

Editing a Date Range Filter
Select the funnel icon in a Date/Time column to display the popup menu.

Select the Range option to open the Define filter range dialog.
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Selecting values from the calendar visual assist and the range visual assist will generate the DATE token
syntax automatically after OK is pressed.

Selecting the From and excluding or the Through and excluding options, excludes the selected date from
the range.

Convert E1 Time to Standard Time Format
If an E1 time needs to be converted to a standard time format refer to the following article:

Convert E1 Time to Standard Time Format
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Additional Criteria Form (Advanced)
On occasion, you will need more advanced filtering than can be specified by the column filters. In these
rare cases, you can define filter criteria using the Additional Criteria form. On the main menu, click
Design > Additional Criteria...

To Do this

Enter OR
logic

Enter Field and Criteria information for one row. On the next row, under Field, select
Chain or. Then Enter Field and Criteria information for the following row. E.g.:

Move a
criteria row

Click the row header  and drag row to new position.

Copy a
criteria row

Highlight the row. Click Copy Row.

Delete a
criteria row

Highlight the row. Click Delete Row.

Accept
changes

Click  OK.

Reject
changes

Click  Cancel.
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Manage Your Report
Now that you have opened a table or business view, you can edit it to create the report you need.

Data Access Studio provides a wide array of ways to format, rearrange, calculate, and group information
into the format you need. As you edit your report, you will be the only one who sees your changes--
hence the term Private Report. Once you are done with your report, you may elect to publish it to
others so they may benefit from your work.

To Do this

Save your private
report

Click File > Save. If this is the first time you are saving your report, Data Access
Studio will prompt you for the report name. Enter the name and click  Ok. If a
report already exists with the name you chose, then DAS will prompt you with a
Dialog with options to rename, overwrite, or cancel.

Copy your report If the report is open, click File > Save As. Data Access Studio will prompt you to
enter a new name. Once you click  Ok, Data Access Studio will copy your
report to the new name.

Delete a report Option 1: Click File > Delete, prompting you to confirm deleting your report
before clicking  Ok to delete.
Option 2: Go to My Workspace, right-click the report and select Delete.
To permanently delete, delete the report from the Recycle bin as well.

Restore your
Report from the
last time you
saved it

Click File > Restore. Data Access Studio will prompt you to restore the report
from the last time you saved it. There is no ability to restore reports prior to the
last save.

Undo the last
change you made

Click  Undo.

Redo the last
thing you undid

Click  Redo.

Once you are finished editing your Report, you can:
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Run it privately
Publish it to other users

NOTE

If you try a delete a report that is used for a ProReport or Dashboard, there will be a warning
notifying the user of what Viewer Object will be broken.





03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 119 / 480

Access Your Reports
Once you build your collection of Reports, you can access them at any time from the home page by
clicking My Workspace (or alternatively File | Open | My Workspace...).

Once clicked, Data Access Studio will show you all of your Reports as follows:

Designers can create personal folders by simply clicking on the New Folder button. You can also create
folders within folders. The user interface also allows you to undo or redo changes you have made. DAS
will migrate your existing folder configuration under My Workspace.
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To Do this

Search for a report Type search terms in the Search box. As you type, the tree will filter results
matching your search. To clear search results, either delete the contents of
the search box or click the Clear Search Filter ![](../images/ClearFilter2.png
button.

Open a report by name Click the Search box . Type in a report name or wildcard (*). Double-
click the row you want to open.

Run a report Browse the list of results in the grid. Highlight the row you want to open
and click  Run. DAS will open and run the report.

Open a report Browse the list of results in the grid. Highlight the row you want to open
and click  Open.

Sort by most recently
created reports

Right-click Date. Select Sort Descending.

Change the data source
where you want to open
the report
(EnterpriseOne only)

Click the Data Source option box. Select from the list of available data
sources. Note: If the administrator revokes this permission, you will not see
the Data Source option box.

Open by selecting a
report that you recently
opened

Click the Recently Opened option box. Click any item in the list to open
the report on which you previously worked.

Create a new report Click the  New button. See Create a New Report.

Close this form Click Close.

Create a new folder Click New Folder .

Rename a folder Right-click a folder. Click Rename. Enter the new folder name.

Undo/Redo Last Change Click the Undo or Redo button.

Delete a Report Refer to Deleting Report Content

Save changes to the tree
structure immediately

Click the Save button.
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To Do this

Sort Columns Click a column header to switch the sort state from Ascending,
Descending, and None. A triangle icon will appear indicating the direction
of sort. Ctrl + Click a column header to apply multiple column sorting.
Single click of a different column header will undo any previous column
sorts and apply the new column sort on the clicked column.

Last Modified Filter Click the funnel icon  on the Last Modified column header to display the
Filter Search dialog. Use the Date Filter section to filter by common date
periods. Use the Values Filter section to choose a specific date period.
Filter by specific period:

Filter by specific date:

Record Size Filter Click the funnel icon  on the Record Size column header to display the
Filter Search dialog.
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To Do this

Report Name and Based
On Filter

Click the funnel icon  on the Report Name or the Based On column
headers to display the Filter Search dialog.

 

Workspace Search
Highlighting

Type in the search field to highlight matches in the Report Name, Based
on, or Last Modified Date columns.
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To Do this

Save the Folder Layout The folder layout is saved per user when Data Access Studio is closed.

Sort Folders By Name To sort folders by name make sure the Name column is sorted on and
open up the context menu by right clicking on the column. Then click on
Sort Folders to turn it on. Please note that this option will not appear if
the Name column is not being sorted on.
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Switch Between Opened Reports
When multiple reports are open at once inside of DAS, there are a couple different ways to switch
between reports or change the tab layout to see multiple reports at once.

In addition to setting a default workspace mode under Default Preferences, the Workspace mode
buttons are also available to switch your view of reports.

When tabbed workspace mode, tile horizontally, or tile vertically are selected, Tab Groups are created in
your DAS environment. For example, when tabbed workspace mode is enabled, there is a single tab
group that displays multiple reports as tabs to easily switch between.

If a user selects tile horizontally instead, a Tab Group is created for each separate report that's currently
open. Three tab groups are created in the example below.
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When in tab mode, a user has the ability to drag reports by their tab to rearrange tab group ordering or
place a report within an existing tab group.
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Interact with Tab Groups
By right clicking on a tab in a report that contains multiple tab groups, this context menu will appear:

Alternatively, if there is only one tab group on a report, this is the context menu:

NOTE

Easily navigate between many opened reports or viewers by utilizing the CTRL + tab keys on your
keyboard.


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To Do This

Close all reports, but the existing tab Select Close All But This

Keep a report at the front of a series of opened
reports

Select Pin Tab or the Pin icon

Create a new tab group below the existing one Select New Horizontal Tab Group

Create a new tab group to the right of the existing
one

Select New Vertical Tab Group

Drag a report to a different or new tab group Click and drag a tab to see tab drop
locations
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Publish Your Report to Others
To publish your report, open your private report and click: File |  Publish... Once clicked, you will see
the following form:

If the report was not previously published, the Published by value will be blank. If the report was
previously published, Published by will show who published the report. By default security, only the
person who published the report last can re-publish it. This prevents users from inadvertently overwriting
each other's published reports.

To Do this

Change the name of a
published Report

Click the edit box next to report and type in a new name.

Select target folder If you are granted the permission, you may select the public folder
where you want your report to reside. Click the ellipses to see the
control of available folders. Select the desired folder and click OK.

Select Subscribers for your
published Report

Click on the selection box under the User ID column. Pick Subscribers
by their JDE User ID, Role, or Group. Add as many users, roles or groups
as you need. If you select DASUSERS then your report will be published
to everyone who uses Data Access Studio.

Disallow Subscribers from
filtering in the QBE fields
for columns

For each subscriber row, uncheck the Allow user to change data
selection check box. The subscriber will still be able to filter using
parameters, just not on columns directly.
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To Do this

Allow Subscriber to hide
and show columns

By default, the Subscriber cannot hide and show columns in a
published report. Check the Allow user to hide and show columns
button to let the Subscriber hide and show columns in the published
report.

Disallow Subscribers from
inputing and editing
comments in the published
report

For each subscriber row, uncheck the Allow user to edit comments
check box. If unchecked, the Subscriber will be able to see comments,
but not modify them.

Publisher the report with
the settings you added

Click  Publish. Once published, your subscribers will be able to see
and run your Report.

Delete a published Report Refer to Deleting Report Content

Close this form Click Close.

Control your data if you
present it in Excel

Click Excel Presentation. See the section below.

Excel Presentation Options

To Do this

Show the Excel presentation Only (and
hide the Data behind it)

Check the Show Excel Presentation Only.
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To Do this

To make the Excel presentation
unmodifiable by the subscriber

Check the Make Excel Read Only box.

Hide Excel Menus Check the Hide Excel Menus box.

Hide designated worksheets Add the names of the worksheets that you do not want to
show to the subscriber under the Sheetgrid.

Overwrite Comments
This checkbox will be visible if both the report being published and the existing published report have
comments.

To Do this

Ensure comments in the current version of the published report
remain

Keep Overwrite Comments
unchecked (Default)

Ensure comments in the private report overwrite existing
comments in the published report

Check Overwrite Comments

NOTE

If Overwrite Comments is checked, the user will get a secondary message to confirm they want to
clear out existing published comments from the report.


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Deleting Report Content
Inside of DAS, there are a couple of different ways to delete content such as Reports, ProReports and
Dashboards as well as published content.

Deleting a Private Report, Dashboard, ProReport
From Open Report
Click File > Delete, prompting you to confirm deleting your report before clicking  Ok to delete.

From My Workspace
Highlight the report(s) you want to delete in the grid. Right Click and select  Delete. Data Access
Studio will move your deleted reports to the Recycle Bin. Any report in the Recycle Bin can be recovered
simply by moving it to another folder. When you delete your report from the Recycle Bin, you will be
prompted to confirm the deletion. Upon confirmation, the report will be permanently deleted.

Deleting a Published Report or ProReport in DAS
There are five different methods of deleting content from the Public Workspace.

Option 1: Inside of the Public Workspace, Folder Admins will have the ability to delete published reports.
This places them in the recycle bin. The report can then be deleted permanently from that location. This
does not affect the private version of the report.

Option 2: For non-folder admin, as the designer, you can open the private version of the report, select
the publish dialog again, and choose "Un-publish" making sure to include all subscribers that have
access to the public report. By un-publishing to everyone the report was initially published to, the report
is now no longer a public report and can be deleted the same way as a private report.

Option 3: Folder Administrators can remove all subscribers from a report using "Manage Subscribers".
Removing all subscribers deletes the published version of that report.

Option 4: DAS Administrators can delete the DAS_PUBLIC version of a report in the 'All Items' dialog.

Option 5: DAS Administrators can remove all subscribers from a report in the 'All Published Items'
dialog.

NOTE

Deleting a report that is used in a ProReport or Dashboard will result in a warning notifying the user
of what Viewer (ProReport or Dashboard) will break in the report is deleted.


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Recommendation: As an administrator, if you aren't 100% sure about deleting published content, you
can save as a private report to ensure access to that report content in the future remains.

Deleting a Published Dashboard or ProReport in Mobie
To delete a dashboard (or ProReport) from mobie, the original publisher of the dashboard needs to go
into the designer and select the publish dialog again. In this dialog, they will see a button to "Un-
Publish". As long as all mobie users who originally received the dashboard are listed before selecting Un-
Publish, the dashboard will no longer be accessible in mobie.

Once the dashboard is removed from the mobie web portal, deleting a private dashboard follows the
same process as deleting a standard private report.

Alternatively, mobie admins are able to remove mobie objects from the admin screen for mobie inside of
Data Access Studio.

NOTE

Because private reports that are published don't have to remain the same as the published report,
once a published report is deleted either by a folder admin or administrator removing the
subscribers, it is possible there is no version of that report available.


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Public Workspace
Public Folders are available to everyone using Data Access Studio. Public folders organize all published
reports into a hierarchy of folders. Each user will only see the portions of the Public Tree based on the
reports that are published to him/her. Any report that is not assigned to a specific folder, by default, will
be placed in a special folder called the Unassigned Folder.

To access public folders, from the home page, click the Public Workspace button(alternatively click File |
Open | Public Workspace).

There are two types of Public Folder users: Normal and Folder Admin.

Normal User
Most users will fall into Normal User category and will see a screen which resembles the following (your
folders, of course, will be different than the ones shown below):
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The Normal user is the user who uses the tree to find and run reports. The Normal user will not have an
Edit button on the toolbar (and hence no Folder Admin section of the toolbar as shown above).

To Do this

Search for a report Type search terms in the search box . As you type the tree will filter results
matching your search. To clear search results either delete the contents of the
search box or click the Clear Search Filter button.

Run a report Browse the list of results in the grid. Highlight the row you want to open and
click  Run. DAS will open and run the report.

Open a report Browse the list of results in the grid. Highlight the row you want to open and
click  Open.

Sort by most
recently created
reports

Click Last Modified. Each click will toggle between descending, ascending, and
no sort.

Exit this form Click the Back button .

Create a new folder Click New Folder.

Un-subscribe from
a report

If you would like to remove a report from your view, click the Un-subscribe
button.

Re-subscribe to an
un-subscribed
report

If you would like to re-subscribe to a report that you previously un-subscribed,
click the Re-subscribe button. DAS will show you a list of reports to which you
un-subscribed. Simply click any number of reports that you want back and click
Ok.

Edit a public report To "edit" a public report, click Save to private report. DAS will copy the public
report into your private reports and open it so that you can change your private
copy. Note: editing your private copy will not alter the public report unless you
republish the report.

Refresh tree To reload the tree from the database click the Refresh button .

Create shortcuts to
run reports

Select a report. Click Report Links and select the type of hyperlink you would
like to export.

Last Modified Filter Click the funnel icon  on the Last Modified column header to display the
Filter Search dialog. Use the Date Filter section to filter by common date
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To Do this

periods. Use the Values Filter section to choose a specific date period.

 

Record Size Filter Click the funnel icon  on the Record Size column header to display the Filter
Search dialog.

Report Name and
Based On Filter

Click the funnel icon  on the Report Name or the Based On column headers
to display the Filter Search dialog.
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To Do this

 

Workspace Search
Highlighting

Type in the search field to highlight matches in the Report Name, Based on, or
Last Modified Date columns.

Save the Folder
Layout

The folder layout is saved per user when Data Access Studio is closed.

Sort Folders By
Name

To sort folders by name make sure the Name column is sorted on and open up
the context menu by right clicking on the column. Then click on Sort Folders to
turn it on. Please note that this option will not appear if the Name column is
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To Do this

not being sorted on.
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Folder Admins
Folder Admins are the only users that can modify the public tree. A DAS Administrator can designate one
or more users to be Folder Admins (see the DAS Administrator's guide for instructions). Only one folder
admin may modify the public tree at one time. Take care editing the tree as all users of DAS will be
affected by these changes.

To Do this

Put public
folders into Edit
mode

Click the Edit button. You will only see the Edit button if you are a Folder Admin.
DAS will make sure no other Folder Admin is currently editing the public folders. If
someone else is, then DAS will show you who is currently editing the public folders.
Once DAS grants you the right to edit the public folders, you will see the Folder
Admin toolbar.

Put public
folders into
non-edit mode

When you are editing the public folders and see the Folder Admin toolbar, either
click the Edit button again or click the Back button . If necessary, DAS will ask
you to save any unsaved changes.

Save your
changes

Click the Save button. DAS will save any changes you made to the public tree.
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To Do this

Create a new
folder

Click the New folderbutton. Once created you can drag and drop the folder to any
location you desire.

Rename a folder Right-click a folder and select Rename. Enter the new name for the folder. Note:
within a parent folder, folder names must be unique.

Delete a report
or folder

Highlight the reports and folders you want to delete in the grid. Right-click and
select  Delete. Data Access Studio will move your deleted reports to the
Recycle Bin. Any report in the Recycle Bin can be recovered simply by moving it
to another folder. When you delete your report from the Recycle Bin, you will be
prompted to confirm the delete. Upon confirmation, the report will be permanently
deleted.

Exit this form Click the Back button.

Create a new
folder

Click New Folder.

Undo/Redo last
change

Click the Undo or Redo button.

Restore from
backup

Given that changes to the public tree affect all users, DAS automatically backs up
versions of the public tree. To restore to a previously saved backup, click Restore
from backup.

Manage who is
subscribed to
reports

See Manage Report Subscribers.

Place reports on
E1 menus or
web pages

Select a report. Click Report Links and select the type of hyperlink you would like to
export.
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Manage Report Subscribers
If you are a DAS Administrator or Folder Administrator, you can add or remove subscribers of one or
multiple published reports. If you are a DAS Administrator, you can access this from the All Published
Items screen. If you are a Folder Administrator, you can access this from the Folder Administration
screen.

Manage Subscribers for a Report
If you are only highlighted on one report, your navigation will appear like the below screenshot. This will
allow you to manage exactly the set of users you want subscribed to that report by either adding or
deleting subscribers. To do that, use the visual assist or highlight and delete users. From there, selecting
"Assign" (the blue arrow) will ensure that report only is published to those subscribers.

Manage Subscribers for Multiple Reports
If multiple reports are selected the form will appear like below and the subscriber list on the left will be
blank. This form will allow you to add or remove subscribers from any selected reports by choosing the
visual assist under User and searching for your users.
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Add Subscribers
If you are highlighting multiple reports, clicking the top button in the middle with the plus sign will add
users to each report if not already subscribed. Existing users' subscriptions will remain untouched.

Remove Subscribers
Clicking the bottom button in the middle with the minus sign will remove the subscribers from each of
the listed reports.

With any action performed in this Manage Subscribers window, you will receive a dialog indicating or
confirming your action. For example, you can see the dialog below indicates that you are attempting to
remove a subscriber from your reports.
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WARNING

If a report loses all of its subscribers, the published report itself is deleted. The developer owning
the private report will have to re-publish the report to recover. You will be prompted to confirm
before each report deletion.


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Report Link Tool
The Report Link tool generates URL or command-line text to launch and run a standard report,
Dashboard or ProReport. Links can be created for both published and private reports, but private links
are only usable by the user who creates them.

You can also use this tool to create links for integrations such as E1 menus and E1 pages and also to
embed dashboards in JDE via Café One.

The Launch type will usually be 'Data Access Studio URL' when running against a DAS web server.

If running on the server, there will also be an option to create a command line text string. This advanced
option would be used if an administrator wants to integrate with a third party scheduler for example.

Hover Helps
Most options in the Report Links tool have hover text to help explain each selection.

NOTE

You will need to be on the DAS web server in order to see the command line text string option.

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Option tabs

Run Mode
This tab defines how the report will run once Data Access Studio or the browser is launched.

Name Description

Report
Mode

This option defines how the chosen report will run. Options are:
Single Instance Mode (-si) : Starts DAS and opens the specified report. However,
the second or later times DAS is started with the -si, it will use this already opened
instance of DAS to run. Useful when launching many reports from a menu.
Standard Run Mode : Starts DAS and opens the specified report as if running DAS
normally.
Single Report Mode (-srm) : Open DAS for a single report. Available only for
Published Reports. Shows only the one report. All other options are hidden.
File (-file) : Runs DAS non-interactively and produces output defined by the -file
parameter.

Additional information is available via hover help when a mode has been chosen.

Auto-run
Report

If this option is available, checking it will ensure that the report is run without any user
prompting.

Embedded
Link

Choose this option to create a url that can be embedded within a web page, such as E1
pages or Café One integration.

mobie®
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For Dashboards and ProReports, this tab will be available if the report has been published to mobie. This
will allow you to create a url to this report.

Name Description

Hide Menu Choose this option to create a url that hides any menu buttons, creating a simple and
clean look for a Dashboard or ProReport.

Embedded
Link

Choose this option to create a url that can be embedded within a web page, such as
E1 pages or Café One integration.

Creating links specifically for mobie® ProReports

These options are used to affect details about presentation and behavior of your web-based ProReport.
You can usually use just the special option Controls=Embed for most CAFÉ One integrations, but we also
provide these specific options.

IMPORTANT

mobie® is the only option for Dashboard and Url generation.

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Controls
Show: (Default) - This will present the normal ProReports controls for pagination, search, and setting
parameters
Hide: Hide the ProReport controls for pagination, search, and setting parameters. Clicking on the
report will show the hidden controls.
None: Present no controls for pagination, search, and setting parameters. This will still show initial
parameter dialog if parameters are insufficient to run report.
Embed: This is special mode suitable for embedding a single, control-less, page-width report with
no menus. Choosing this one option is the equivalent of choosing all of the following options:
Controls=None, Submit=Auto, Zoom=PageWidth, and HideMenu=true.

Submit
Manual: The user must manually press the parameter submit button.
Auto: Automatically submit whenever all URL parameters combined with any defaults parameters
satisfies all required parameters.
Explicit: (Default) Automatically submit ONLY if every required parameter is provided as a URL
parameter.

Zoom
Page Width: Zoom to the extents of the width of the report.
Whole Page: (Default) Fit the whole report on page if possible.

User Login
Optionally add user credentials or enable SSO.

If using user credentials, the password will be shown in plain text. FOR SECURITY REASONS, DO NOT
USE THIS ON A WEB PAGE.

WARNING
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Report Parameters
If the report has parameters, this tab will be visible to allow the user to set these parameters.

Standard reports and DAS deployed ProReports

Dashboards and mobie deployed ProReports
Dashboards and mobie deployed ProReports with parameter values will also show the parameters tab
and will have an experience similar to, but not the same, as standard reports.

You can select single or multi-value parameter values, but parameters that use dynamic lookup settings
are not fully supported. However, you can manually type the list of comma-separated values to generate

NOTE

If you are logged in with a Windows or Okta single sign-on configuration, the dialog will indicate
that you are logged in with single sign-on and user name and password may not be specified.



NOTE

Standard reports and ProReports use the standard DAS expressions that are common when editing
the report and setting parameters within Automator.


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the Url as shown below:

File Output
If the run mode is 'File', this tab will be visible to allow selecting a folder and file name for the output.
The primary use for File Output is to allow third-party scheduling on a server via the command line.

Name Description

Output
Type

This allows you to choose supported output types for the chosen report. The proper
extension will also be set on the file name when the Output Type changes.

File Path Choose the folder and file name for the output.
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Format Your Report
Now that you understand how to save, restore, publish your report, we can address modifying your
report. When you modify a report you will be transforming your data closer and closer to the final form
that you need it. These transformations are the Building Blocks for creating any report.

See the following sections to see how to use each of the options on this Column Menu and more.

TIP

The majority of formatting operations are found on the Column Menu. To access the Column Menu
on any grid:


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Show Only the Columns You Need
JDE tables have many columns. In most cases, too many columns for a readable report. That's why Data
Access Studio lets you easily hide and show columns as you need. Furthermore, as a performance
benefit, the more columns you hide, the faster your query will run over large data sets (for a single table
report only). To understand additional performance benefits, review how to make your report run faster.

You can hide and show columns the following ways:

Click Design | Columns in the Quick Menu above the grid

Right-click the column header(s) (Column Menu). To multi-select columns hold CTRL and click the
column headers. Select:

Hide Column(s)
Show Only Column(s)
Hide and Show Columns

When you click Design | Columns in the Quick Menu or right-click and select Hide and Show Columns,
DAS will display the following form:

To Do this

Search for a
column by name

Type in the name of the column in the Filter Box under Column Caption or the
Alias under Alias.
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To Do this

Hide or show a
column

Check to Show. Uncheck to hide.

Hide or show
multiple columns

Hold the CTRL key down and click the columns you need. Then right-click your
selection and select Uncheck highlighted items to hide. Select Check
highlighted Items to show.

Show columns with
filters

Click the Show Columns with Filters button in the Quick Menu at the top of
the form.

Show system
columns

If your report has hidden system columns, the Show System Columns button
will show them. If you click this button, the column list will include system
columns that you can show.

Edit available
columns in a
business view

If your report is based on a DASVIEW (joined tables), then you will see an
additional button Show Table Join. When you click this button, you can add
and remove columns from you join definitions directly.

To accept your
changes

Click  OK.

To cancel your
changes

Click  Cancel.
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Place Columns in the Positions You Need
Data Access Studio makes moving columns easy. Simply click the column header and drag it to where
you want it. You may also multi-select columns with the CTRL or SHIFT keys and drag-and-drop columns
as a whole.

To move the Item column below:

1. Click the Column Header:

2. Hold the mouse key down and move the column to the desired position.
3. Let go of mouse button to drop:

You can also use the 'Move Column to First Position' command to move any selected column to the left-
most position.
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TIP

If you click on the column caption and begin typing, the grid will search for the column name that
you typed. Use this feature to find any column in the grid.


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Get Description for Cryptic JDE Data
JDE Data contains many codes and numbers that are not readable in plain English. Data Access Studio
solves this problem with instant Associated Descriptions. For instance, consider the data in Account ID:

Clearly the data in Account ID is not understandable in plain English. JDE, however, has an Associated
Description for Account ID that provides its English description.

For any column that has a JDE Associated Description, simply double-click the Column Header.
Alternatively, you can click the Column Header and select Quick Calculation | Enterprise One (or
World) | Associated Description:

Example result

The Associated Description calculation creates a new column next to the coded column. The new
column shows the English-readable description, which makes your report more understandable.

You may hide the original column once you get its associated description.
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If a column does not have an associated description, such as the Amount column, then you will not
see the Associated Description on the Column Menu.
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Get Totals by Column
With most reports you write, you will need to rollup information into a summary value. Data Access
Studio provides this capability with Grouping and Summarizing.

Let's say we have the account balance details, as shown below. We want to create a summary total for
each account. Having this summary will let us know if an account is in balance or not.

The first step is to group the things we want to summarize by. To group by any column, right-click the
column header to get the Column Menu. Select Group By This Column.

When we group by Account ID, notice below that Data Access Studio collects all accounts with the same
name and puts them together! Also, because Amount is a numeric field, DAS automatically sums the
values and shows you the result. Also notice that the summary operation puts a Grand Total at the
bottom.

To change a summary, right-click the column header to get the Column Menu and select Summarize |
Sum.

Once you group a column, you can click the  Group Expand button to see the detail lines. This can be
a great way to double-check your information.

Also, you may group more than one column. For each column you group, Data Access Studio will create
a subtotal automatically. You can control how you want to roll up your groups. For more information see
Fine tune Grouping and Summarization.
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You can do other summaries as well: Count, Minimum, Maximum, Average and None. You can right-
click any summary on the grid and either Suppress or Un-Suppress it.
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Set Grouping and Summarization
Once you Group and Summarize your Layout, you can fine tune how you want the grouping to look. For
this topic, you will right-click the group row as follows:

To Do this

Show all details Click Full expand.

Collapse all details to the
top group level

Click Full collapse.

Collapse all details to a
given group level

Click Group all to this level.

Always collapse details to
a given group level

Right-click the desired group node. Click Always Group to this level. All
groups will be collapsed and set to the same level as the group node that
you right-clicked.

Set the collapsing of
details to a specific level

Click Set grouping level. On the resulting dialog, enter the group level to
collapse to. If you use the up/down arrows, the grid will show you a
preview of the rollup.
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To Do this

Set page break at a
specific level

Click Set grouping level. On the resulting dialog, check Page Break and
select the level. When you export your report (to pdf or Excel) or do an
Automatic Presentation, your report will page break at the group level
you selected.

Clear all grouping Click Clear grouping.

Hide/Show summaries on
the collapsed group row

Click Hide to hide. Click Show to show the summaries.

Show the value only for
the group row label

Default. Click Group Display Style > Value only.

Show the category and
value for the group row
label

Click Group Display Style > Category and value.

Show only the text
portion of a label in the
form number.text or
number~text

Click Group Display Style > Indexed value. For instance, if your group
text is 01.My Account, then selecting this option will display it as My
Account. The indexed style lets you use the number portion to sort the
group labels as you wish. For number.text, the number portion has a
upper limit of 2,147,483,647 (number~text has no such limit).

Show the group row at
the top or bottom of the
details

Click Group Display Style > Group rows on top to show at the top. Click
Group Display Style > Group rows on bottom to show at the bottom.

Add a quick count to the
group row

Click Add Count. To remove the count, click Remove Count.

Automatically suppress
rows that summarize to
zero at the lowest
grouping level

From the Design menu, select Suppress Zeroes. If checked, then the grid
will hide any row where all visible summary values of regular and
calculated columns for the lowest grouping level are zero.
Note: When this feature is enabled, it will be shown in the Filter section of
Design Notes.
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Sort Data in Any Order
Data Access Studio lets you sort any column or set of columns.

To Do this

Sort a column from smallest to largest Right-click the Column Header. Click Sort Ascending.

Sort a column fromlargest to smallest Right-click the Column Header. Click Sort Descending.

Sort many columns from smallest to
largest

Hold the CTRL key down and multi-select the columns you
want. The order in which you click the columns will
determine which column is sorted first. Right-click the
Column Header. Click Sort Ascending.

Sort many columns from largest to
smallest

Hold the CTRL key down and multi-select the columns you
want. The order in which you click the columns will
determine which column is sorted first. Right-click the
Column Header. Click Sort Descending.

Sort by both smallest to largest
andlargest to smallest for multiple
columns

Hold the CTRL key down. Right-click the Column Header.
Pick a different sort than the one it shows.
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Customize the Look, Colors, and Behaviors of
Your Report
You can change the look of your layout by clicking Design > Grid Styles...

To Do this

Change the Font, Font Color or
Background of the available styles

Click on the Font, Font Color, or Background of any cell
to modify the property.

Hide/show vertical lines in your grid Uncheck/check Show Vertical Lines.

Hide/show horizontal lines in your grid Uncheck/check Show Horizontal Lines.

Hide/show summaries in your grid Uncheck/check Summaries.
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To Do this

Place summaries on the same line as your
group label (default)

Check Summary on group line.

Force report to sort data at the database Check Sort at Database. This option is for advanced
users only. If the Administrator denies this privilege to
you, this check box will have no effect.

Hide column headers when exporting a
report to CSV, XLS, or other format

Uncheck Export Column Headers

Fit column widths automatically after
each Find

Check Auto-Width On Find.

Keep your manual column widths intact Uncheck Auto-Width On Find.

Let Data Access Studio automatically
control the character casing for filters

Check Auto-Uppercase Filters.

Hide/show the row indicator column at
the left

Uncheck/check Show row indicator.

Hide/show the calculation indicator  in
the column header

Uncheck/check Show calculation indicator

Enable/disable Smart Column Filters Uncheck/check Smart Column Filters

Select a different Column Header type Click the Column Header options box and select the
option you want to see.

Hide the sort order numbers in the
column headers of the sorted columns.

Uncommon. Set the Multi-Sort Font Size setting to zero.

Set the report's time zone to something
different from the user's time zone or
display the report's time zone in the title
bar

Select the ellipsis on the Selected Time Zone setting.

Change the JDE module specific naming
of columns

Select a different system code (i.e. module identification)
for the 'Jargon System Code' setting. Clearing this setting
will use the default column headings as defined by the
data dictionary.
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Smart Column Filters
Several calculation will automatically add filters to the report to improve performance. Sometimes this
performance optimization can interfere with report development and debugging. Following is a list of
calculations that leverage Smart Column Filtering.

Calculation Effect of Smart Column Filtering

Relative
Period

Automatically add fiscal year and period to the query

Relative Date Automatically add known date range to the query

List Automatically add Rollup Criteria to the query

Parent/Child Automatically filter data based on configured root node

Model
Account

Ensures that the F0901 inclusion in the report is considered a LEFT OUTER join. In
other words, non-primary F0901 columns have 'OR <BLANK>' added to their filters.

The Smart Column Filter setting also controls adding the general 'OR <BLANK>' filter to the columns of
the secondary table of all standard LEFT OUTER joins. JDE also uses 'OR <BLANK>' filtering of secondary
table columns as well in the query sent to the database that this setting will not control. This setting - if
disabled - might then filter records out of the final set of records seen in the report.

Report Time Zone
By default, JDEUTIME columns display time using the time zone and optional daylight savings rule using
the user's settings from User Preferences. Normally, this is fine but there are times when a special report
is required to view time data from a specific time zone.

TIP

Disabling Smart Column Filters can help diagnose issues in complex reports.

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To override the user's default time zone, check the Override User's Time Zone checkbox and select
either UTC or the Specific Time Zone. For convenience, the current user's default time zone is displayed
to the right of the Override User's Time Zone checkbox in italics.

This time zone will be considered the Report's Time Zone. This time zone will be used for:

Displaying the date/time data in JDEUTIME columns
Used by the Convert Time calculation
Used to resolve the TODAY and NOW variables.
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Report Parameters
Report parameters provide the way for your user to input valid values to the report prior to retrieving the
results. The DAS Report Parameter system supports the following input scenarios:

1. Enter a filter value (single value, lists of values, range, etc.)
2. Single value only entry
3. Selection by automatic valid values
4. Selection by customized list of valid values
5. Select by a calendar for dates
6. Allow or disallow blank entry
7. Selection by data type: string, date, number etc.

Report Parameter Creation
Method 1: Drag a column to the report parameter space

In the example above, we drag the Or Ty column above the grid columns and drop for this result:

Now we have an Order Type parameter above the grid columns that is linked to the Or Ty column. In
this case, any value the user enters in the "Order Type" parameter will be reflected in the Or Ty column
filter. You can see that this link is present by clicking the Or Ty filter box (QBE). You will see the text
<Order Type>. Angle brackets wrap the name of the parameter and is how the parameter is referenced
in places like grid column filters or calculation inputs. If you try to clear the Or Ty column filter, DAS will
issue a warning that says you're about to break the link between the filter and the parameter -- the
default recommended course is to maintain the link.

Another feature of the Order Type parameter is that it has the same visual assist as the Grid Column Or
Ty. This means that when the user clicks the Order Type entry box, DAS will present a visual assist
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button that shows the valid Order Type values when clicked.

Remarks on Parameter Dragging
When a parameter is added to a report, an Empty Space Item is also created and placed
automatically on the right. This allows designers to enter Arrange mode and adjust the parameter's
width more easily. Review Report Parameter Arrangement to understand how to arrange the
parameter panel.
If a user drags a column into the panel quickly, the created parameter will be placed at the bottom
of the existing parameter panel. If a user drags a column and drops it in between or to the right or
left of existing parameters, it can be placed directly into a desired location instead (such as between
two existing parameters).

Method 2: Manually add a parameter using the parameter editor
To manually add/edit/delete the report parameter fields in your report, click Design > Parameters or
the 'Design' button on the parameter panel. Once clicked, DAS will open the Report Parameter Designer
as follows:

To Do this

Add a parameter
manually

Click an empty cell beneath the Name column. Enter the name for your
parameter. Tab out of the Name column. Select an editor type that is
appropriate for your parameter. If you have a Date parameter, select a Date
editor, etc. For each editor type you select, modify the properties of the editor
to best match your parameter's needs.

Delete a parameter Highlight one or more parameters. Click  Delete Row.

Make a parameter
visible/invisible

Check Visible (default) to make the parameter visible. Uncheck Visible to hide
the parameter from the user.
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To Do this

Lock a parameter Check Lock to ensure the parameter isn't removed if a Quick Form Index is
selected. By default, any parameters created from an index do not have the
Lock option checked and any parameter created manually or by dragging up a
column from the grid will have the Lock option checked.

Rename a parameter Click on the parameter name in the Name column. Type in the new name. DAS
will automatically update all parameter name references in your report to the
new name.

Close the Designer
and return to your
report

Click OK to save your changes or Cancel to discard your changes.

Method 3: Utilize Indexes from the Quick Form Dropdown Menu
In addition to the two methods for including parameters listed above, users can also utilize Index values
for their parameters by selecting options from the Quick Form dropdown that shows up in the top right
corner of DAS when reports are open.

Selecting an option from this list will pull each field value in as a parameter in the opened report.

These indexes are set up in your JD Edwards database either by default or additional entry as a
mechanism to easily identify what filtered fields will result in a faster data return.

Remarks on Indexes as Parameters
Indexes selected will default to having the Lock option unchecked. This is to ensure that if a user
wants to quickly switch their parameters from one list of index values to another, it replaces existing
parameters rather than adding to them.
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There is an administrator setting to require index filtering called Index Use to ensure users aren't
running reports without first filtering down results by a certain percentage for performance.
If the report is a DASVIEW that joins multiple tables together, index values will only appear if all field
values are pulled into the report from the Table Join wizard.

Report Parameter Arrangement
Once parameters have been created, there are a series of options to help arrange the parameters on the
parameter panel to best fit the needs of any report.

Parameter Panel Positioning
When a parameter panel is created, a user has the ability to dock or position the panel to any side of the
report as well as to pin or unpin the panel from view.

To Do This

Hide the parameter
panel unless it's
highlighted over

Select the Pin icon in the top right corner of the panel. The parameter will
then hide itself unless a user scrolls over the Parameters header. Select Pin
again to re-pin the panel to its location.

Move the parameter
panel to any side of
your report

Click anywhere in the header of the panel and drag to drop it in a different
location using the arrows that appear. If the panel is floating, it will go back
to its previously saved position upon a close and reopen of the report.
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Parameter Arrangement
When a parameter panel is created, there are a couple options seen in the top right to help designers
control the placement and design of those parameters.

Design
Mentioned in Method 2 above, Design is available either from the Design > Parameters menu or by
selecting Design from the panel itself.

Arrange
Selecting Arrange in the parameter panel will enter Arrange Mode. This mode makes it easy for
designers to rearrange parameters, align parameters horizontally, add groups or tabs and more.

To leave arrange mode, either select Arrange again or click anywhere outside of the parameter panel.

Review Items Available to Arrange
An item in the parameter panel is an element that can be used to display and organize parameter
elements. While parameters can be added by dragging or going into Design, parameter-based items are
added by right clicking while in the Arrange mode or in Advanced Arrange. Review the full list of
available items below.

Item Function

Empty Space
Item

Helps create space, increase or decrease width of a parameter. Included in the
parameter panel by default to easily control width of any included parameters.

Label Adds a label item where text can be entered. Right click and choose Rename to enter
text. This option can text wrap if its height allows.

Separator Adds a horizontal or vertical line.

NOTE

The location and pin state of the parameter panel will save with the report.

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Item Function

Splitter Adds a small splitter item to create space between items. This item can be used to
adjust spacing horizontally or vertically outside of arrange mode as well.

Group Selecting Group will place all currently highlighted items within a group. Right click
on a group header to see additional options like Rename, Group Style, and Ungroup.

Create Tabbed
Group

Selecting Create Tabbed Group will place all currently highlighted items within a
tab. Right click to the right of a tab to add additional tabs or remove the group.

Navigating the Arrange Mode
When in arrange mode, any item that is dragged will display a blue highlight as it moves. Be aware of
the blue highlight's placement as this will indicate where a item is dropped.

NOTE

Deleting a Group or Tabbed Group will result in everything inside of the group being deleted as
well. Select Undo if you did not mean to do this. Choose Ungroup instead to remove a group
without deleting the items inside of a group.





03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 171 / 480

Example

Starting position of the parameters

Drag Company from the right, down below Customer Number only

See new arrangement of parameters

Arrange Mode Right Click Menu Options
In addition to being able to select items outlined above, when in arrange mode, the right click menu has
a few additional options.

Option Definition

Best Fit Attempts to evenly distribute the items within the panel.

Size
Constraints

A series of options to allow different aspects of items to be locked or freed from
allowed default size adjustments.

Reset to
Default

Removes any size constraint options selected and resets an item to its default behavior.
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Option Definition

Free Sizing Removes any default size constraint lock on an item. For example, without Free Sizing
selected on a parameter, a user cannot expand its height manually.

Lock Size Lock an item's height and width.

Lock Width Lock an item's width only. This option may be particularly helpful if a parameter will
require a large input string.

Lock Height Lock an item's height only. If there is no other control below, even with locked height,
the item will extend the entire height of the parameter panel.

Text Options When right clicking on a parameter in arrange mode, there are also four Text Options
available.

Selecting a text position will move the title of a parameter relative to the parameter's
edit control.

Reset Layout Removes all non-parameter items and places the parameters in a single column on the
left-hand side of the panel. An Empty Space Item will be added to the right-hand side
of the panel to allow a designer to easily adjust the width of the parameters.

Advanced Arrange
In addition to arranging parameters in arrange mode, there is also an Advanced Arrange popup menu
available by selecting the dropdown by Arrange and choosing Advanced.
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This more structured view of the parameter panel is recommended when the report has many
parameters grouped in subgroups and/or tab pages. Designers can navigate and adjust their parameter
panel items through this advanced menu instead of dragging the items around directly.

The Hidden Items in this popup (Empty Space Item, Label, Separator, and Splitter) can be dragged up
into Visible Items or dragged directly into the panel for placement.
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Parameter Definitions
Once you have parameters defined, you can change the properties of those parameters in the parameter
editor. Click on the parameter you want to customize and view the Define Editor tab:

To Do this

Specify editor type Click the Editor Type selection box and pick the desired editor type:

When you select an editor type, the editor option settings below will
update to reflect options for that editor type. To enter filter values like
><=! in the parameter input, use the editor type String.

Allow a parameter editor to
access a report column's
visual assist

Include a column from your report in the Column field. This does not
automatically link this parameter to the filter on a column.

Allow/disallow blank entry To allow blank entry (default), check the Allow blank entry check
box. To force entry of a value, uncheck this checkbox.

Add a tooltip for hover help
on a parameter

Select ... for Tooltip to type in a title and text that will act as a tooltip
for your parameter. To see the tooltip, hover your mouse over the
parameter title or input box once you exit design mode.
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Editor Type Options
The Editor Type will determine what type of data is allowed to be entered by the user and will also affect
the type of visual assist available to a user. Depending on the editor type selected, the following
additional options will be available.

Editor
type

Editor
option Definition

String,
Character

Character
Casing

Choose Normal for mixed case. Choose Upper case to force entry in
uppercase. Choose Lower case to force entry in lower case.

Date Time
Support

When enabled, start and end time options are included. When disabled,
time inclusion for date ranges is ignored. When hidden, time support
entry is allowed, but start and end time visual assist options are not
displayed.

String,
Date

Single value
only

Check Single value to enforce a single value input for the parameter.
Default is unchecked.

Integer Minimum Smallest allowed integer value

Integer Maximum Largest allowed integer value

Visual Assist Types
The visual assist type will determine what a user sees when they select the visual assist on a parameter in
a report.

Visual Assist
Type Definition

Default Default will reference the editor type to identify what text is allowed to be entered in
the parameter. Default, when paired with a Column will default to display that
column's visual assist options (Address Numbers shows Address Book Master, Due
Date shows Dates, Doc Type shows the UDC table, etc.). This option provides a filter
button on the entry field that assists the user with the various filter options (list, not in
list, range, etc.). See Example.
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Visual Assist
Type Definition

Custom value
from list

Parameter designer specifies a list of valid values manually. If the valid values also
have associated descriptions, then these will be shown to the users as well (although
the report designer may override even this description in the list). Use this option to
limit the valid choices to a user. See Example.

Custom
description
from list

Like custom value from list, but rather than selecting by value, the user is presented
with the descriptions of those values only. This mode is handy to show the user a
more friendly (and customizable) list of options which get resolved to the
description's values automatically. See Example.

Report Link to a report to use it as the visual assist for a parameter making it easy to
dynamically return only the results needed or utilize cascading parameter
functionality where one parameter filters the options available in the next. See
Example for Standard Report Visual Assist and Cascading Parameters.

Example: Default Parameter
Create a Company parameter linked to the Company field in a report.

1. Drag up the Company column from the report to create a report parameter.
2. Check the visual assist ellipses (...) to confirm that the Company visual assist appears.
3. Select a Company ID and select Get Sample Data or Run Report to see the results change as this

parameter is automatically linked into the filter field for Company.
4. Select Design on the parameter panel to view the editor settings for the Company parameter.
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Example: Custom Description from List Parameter
Suppose we wanted to allow the user to pick from two Ship To address numbers. The address number in
this case is the "backer value" - it is that which we want to use to query. However, the user doesn't
recognize address numbers as easily as the Ship To name. By using Custom description from list, we
setup the Custom valid values as follows:

Here we enter the valid address numbers. Notice that the Description value automatically defaults to
Associated Description which means DAS will automatically get the description for the number. You
may override the description with any text.

Once set up, the user simply selects by description:

Once the user makes the selection, the Ship To token is set to the corresponding address number for
that selection.

Example: Custom Value from List Parameter
Suppose we wanted to allow the user to pick from three Company numbers. In this case, the user may
prefer to select by company number rather than description as it is short and recognizable to the user.
By using Custom value from list, we set up the Custom valid values as follows:
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Here we simply enter each valid Company number on each line. If the column has an associated
description, this will be the default description per line. You may override the description with any text.

Once setup this way, the user selects by Company number:

Here the user selects by number and the selection is shown as the number that's selected. The
description only shows up in the Valid Values selection.

Example: Report Visual Assist Parameter
Suppose you are designing an AP Detail Report using the F0411 table with one parameter, "Vendor
Number," built by dragging up the Address Number/AN8 field. As a designer, you want to ensure that
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your subscribers only see Vendors when they view the visual assist of the Vendor Number parameter,
but, by default, it displays the full list of address numbers which includes customers, vendors, employees
and more.

We can create a report visual assist for this parameter to limit these options. These instructions assume
an AP Detail Report report has already been created.

Step 1: Create your report for the visual assist

1. Open a new F0101 table.
2. Limit the column results to just the Address Number (AN8), Alpha Name (ALPH) and Sch Typ (AT1).
3. Filter Sch Typ = V (for Vendor).
4. Save the report as "Vendors Visual Assist"

Step 2: Edit the parameter in design mode to use the report visual assist for Vendor Number

1. Return to your "AP Detail Report".

2. Select Design in the top right corner of the parameter panel.

3. While selected on your "Vendor Number" parameter, change the Visual Assist Type to Report.

4. Go to the Report visual assist options section and fill in the following...

5. Select OK to save.

6. Review visual assist. See that only Vendors are being returned because of the filter on Sch Typ.

Alternatively, you could apply the Sch Typ filter for Vendor directly into the parameter editor in the
Report visual assist parameter assignment section as seen below.

NOTE

The Run Mode option determines if the visual assist will Get Sample Data or Run in full. If a
visual assist report may run more slowly when fully executed, the recommendation would be to
utilize Get Sample Data as the Run Mode option which still allows a user to select Find and
return all results once in the visual assist.


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Example: Cascading Parameter
Suppose you're in the same AP Detail Report, but you now want to add Company and Business Unit
parameters. Rather than having the default visual assist for both, you'd like the Company parameter to
be required and filter the Business Unit visual assist results to only show Business Units under the
selected Company filter.

We can create another report visual assist for these requirements.

Step 1: Add Co and BU parameters to your AP Detail Report

1. In your existing "AP Detail Report" ensure Business Unit (MCU) and Company (Co) are visible
columns in your report. If not, select Design > Columns and add them.

2. Drag up both Company (CO) and Business Unit (MCU) to create two additional parameters.
3. Review existing visual assists for both parameters.

Step 2: Create your report for the BU Visual Assist

1. Open a new F0006 table.
2. Limit the column results to just the Business Unit (MCU), Description (DL01) and Company (CO)

fields.
3. Save the report as "Business Unit Visual Assist".

Step 3: Edit the parameter in design to use the Report Visual Assist for Business Unit

1. Return to the "AP Detail Report".

2. Select "Design" in the top right corner of the parameter panel.

3. While selected on your "Business Unit" parameter, change the Visual Assist Type to "Report".

4. Fill in the following fields as seen in the image below: Report, Selection Column, and Report visual
assist parameter assignment.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 181 / 480

5. Select OK.

6. Fill in a Company and then select the ... on Business Unit in your parameter panel to see the custom
visual assist you've just created.

7. Adjust the Company filter and select the ... on Business Unit again to see it change.

Additional Remarks for Cascading Parameters
Adjusting Cascading Parent Parameters Impacts Children
Suppose that parameters are filled in on your report: Company 00001 and Business Unit 1;3;4 from that
cascading parameter list. Adjusting the Company filter will result in a clearing out of the Business Unit
parameter values as those are no longer valid values for that Company.

Default Assignment Behavior
By default, any cascading parameters where the parent parameter is left blank will result in the child
parameter's visual assist returning all results (no filter applied). This is because the default assignment
behavior is set to "No Filter".
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If you would like to make it so the parent parameter being blank results in the child's visual assist
filtering on <BLANK> for that link, you can adjust the assignment behavior by selecting the blue arrow
on your parameter editor (see screenshot below).
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Prompt for Values
Once you have designed your Report Parameters and clicked OK or Cancel (which closes the designer),
Data Access Studio will show the user prompt that you designed. For example:

To Do this

Enter a parameter Click on the edit box next to the parameter you want to modify
and enter a value if the Allow typing was set for the parameter.

Run the Report with the
parameters you entered

Click 

See some sample rows for the
parameters you entered

Click  Get Sample Data.

Edit and design your parameters
(Designer user only)

Select Design in the top right of the parameter panel or click 
and select Parameters.

Resize the width or adjust
parameter placement in your
panel.

Review the Report Parameter Arrangement documentation.

If the parameters that the user entered violate a entry rule, DAS will pop up the error message below the
offending parameter value. The popup will instruct the user how to correct the data entry issue.

Once you design your parameters, you can also connect the parameters to certain calculations. See
Connect a Report Parameter to a Calculation for more information.
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Copy Column(s)
You can copy multiple columns. To copy one or more columns:

1. Multi-select the column headers you want
2. Right-click on the Column Header for any column in your selection
3. On the popup menu, select Copy

DAS will create new copies for the selected columns and highlight the new columns when the copy is
complete. You can proceed to edit the new copies by double-clicking the column header.
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System Variables
Use System Variables to get information about the signed-on user. You can use this information to filter
data, name reports, or set column captions.

List of Available System Variables
Variable Description

SYS_USER_ID Login ID of the user.

SYS_USER_Description User name from the address book.

SYS_USER_BusinessUnit Business unit for the user.

SYS_USER_Company Company for the user.

SYS_USER_Type Address book type of the user (e.g. 'E' for Employee).

SYS_USER_Environment Login environment of the user.

SYS_USER_SignedOnRole Login role of the user.
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Rename a Column
By default, Data Access Studio names columns based on their JDE Data Dictionary description. You can,
however, override this caption and change it to whatever you wish.

To Do this

Rename a
column

Right-click the Column Header. Select Rename. Type a new name and click OK. You
can press the  button to see parameters and variables that you can also use in your
column header. For instance, let's say you had a column that shows period amounts
and the user can enter different period amounts via a parameter. Then, if you select the
period amount parameter tag in the Column name, as the period numbers changes,
the column header will change too! Parameter tags are in the form of: <tag>. You can
place the tag anywhere in your column header. For instance: Current Period
<Period>.

Change the
column
caption to
pre-set
value

See Column Caption in the Customize the Look and Colors of Your Layout topic.
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Presentations
After gathering and transforming data into a logical report, this data will often need to be presented in
some way. From presenting in Excel, to being hosted using a BI dashboard, Data Access Studio provides
many different methods of presentation. These methods can be access from the Design menu of a
report:

You can also present to a ProReport or a dashboard from your 'My Workspace' or 'Public Workspace'
areas.

Summary of presentation methods:

ProReport will bring up our ProReport New Report Wizard to guide you through constructing an
enterprise-grade report.
Dashboard will bring up our dashboard designer for this report so you can create an interactive BI
dashboard.
Excel Presentation will embed Excel into this report allowing for tight integration with this very
useful tool.
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Presenting from a Report
Toolbar Menu
The Report toolbar contains a menu option for presenting to Excel, ProReport and Dashboard.

Present to ProReport from Toolbar
From the menu select Design > Present Data to > ProReport and select the option for Automatic or
Wizard.

Grid Popup Menu
The Report grid column headers display a context menu when right-clicked. Options are available to
present to Excel, ProReport and Dashboard.

Present to ProReport from Grid
From the popup menu select Present Data to > ProReport and select the option for Automatic or Wizard.
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Showing Viewers
A ProReport or a dashboard that is presenting your data is called a viewer. To manage your
development, you will want to be able to see what ProReports and dashboards use your reports. You can
see this list from the 'Show Viewers' sub-menu of the design menu of a report. The notation '(Published)'
indicates that this viewer is published to mobie.

You can also view this same list from the 'My Workspace' area.

NOTE

The selected grid column can be unmapped by un-checking the Automatically map this column
option, meaning it will not show up in the columns for the ProReport.





03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 190 / 480



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 191 / 480

Add Charts and Excel formatting to your report
You can present your report with all the features of Excel. With Excel Presentation, your query comes
alive with graphs, dashboards, and pixel-perfect formatting:

Data Access Studio provides two ways to format your report in this manner:

Automatic presentation
Manual presentation

In general, use the Automatic presentation for new reports. The Manual presentation method (which
uses row padding for nested groups), is there for legacy reports.
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Automatic Presentations
The Automatic presentation mode supersedes the old way of presenting your data in Excel. Automatic
presentations automatically track changes you make on the data tab. For instance, if you add new
columns or change the grouping, the change automatically appears on the presentation tab.

Automatic presentations also do away with row padding. This means you may have as many grouping
levels as you want (formerly had a limit of 3 group levels). Also, the new mechanism is more efficient
with memory – so the size of your resulting report will be smaller as well.

Automatic presentations work seamlessly with downstream Excel formulas and charts. Automatic
presentations keep formulas and charts intact as your incoming query data changes. Also, the formulas
track changes to the List calculation. For example, if you add a row to a List, all formulas based on other
amounts will remain unaffected.

Finally, Automatic presentations let you quickly create beautifully formatted report elements. To get you
started, we’ve provided over 30 different customized styles that you can quickly apply and customize.

Creating an Automatic Presentation
To automatically present your data in Excel, right-click a column to get the Column Menu. Select 
Present data > Automatic.

DAS will embed Excel under the Presentation tab and map all visible columns automatically with the
default style (more on that later). Note also the appearance of the Presentation menu item in the
toolbar (see Control the Excel Presentation).
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Once you create your automatic presentation, you can control it in many ways.
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Controlling the Automatic Presentation
Once you've added an automatic presentation to your report, you can control it as follows:

To Do this

Exclude a
column from
being
presented

Either: 1) hide the column or 2)
Right-click the Column Header.
Uncheck Presentation

Automatically map this
column.

Include a
column in
presentation

By default, all visible columns are
automatically presented. So if you
add a calculation column it will
automatically show in the
automatic presentation. If you
previously unchecked
Presentation

Automatically map this
column, then right-click the
Column Header. Check
Presentation

Automatically
map this
column.

Change the
column style
mapping

Each column is automatically
mapped to a default style. For
instance, the grouped column is
mapped to the style GROUP. You
can change the default style as
follows: Right-click the Column
Header. Select Map to style ->
and select the desired styles from
the available styles. See Automatic
Presentation Styles for more
information.

Change how
the
presentation
looks

SeeAutomatic Presentation Styles.

Change the
report
grouping level

Just change the grouping level in
the data tab, the Automatic
presentation automatically
updates itself. Also, if you move
the grouped column, the
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To Do this

automatic presentation will track
the movement.

Add a chart or
formula

Click Refresh . Then add any
chart or formula you want using
Excel notation. DAS will
automatically track the formula
and chart as the data in the data
tab changes (e.g. with different
queries).

Add row above
the
presentation
area

Click Refresh . In Excel, insert a
row. Also, you can click
Presentation

Advanced Edit and enter a
value for Excel row explicitly.
You can also change the
target sheet and column for
the Automatic presentation
by changing the Excel sheet
and Excel column values.

Remove/Edit
text for Totals
row

By default, the automatic
presentation prefixes the total lines
with the word "Total -" and the
label of the group. E.g. Total - Bank
account. To change this behavior,
click Presentation

Advanced Edit. Edit the field
value for Totals label. You
can type any text you want or
remove the text altogether.
The special tag
[GROUPLABEL] means the
text value of the current
group label (which will
change depending on the
row).

Toggle Excel
outlining

By default, when you add an
Automatic presentation, DAS does
not add Excel outlining to the
presentation. To add Excel
outlining (i.e. +/- group collapsing
in Excel), click Presentation

Advanced Edit. Modify the
field value for Excel
Outlining. Note: adding
Excel outlining can slow your
report down.

Remove the
Automatic
Presentation

Right-click the Column Header.
Select Presentation

Remove Presentation.
Alternatively, from the report
tool bar, select Presentation

Un-embed
Excel.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 196 / 480

To Do this

from your
report
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Automatic Presentation Styles
The automatic presentation feature provides a rapid way to style your presentation. Consider the
following four screen shots:

Each is a different style for the same report. With one click, the user can transition between each of the
above styles.

A style is any Excel format (color, font, size, numeric precision, conditional format, border, etc.) that you
specify for a specific element. You can see that it is possible, for instance, to do odd-even row shading
and conditional formatting.

Pre-built DAS Styles
To get you started with styles, DAS ships with about 30 pre-defined styles. To try out a predefined style
on a report with an Automatic presentation, click Presentation > Styles.
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Click any row and your automatic presentation will apply the style you selected. See Managing Styles
for more information.

How Do DAS Styles Work?
Now that you've had a chance to play with the pre-built DAS styles, let's consider how styles work. Once
you understand this, you can create and save your own custom styles.

First, why do we need DAS styles? Without DAS styles, you would be forced to format your Excel
presentation cell by cell. The problem with this approach, other than tedium, is that as soon as your data
changes, all of your formatting is incorrect. So this approach clearly cannot work for reports in general.

As opposed to styling cell by cell, DAS Styles format by a cell's type. A cell has two components to its
type: the Row Type and the Column Type.

Row Types
Row Type Description

CAPTION The text in the header part of the grid column

GROUP The text for the group by each group level
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Row Type Description

DETAIL The text and amounts at the detail lines

TOTAL The text and amounts for a group's total at each level

GRANDTOTAL The data for the column grand total

DEFAULT The default formatting

SPACER The spacing between a total and the next group

So given this simple set of types you can, for instance, define that you want the Group caption to be
Arial, font size 14, and blue. No matter what the input data (whether it's 100 rows or 100,000 rows), the
group styling will always be correct. Note that row types are referenced by the literal labels in the table
above. Also, GROUP, TOTAL, and SPACER support appending a number to specify "at which level". For
example, GROUP1 means the styling for group level 1.

Column Types
Column Type Description

GROUP The group column

FIRST The first column

LAST The last column

DEFAULT Any column by default

USER_DEFINED Any user-defined style to be applied by column (note that the Type in this case can
be any name - it does not have to be USER_DEFINED). You may also specify as many
user-defined column types as you need.

The column types let you specify column-specific styling in conjunction with the row type.

The DAS_STYLES sheet
When you combine Row Types and Column Types you get the DAS_STYLES sheet. All automatic
presentations have a DAS_STYLES sheet. This sheet is the matrix of the row types and columns types that
define the style for your presentation. When you select a style, this is the sheet that gets updated with
the style's data.
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The image above shows the DAS_STYLES for the template "Color Tiles 3". You can see it is simply a
spreadsheet of formats for each row and column type. The COMMENT tag means ignore any text below
the COMMENT tag.

If you modify any of the formats in the DAS_STYLES sheet, then you customized the style. For instance, in
the screenshot above, you could change the GROUP1 text to be blue (Cell B3). Once changed, all your
Group level 1 text will be blue. See Managing Styles for more information about saving and publishing
custom styles.
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Managing Styles
To control the DAS presentation styles on a report with an automatic presentation, click Presentation |
Styles.

This dialog lets you control the styles in your reports.

To Do this

Apply a style to
your report

Click any style row. DAS will apply the selected style to your
report.

To set a style as
the default

Check the Default check box for the style. Once checked, the
next time you create an automatic presentation, this is the
style that will be applied. If no style is checked, then DAS uses
the internal bootstrap style for new automatic presentations.

Customize a
style

Click any style row and select Customize Style from the
toolbar. DAS will display the styles DAS_STYLES sheet for you
to edit. Once you are done editing, click Save style to save
your style to either a new name or overwrite an existing name.
Note: you cannot rename pre-existing styles; but you can

Spreadsheet Look
and then selecting
the DAS_STYLES
worksheet.
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To Do this

copy these styles to your private styles with the same name.
You may also customize a style from the Report tool bar by
clicking Presentation

Rename a style Click on a style row and click Rename in the tool bar. Enter the
new name for the style. If you select an existing name, DAS will
warn you of overwriting if necessary.

Delete a style Click on a style row and click Delete in the tool bar. Note: a
DAS Administrator must grant you delete rights to delete
public styles.

Publish a style
to others

Click on a private style and click Publish. The style will be
copied to the public space. Note: a DAS Administrator must
grant publishing rights for your to publish styles.

Copy a pre-
built or public
style to your
private styles

Click a public or pre-built style. Click Copy to private in the
toolbar.

Add page
breaks for top
group

Click Page Break on Group. DAS will add Excel page breaks
for all Group level 1 level breaks. Note: Excel 2010 and earlier
can only insert up to 1024 page breaks. If your report exceeds
this limit, consider using Bursting instead.

Create a new
folder

Click New Folder.

Rename a
folder

Right-click a folder. Click Rename. Enter the new folder name.

Undo/Redo last
change

Click the Undo or Redo button.
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Manual Presentation
You can choose to present your report with the Manual presentation option. The Manual presentation
provides the most flexibility for simple reports. If your report is complex (for example, you need more
than three group levels or have hundreds of thousands of rows of data), you should opt for the
Automatic presentation approach (see Automatic Presentation).

With Manual Presentations, your query comes alive with graphs, dashboards, and pixel-perfect
formatting:

To present your data in Excel, right-click a column to get the Column Menu. Select Presentation.
Data Access Studio will display the following screen:
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To Do this

Add columns to
present

Click on the visual assist in the From grid list. Select the columns you want.

Re-order the sequence
of columns

Click on the grip bar  and drag the column name to the position you want.

Map data to Embed
Excel but do not
graphically present it
(old style Embed Excel)

Set Sheet to blank or DASLink.

Change the target
sheet where you want

Change the Sheet text box to the name of the Excel sheet you want.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 205 / 480

To Do this

to present the grid
data

Change the target cell
where you want to
present the grid data

Change the Cell column and row values.

Change upper limit on
the number of rows
for the presented data

Change the Row Padding value. The Row Padding value sets the upper
limit on the number of rows Excel will present. Pick the smallest number that
you know will be bigger than the number of rows you expect from your
query and grouping. For instance, if your grid groups business unit and you
know that the maximum number of business units for any given query will
not exceed 500, then set the Row Padding to 500. If you make this number
smaller, it will be easier to format your Excel presentation later.

Map data only (and
hence do not graph
the values)

Select None for Chart Type.

Create a chart for each
column. X axis = rows
and values of the chart
are the values in the
grid.

Check One chart per column. Select the visual assist for Chart Type and
select the type of chart you want. DAS will create an array of that chart type
in the Excel presentation.

Create a chart for each
row. X axis = columns
and values of the chart
are the values in the
grid.

Check One chart per row. Select the visual assist for Chart Type and select
the type of chart you want. DAS will create an array of that chart type in the
Excel presentation.

Specify how you want
the graphs to be laid
out in the presentation

Click the Pattern option and select how many columns to use when laying
out the resulting graphs.

Specify borders for
your graphs

Check the Border box for borders. Un-check the Border box to create
graphs with no borders.

Specify round corners
for your graphs

Check the Round Corners for round corners. Un-check for square corners.
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Once you have configured the options you want, click the  Map Columns to Excel to complete the
presentation. Whenever you Map Columns to Excel, DAS overwrites the previous mapping. Usually, it is
a good idea to clear the target sheet before re-mapping graphs to it.
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Control the Excel Presentation
Once you present your data in Excel, DAS displays the  Presentation menu option on the Quick
menu above the grid. You can use this menu to control how DAS presents your data in Excel. To access
these options, click on the  Presentation menu:

To Do this

Adjust the Excel width
automatically after each
query

Check the Best fit after query button. Uncheck this button to keep Excel
column widths intact.

Best fit the current
visible sheet now

Click Best fit sheet.

Auto fit the sheet width
to the width of the
printer

Check the Auto-fit to printer. Note: If you want to add page breaks to
your presentation, make sure to uncheck Auto-fit to printer.

Hide/show spacer rows
used in Manual
Presentation groups

Check the Filter sheet to hide the spacer rows (as defined by the
Presentation > Advanced edit > Map group values to Excel > Row
padding). Uncheck to show the spacer rows. Note: Show the spacer rows
if you want to apply Excel Format Cells.

Format the cells of
Manual Presentation

Uncheck the Filter sheet button, to make all spacer rows visible. Select the
cells and spacer cells and apply the desired Excel Cell Formatting to the
cells (E.g. numeric format, bolding, etc.). Re-check the Filter sheet button
when you are done to once again hide spacer rows.

Show a "clean" look for
your report

Click Report look.

Show a "spreadsheet"
look so you can edit
your report

Click Spreadsheet look.

Hide/show Excel menus Click Toggle > Menus.

Hide/show grid column
and row headings

Click Toggle > Headings.

Hide/show grid lines Click Toggle > Lines.
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To Do this

Hide/show worksheet
tabs

Click Toggle > Worksheet tabs.

Hide/show status bar Click Toggle > Status bar.

Wipe out the visible
sheet (i.e. start with a
"clean slate")

Click Clear active sheet.

Present visible grid
columns in Excel

Click Map visible columns to Excel. Once you click, DAS will present the
dialog to present columns in Excel Add Charts and Advanced Formatting.

Manually edit and refine
previous mappings

Click Advanced Edit. With this option, you can append new maps at the
end. Use this option if it is important to maintain the order and columns of
a previous mapping. You may also add additional mapping such as Report
Parameter mapping with this editor.

Remove the Excel
Presentation

Click Un-embed Excel. DAS will remove the Excel presentation and show
the grid showing your query data.

Utilize DAS Variables in the Excel Presentation
The presentation layer provides a dynamic set of referenceable variables within your reports, including
report metadata such as report name and last select time, along with any report parameters and system
variables. These variables can be referenced directly within the presentation layer by typing in =DAS with
the name of the variable.

Variable Definition Example

=DAS_ReportName Returns the full name of the
report.

=DAS_ReportName resolves to
Supplier Metrics by Business Unit.

=DAS_ReportType Returns either Private or Public
based on the report.

=DAS_ReportType resolves to
Private.

=DAS_LastFetchTime Returns the date and time
when all records run for the
report have been loaded.

=DAS_LastSelectTime resolves to
46073.66 OR 3/2/26 3:46 PM (after
formatting adjustments)

=DAS_LastModifiedTime Returns the date and time of
the last save of the opened

=DAS_LastModifiedTime resolves to
46083.63 OR 3/2/26 3:03 PM (after
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Variable Definition Example

report. formatting adjustment)

=DAS_LastSelectTime Returns the date and time of
the last time data was pulled
from the database (or external
data source) for the report.

=DAS_LastSelectTime resolves to
46073.66 OR 3/2/26 3:44 PM (after
formatting adjustments)

=DAS_[ParameterName] Any parameter created in this
report will be available to
return in the presentation
layer.

=DAS_Business_Unit resolves to
10;20;30;30M.

=DAS_[SystemVariableName] Review the list of available
system variables.

=DAS_SYS_USER_ID resolves to the
logged in user.

NOTE

Any time-based DAS variables will display in the general Excel format by default. Adjust the number
format to return the variable in a date, time, or date and time format instead.


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Excel Pivot Tables and Charts
Both manual and automatic presentations support embedding pivot tables and charts. This allows
advanced Excel users to leverage a powerful feature of Excel with DAS. The data in DAS is mapped to
Excel without grouping or expanded groups, and then a pivot table or chart is linked to the mapped
data.
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Important Limitations

Pivots in Manual Presentations
If you do not have to display the source data brought in by DAS, it is recommended that you use a
manual presentation to back your pivot table or chart. A manual presentation performs better since it
only brings in data and does minimal styling processing in Excel. This feature is ideal when the report
only shows a pivot table or chart.

When creating the pivot table or chart, make sure to select just the columns in the DASLink page to
ensure that the pivot datasource works with varied row counts coming in from DAS.

Pivots in Automatic Presentations

NOTE

Columns that use variables in caption names (such as conditionals ('<within>') or relative periods
calculations) should have those variables removed before being used by a pivot table or chart. Excel
pivot tables and charts cannot reliably handle changing column caption names and will silently
remove these columns from the pivot when the caption name changes.



NOTE

Excel slicers are not supported.

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If you need to display the data in addition to your pivot table, the automatic presentation is
recommended.

When creating the pivot table or chart, use the 'DAS_LinkData' named range to ensure that the pivot
datasource works with varied row counts coming in from DAS.
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Calculations
Data Access Studio provides two calculation methods to transform data:

1. Calculation Columns
2. Global Variables

Calculation Columns
Calculation Columns give you the power to create information derived from your grid. Calculation
Columns differ from Excel cell calculations in that Calculation Columns work for any number of rows. This
row-independence means you can design reports that are more useful and re-usable on JDE data than is
possible with Excel.

Quick Facts:

Each Calculation Column lets you transform your data visually.
Many calculations support Quick Calculation. With Quick Calculation, you can select multiple
columns, right-click any column header in your selection, and select Quick Calculation > ... to
complete the calculation you need. See Associated Descriptions for an example.
Once you add a calculation, you will see the results of the calculation in your grid immediately.
You can edit a calculation by double-clicking its column header. (Edit Calculations with the Editor)
You can edit all calculations. (Edit Calculations with the Editor)
You can delete a Calculation Column by right-clicking the column header and selecting:  Delete
Column.
You can filter Calculation Columns just like any other column. Note: If you have a slow-running
query, Calculation Column filtering won't improve database query performance.
Data Access Studio re-calculates when you find new data or when it detects a change that forces a
recalculation.
Data Access Studio automatically determines dependencies, calculation order, and circular
dependencies.

Formula
The formula calculation is a special Calculation Column that allows you write an expression combining
many different calculations.

Only Rollup If
Most calculations will have a parameter named Only Rollup If. You can edit this parameter to have any
condition you need that specifies whether you want the calculation value to apply. For instance, let's say
you had a calculation that calculates the total price. You could edit the Only Rollup If parameter to
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specify that you only want the total price to apply if the customer has paid on time. Once you set the
condition, then the total price will only have a value if the condition is met.

Layout
Each calculation will be on its own page with a description of the calculation, remarks, an example and a
layout of what information is needed for the calculation editor.

1. Date
2. Math
3. Database
4. System
5. Text
6. Trig
7. Enterprise One / World

Global Variables
Global variables are calculated values that can use parameters (See: Prompt for Values), system values
(See: SystemVariables), or constants to create derived information prior to running a report.

Primary uses:

Create filters which derive from input parameters to filter grid column data. For example, if you have
an input date parameter, you could make a global variable to create a filter selecting the first day
and last day of the month relative to that input date. Then you can use the global variable as the
filter to a grid column so your report shows only the range for the first day to the last day of the
month for your grid data.

Create static information to use in Calculation Columns (see below).

Create static information.
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Edit Calculations with the Editor
Data Access Studio provides the following ways to edit calculations.

To Do this

Edit a single
calculation

Double-click the Column Header. Or
right-click the Column Header, and select
Calculations

Edit... Either of these actions will take
you to the calculation flow view (see
below)

Edit all
calculations

Click Design Calculations.... This option will take you
to the calculation list view

DAS has two ways to view calculations.

1) The calculation list view, where all the calculations are shown.

2) The calculation flow view, where the flows into a selected calculation are shown (see Calculation flow
view below)

Calculation list view
The calculation list view allows you to add, delete, edit, and copy calculations. You can rearrange the
display order of the calculations by drag and drop.

To Do this
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Add a calculation Click on an empty box under Calculation type. Click on the
Visual Assist to select from a list of available calculations. Or
type in the name of the calculation directly. Click TAB to
apply. Once applied, the calculation-specific parameters will
show under the Parameters tab.

Delete a calculation Highlight one or more calculations on the left-hand side.
Click  Delete.

Edit a calculation Highlight the calculation row on the left. Edit the values
under the Parameters tab. You may also change the
Column Caption and Output Type (if the particular
calculation allows it).

Copy a calculation Highlight the calculation and click  Copy. The copied
calculation will appear at the bottom.

Disable a calculation If you want to keep a calculation from running, but you don't
want to delete it, you can uncheck the Enabled checkbox for
the calculation. When a calculation is disabled, it will emit
the default value for the calculation and skip running the
calculation itself.

Re-arrange the calculation display
order

When viewing the list of calculations, it can be handy to re-
arrange the row display order of the calculations. To re-
arrange calculations, click on the Row Control area. Drag
and drop the calculation row to the desired location and
drop. You may rearrange multiple calculation rows at a time
(user standard Ctrl-click and Shift-click) to select multiple
rows

See the value of a calculation for a row If your grid has rows loaded, the Value column will show the
calculated values for that row. To select another row to
evaluate:

Right-Click the Value column.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 217 / 480

Select Evaluate Previous Row to see all calculation values
for the previous row

Select Evaluate Row (nnnn) to re-evaluate the values for
the current row

Select Evaluate Next Row to see all calculation values for
the next row

Check/Uncheck Auto-evaluate to turn calculation evaluation
on or off respectively (default is on)

You may also evaluate the calculations directly from the
report. If you are on the Data tab of your DAS report, you
can right-click a detail row and select the Debug option.
Once selected, DAS will show the calculation editor and
evaluate the calculations for the row you selected.

See calculation dependencies If your calculation row shows a magnifying glass in the row
(Show flowchart), then this means the calculation depends
on the results of other calculations. You may click the
magnifying glass to see the flow chart.

Typing shortcuts:

Key Effect

TAB/SHIFT+TAB Tab to the next/previous editable field. Tab from the last editable field of the header
row will activate the first editable field in the Parameters grid.

F4 Open any active visual assist. If the visual assist is not active, you can press ENTER
and then F4 to open the visual assist. When selecting from the list of valid values,
you may type in the value you need in the filter box, and then press Alt+S to select
the value.

Calculation flow view
The purpose of the flow chart view is to show you how your calculations inter-relate. This view is useful
for visualizing complicated calculation logic. The flow lines show which calculations flow into which (flow
direction indicated by the arrow). Also, the Value column shows the evaluated values (if available) for
each stage of the flow. In the example below we see that the Account category calculation feeds in the
YTD calculation (for this row, the value it passed the value GLG9)



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 218 / 480

You can see calculations in flow chart view as follows:

1) If you double-click a calculation column header in your DAS report.

2) If you are in the calculation editor in list view and you click the magnifying glass next to the
calculation editor

To Do this

Go back to the
calculation list view

Click the Back to list view button at the top of the flow chart

Expand and collapse
levels of detail

Click the top Level of detail arrow to collapse to higher levels of the flow
chart. Click the bottom Level of detail arrow to expand to more detailed
levels of the chart
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Connect a Report Parameter or System Variable
to a Calculation
When you create Report Parameters for your layout or want to access information about the signed-on
user, you may want to connect these variables to a calculation input:

1. Click on the Parameters tab for the calculation you want to connect to a Report Parameter.
2. Click the  Filter button.
3. Select Variables > select the name of the parameter you want to connect.

Once a Report Parameter is connected, when the user changes the value of the parameter, the
calculation parameter will change as well. This is useful, for example, in the Period Amounts. You could
hook up a Parameter called "Period" to the "End Period" of that calculation.

Once a System Variable is connected, when a different user signs in, the calculation parameter will also
change as well. This is useful when creating self-service reports that a user might access from a web
portal.
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Troubleshoot Calculation Errors
If your calculation has an error, DAS will red-out the cell values that have an error in the grid.

To identify and resolve errors:

1. Run your calculation.

2. Right-click on calculation cells that are red.

3. Read the message box instructions and optional resolution.

4. Press "Edit Calculation" to correct the error.

Common errors include:

Invalid type conversion

Missing inputs

Blank inputs

Missing options

Circularly dependent calculations

Performance considerations
The calculation architecture is designed to provide maximum performance. This includes:

1. Only re-calculating necessary columns.

2. Caching results when appropriate (associated descriptions and table lookups).

3. Taking minimum steps in repetitive calculations.

Overall, the result should be that adding new columns has little performance impact on your layout.
Calculations can, however, impact performance if they are used improperly. The section that follows
outlines best practices for using calculations:

Delete any calculation that you are not using.

Limit the number of Table Lookup calculations. A table lookup will query data from other tables. If
this is done excessively, the overall performance of your report may suffer.

If you are querying against a large table (>1,000,000 rows), make sure that your report filters on at
least one database column. You may filter calculation column results; however, the database itself
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cannot recognize these filters. Because calculations are derived data, filtering calculations will not
result in a smaller set of rows retrieved from the database.
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Global Variables
Global variables are values you define that can be used in your report for:

Filters
Inputs to grid calculations
Display values in headers and presentations.

To create one or more global variables for your report:

1. Click  Design.

2. Click Variables

3. DAS will present the Calculation Editor (See Edit Calculations with the Editor) for variables

Editing variables is similar to editing calculation with these important differences:

Variables can only use input Parameters, System Variables, Constant values, and other variables as
inputs
Most, but not all, calculations are supported in variables mode. The editor will show which
calculations are available
Variables can feed the report filters before the report is run (i.e. the variable values can shape the
data set of your report query if desired)
As you edit variable values, the evaluated value will show in the calculation editor immediately
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Variables as Filters
One of the primary applications of Global Variables is to create dynamic filters.

Example
Suppose you have a report with an input parameter named Date

Now suppose you want to filter the Order Date column with the range of the first day of the month
through the last day of the month based on the Date entered.

To accomplish this:

1. Open the variables editor
2. Add a new calculation: First Day of Month
3. For the input, change to Literal, use the filter visual assist button and select the Date parameter (in

general, Parameters and variables are reference by their name enclosed in angle brackets: e.g.
<Date>)

4. Do the same steps, this time add a new calculation Last Day of Month

5. Now add a Concatenation calculation to create the filter string for the range filter (See Filter a
Range)
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Rename the Caption to Filter. The Concatentation example above shows how you can combine the
other variables into a new variable that will server as the filter string. Note the Value column shows that
the filter evaluation is what we want.

6. Click Save and Close to save your changes

7. Click the visual assist on the Order Date filter column. Select Variables -> <Filter>

Now the Order Date filter tracks the first and last day of the month of whatever date you enter in the
Date parameter of the report
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List Calculation
A List is like a mini spreadsheet where all formulas are referenced by name (as opposed to Excel where
formulas are usually referenced by cell position e.g. A47). Named formulas are an advantage when you
need to modify your spreadsheet formulas. For instance, if you have a label named [Sales], the label
means the same thing regardless of where it appears in the List.

A list can be anything: a list of accounts, business units, ledger types, customers, etc. Data Access Studio
lets you define the lists you need and assign the list a label for quick reference. For instance, you can
define your list of P&L account and label the list as "P&L Standard". You can then define cell and row
calculations over any label in your list. For instance, you can sum up several items or take a percent of
one label to another.

To create a List
You can setup a List with the Calculation Editor or Quick Report Wizards. In the Calculation editor, select
the List calculation and click Edit List. Once created, you will almost always Group by the list column. You
can group by more than one list. A list may be grouped at any level as well.

A List consists of the following:

1. Label - unique text that identifies the item. IMPORTANT:Labels need to be unique for the thing
they represent. If you need duplicate labels, you can append as many spaces after your label to
make a unique name for it. In your formulas, the spaces will be represented as an underscore so:
SALES and SALES_ will be different labels in your formulas (the first has no spaces after it the second
has one space).

2. Criteria

(optional). If present, the criteria says what values to roll up for the label. For instance, if the
criteria is Obj Acct 1* that means any row where Obj Acct starts with 1 will be rolled up into the
total amount for the label.

3. Default Expression (optional). The expression evaluates slightly differently based on two cases.

Case 1. Label has criteria. In this case the expression operates on the elements that make up
the label. Use the Apply Operation command to easily apply operations to multiple rows of the
list.

Case 2. Label has no criteria. This is the row totals case. In this case the expression defines
what the label is. e.g. [Bank 1] + [Bank 2] + [Bank 3] is the formula for the label Bank Total.

4. Additional Expression (optional). This is an extra set of formulas that can use any of the symbols in
the list or default expression. Use this to create secondary calculations such as percent of row
values.
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5. Override Style (optional with Automatic Presentation only)

To Do this

Add a new row Click Insert Row Before or Insert Row After. The editor will
create a new row above/below the row you have
highlighted. Alternatively, you may enter text in the new
empty row at the bottom in the Description column.

Define how the label is rolled up Click the box under the Pattern column and click the ...
visual assist. See Define Criteria for the List Item for
instructions on defining the "pattern".

Define a row calculation Click the box under the Row Calculation column. See Define
row calculations for the List item for further instructions.
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Delete list items Hold CTRL key down as you left-click multiple rows. Then
click the Delete Row button.

Copy and Paste Hold CTRL key down as you left-click multiple rows. Then
click the Copy button. Highlight the row where you would
like to paste the rows. Click Paste.

Move multiple list items Hold CTRL key down as you left-click multiple rows.
Highlight the row you want to move. Then click the "Drag
and drop grip bar" and drag row above or below current
position. Release mouse button to drop to new position.
Grid will automatically scroll as you drag near the top or
bottom.

Save your list Click File | Save List. See Save a List and Share a list

Load a previously saved list Click File | Load List.

Delete a previously save list Click File | Load List. See Work with Your Lists.

Export your list to XML To export your list to XML, click File | Export. Exporting to
XML can be useful if you want to do mass search and replace
or other options in an XML editor.

Import your list from XML Once you have modified an XML export, you can import it
back using File | Import.

Create a secondary expression Click Add Column. This creates a new expression column.
Create formulas in this column that combine symbols from
the list and default expressions. See Define secondary
expressions.

Delete secondary expression Highlight a secondary expression column. Click Delete
Column.
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Apply an expression to a grid column Back on your report grid, right-click the Column Header.
Select Apply this list expression -> and select a valid list
expression.

Load a pre-defined list Click the Import from JDE tab. Select the list that you would
like to import.
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Define Criteria for the List Item
Once you click the ... visual assist, you will see the Define criteria form below:

This form allows you to specify what criteria the data has to meet to apply to the label you entered. For
instance, let's say our label was US customers, then the Criteria may be "Country = US". In this example,
"Country" is the value we would select under the Field column of this form. "US" is the text we would
enter in the empty box under the Criteria column. You may add as many Field-Criteria lines as you
need. See Filter Your Data for more details.

To Do this

Add a new criteria row Select from the list of fields in the Field edit box. Enter the
criteria for the field in the Criteria edit box. In the Criteria
edit box, you may use the Filter Helper visual assist to define
things such as lists and ranges. Also, each line you enter
implicitly means apply this line AND any previous lines
before it.

Add an OR condition Sometimes you may have complicated criteria that requires
AND-OR logic. To add an OR condition, click the empty box
under the Field column and select or. You should have at
least one line defined before the or and one line defined
after the or.

Delete a criteria row Highlight the row you want to delete. Then click the Delete
Row button.
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Delete multiple rows Hold CTRL key down as you left-click multiple rows. Then
click the Delete Row button.

Copy a criteria row Highlight the row you want to copy. Then click the Copy
Row button.

Copy multiple rows Hold CTRL key down as you left-click multiple rows. Then
click the Copy Row button.

Move a criteria row Highlight the row you want to move. Then click the "Drag
and drop grip bar" and drag row above or below current
position. Release mouse button to drop to new position.

Move multiple rows Hold CTRL key down as you left-click multiple rows.
Highlight the row you want to move. Then click the "Drag
and drop grip bar" and drag row above or below current
position. Release mouse button to drop to new position.

Save your criteria definition Click OK.

Cancel your criteria edits Click Cancel.
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Define List Calculations
You can perform two types of calculations on any list row:

1. Modify the results of the rollup on the row (applies if the rollup Criteria is defined for the row)
2. Calculate values from other rows (applies if the rollup Criteria is not defined for the row)

Case 1: Label has Criteria defined

If you place a calculation in the Row Calculation column, the value of the rollup will be modified
directly. Use the Apply Operation command to easily apply operations to multiple rows of the list.

Case 2: Label has no Criteria defined
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In this case, the Row Calculation is any supported calculation of the labels. The most common scenarios
are:

1. Summing other labels. In this case, hold down the shift key while selecting labels in the 'List label'
control in the formula editor. The result will be the syntax for summing the labels. For example:
[LABEL A] + [LABEL B].

2. Subtracting. In this case, change the sign of the operation in the calculation: [LABEL A] - [LABEL B].
3. Percent: [LABEL A]/([LABEL A] + [LABEL B]).

In general, you can enter any expression using +, -, *, /, (, ). The row calculation also supports built-in
functions (as listed in the visual assist for the Row Calculation column in the Math Calculations
category). These row expressions are referred to as the Default Expression. You may apply these
expressions to numeric columns in your report or derive Secondary expressions to do more
sophisticated calculations as well (See Define secondary expressions)
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Define Secondary Expressions
In addition to the Default Expression for the list, you may also define additional Secondary
Expressions. Secondary expressions always follow the Default Expression to do additional
calculations. For instance the default expression could be calculating a total and a secondary expression
could calculation the percent of that total.

To create a Secondary Expression

1. Edit your list
2. Click Add column. This will create a new expression column in the list editor (e.g. Expression 2)
3. To rename the expression column, right-click the new column, click Rename. Enter the new name

for the expression.

In the screenshot above, the Default Expression defines Total as [A] + [B] + [C]. The Percent column is
the secondary expression. You may add more than one secondary expression to your list definition.
Remember, in all cases, the Default Expression is always evaluated prior to the secondary expression.

Note that most secondary expression will apply the same operation to all rows to determine such things
as percent of total. Use the Apply Operation command to easily apply such operation to multiple rows of
the list.
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Remember that symbols in brackets are case insensitive -- so [Total] means the same thing as [TOTAL]

To apply an expression to your report
Once you have defined a Default Expression and optionally Secondary expressions, you may
selectively apply these transforms to your report as follows:

1. On your report with a list, right-click a numeric column
2. Click Apply this list expression
3. Select None for no expression, Default Expression for the default expression, or any other

secondary expression you have defined
4. Once selected, DAS will calculated each list row and column intersection with the expression

selection you pick



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 235 / 480

Apply an Expression to Multiple Rows
Use the Apply Operation command from the tool bar to apply such an expression to the expression
columns. In this example, the constant right-hand of the expression, /[NET SALES], is applied to all the
selected rows.

This feature is useful in the following scenarios:

1. Reversing the sign of the rollup. In this case, simply type a minus sign: - in the Enter operation to
apply field.

2. Scaling the value of the rollup. For instance, suppose you want to divide a set of rows by 1000,
simply enter: /1000 in the Enter operation to apply field.
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Save a List
When you click Save List, you will see the dialog below:

To Do this

Provide a name for your list Click on the edit box next to Enter name for list. Enter the name of
your list.

Organize your list into a
category

Click the down arrow on the List category edit box. Select the
category that best matches how you want to categorize your list.

Make your list available to
other reports and people

Click Publish list. See Share a list

Save the list Click OK. Note: if there is a list with the same name, Data Access
Studio will prompt if you want to overwrite the existing list.

Don't save the list Click Cancel.
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Publish/Share a List
When you publish a list you make the master version of the list available to more than one report. When
any report uses a published list, then any change to the master list automatically gets applied. This
technique is a great way to synchronize many reports the reflect the change made to one list.

To share a list
1. Make a list. See (Lists)
2. Click Pre-defined lists tab. Click Save/Share
3. Name you list and click Publish list
4. Click OK

In the above example we created a new list called: Shared List. We can now re-use this list in other
reports such that any changes to the master list is automatically reflected in all reports that reference it.

To reference a published/shared list in another report
1. Open/Create another DAS report
2. Add and edit a List calculation
3. Click Pre-defined lists tab. Click Load
4. Select a list under the Published/shared list category (See Work with Your Lists)
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Notice differences in using a shared list:

1. List Editor title shows: Shared list mode
2. The list by default is read-only.
3. The list menu is sparse: Unbind/Change, Close, and information about the Shared list

The shared list is read-only because any change to the list could have wide-reaching impact - i.e. any
saved change to the published list will automatically apply to all reports bound to the list.

NOTE

This also means that any adjustments made to the grouping level for the list will not be allowed in
bound lists. This is what you would see after selecting the 'Set Grouping Level for List Item'
command from the group column context menu.


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To edit a shared list
1. Double-click/Edit the list

2. Click Unbind/Change. This places the list into an editable mode

3. Edit the list

4. To apply changes for everyone, click Pre-defined lists tab. Click Save/Share (leave the name of the
list the same and leave Publish list checked)

5. Click OK



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 240 / 480

Work with Your Lists
When you select a list to load, you may also do other operations with your lists. The select list form
organizes all lists in the system as:

My Lists

Public Lists

Furthermore, the form organizes lists by the categories people selected when saving the list.

To Do this

Select a list to load Highlight the list in the grid. Click OK.

Delete a list Highlight the list in the grid. Click Delete.

Copy a public list to your private
list

Highlight the public list in the grid. Click Copy To Private
Mapping.

Use a shared list in your report Select any list under Public/shared lists (See Share a list)
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Additional List Properties
You can edit additional list properties by opening the Calculation Editor and highlighting your list item:

Option Effect

Filter
database

Default is False. If True, the calculation will apply the list criteria to your data selection.
This can improve performance in some cases.

Allow
duplicate
maps

Default is True. If checked, your list can have rows that map to multiple list labels. For
instance, if your label A has range 1000 - 2000 and label B has range 1500-3000, then
the overlap of 1500-2000 will be handled automatically. If this option is not checked,
then overlapping ranges are not allowed and the first occurrence of the range wins.

Smart
collapse

Default is True. If checked and a group has only one row, then the list will not allow a
drill down as it is not necessary. In this case the +/- group button will be hidden and
only the result of the row is shown. This usually makes for a cleaner look. If
unchecked, then the +/- group button always allows a drill down.

Guarantee
Row

Default is True. If checked, the list will guarantee that the row label appears in the
order of the list whether or not there are data rows for that label. If unchecked, then
the label will only show if there are rows for that label.

Set Group
Levels for List
Items

When a list is used as the grouping structure on a report, a user has the ability to
right click specific list elements and select "Set Grouping Level for List Item". This will
then allow a user to apply a specific grouping level (ex: Full Expand) on only that
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Option Effect

selected list value. This option will not be available to adjust when using a shared list.
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List override styles
If your report has an Automatic Presentation (See Automatic Presentation), then you can optionally
define cell style overrides in your list. This feature is handy when you want to apply cell-specific
formatting to one part of your list (but not necessarily the whole column)

1. Open a report with a list and an automatic presentation
2. Edit your list
3. You will see a column on the far right named Override Style

The Override Style allows you to select an available presentation style (See Automatic Presentation
Styles) for any cell. If the Override Style is left blank, then the default presentation styling will be used
when formatting the row and column. However, if you specify an override style, then this style will always
be used. For example let's say you always wanted to format a certain cell in your list as a percent with an
orange background. Define a style label See Automatic Presentation Styles) and select this style for the
cell in your list.
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Import a list definition from Excel
If you need to create a very large list, it may be easier to create the structure of the list in Excel and
import it into DAS. DAS provides a rudimentary way to define a list in Excel that can be import into DAS:

1. Create an Excel workbook formatted as follows:

A B

1 Label FieldName FieldName2

2 Label1 Value1 Value2

3 Label2 Value3 Value3

A,B,C are Excel columns A, B, C. Each FieldName is the name of the field for your criteria: e.g. LT or MCU

Here’s an example with literal values:

A B

1 Label MCU OBJ

2 Misc 1 1000

3 Assets 1 2000

4 Liabilities 1 3000

What this means is Column A is the list label. Columns B and C are the Criteria for that label. In this
example, the criteria is interpreted to mean: MCU=1 AND OBJ=1000. So you can see, you can leverage
the copy/paste features of Excel to quickly define hundreds of rows this way.

2. Getting the Excel definition into DAS: First, create an external client-side data link in DAS to the
workbook above (See Example - Connect to an Excel file). Once you save the connection and Create
Report you will see the workbook in DAS. Click Run Report to load the workbook data into DAS. For
example, with the attached workbook:
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IMPORTANT: Notice that is you named the column in your Excel file as F0902.OBJ, then when you open
that Excel file in DAS, it gets renamed to F0902#OBJ (this is because Excel has an issue with periods in
the column name. if you avoid periods in the column name you will not have this issue). You need to
right-click and rename F0902#OBJ and F0902#SUB to F0902.OBJ and F0902.SUB

in the report designer, click CTRL-A to select everything. Right-click and grid Column Header and select:
Quick Calculation -> Text -> List:
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DAS open and load the list editor with the definition from the Excel file. The editor will highlight any
detected errors.
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So you can see the significance of the Field name: F0902.OBJ and F0902.SUB are the field names in your
report. If for instance you report was over the just the F0902 table only (i.e. not a DASVIEW), then these
fieldnames would have been OBJ and SUB. Make sense?

Click Pre-defined list tab and Click Save/Share to save this list.

See the follow support page article for more information on importing list definitions from Excel:

https://support.reportsnow.com/hc/en-us/articles/202666223-How-to-Import-a-list-from-an-Excel-file-
into-a-DAS-List-calculation

https://support.reportsnow.com/hc/en-us/articles/202666223-How-to-Import-a-list-from-an-Excel-file-into-a-DAS-List-calculation
https://support.reportsnow.com/hc/en-us/articles/202666223-How-to-Import-a-list-from-an-Excel-file-into-a-DAS-List-calculation
https://support.reportsnow.com/hc/en-us/articles/202666223-How-to-Import-a-list-from-an-Excel-file-into-a-DAS-List-calculation
https://support.reportsnow.com/hc/en-us/articles/202666223-How-to-Import-a-list-from-an-Excel-file-into-a-DAS-List-calculation
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Formula
A key concept in Data Access Studio is to provide a relevant set of point-and-click calculation columns
that are easy to use and understand. This allows us to present a powerful enterprise-grade reporting tool
to a larger audience. While it is possible to chain together these simple calculations to solve ever more
complex problems, it becomes burdensome to manage such complex chains of calculation columns.
Therefore, especially for complex and large reports, it is suggested to use the formula calculation.

Key Features
Allow combining many calculations into one column. This reduces the number of total columns
thereby reducing both the complexity to understand the report but also reduces the memory
footprint of such a report at runtime.
Multi-line text with line-specific comments. The comments can be embedded within the expression
as needed.
Nested IF Statements. The non-formula conditional calculation could only express one expression.
Nesting Ifs allows for an easy expression of a decision tree of expressions - making complex reports
easier to manage.
Horizontal Summaries. By default, formulas will calculate using the summaries of its inputs in group
and report summarization.

How to Create a Formula
A formula calculation can be created in many different ways:
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1. By selecting the 'Formula' calculation in the Calculations editor like other calculations.
2. By using the 'Formula' menu item.

3. By converting an existing non-formula calculation to a formula using the 'Convert to Formula'
command.

4. By converting all non-formula calculations in a report to formulas using the 'Convert all to Formula'
command.

NOTE

Converting all non-formula calculations to formulas in a report will combine simple calculations into
more complex formulas automatically. Please see Formula Conversion for more information.



NOTE

Not all non-formula calculations can be converted to formulas. Please see Formula Conversion for a
list of calculations that cannot be converted.


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Working with the Formula Editor

Available Items
The Available Items section contains the items that can be used in the formula editor:

Parameters - visible if the report has parameters. Parameters will always read as string values in
formulas. If a non-string value is desired (such as an integer), consider first wrapping the parameter
in a Global Variable leveraging the Type Converter calculation.
Variables - visible if the report has variables.
System Constants - always visible and contains such things as the current date, current user, etc.
Grid Columns - all columns from the report
Functions - all functions that can be used in a formula. Note that there are calculations (such as
table lookup) that cannot be used in a formula.

Operators
Below the editor are the list of operators to use to create expressions for assignments and conditions.

 - Comment and uncomment lines in the formula. Useful to temporarily disable a section

of the formula.

 - Basic math operator including modulus and power.

 - Wrap the selected text in parenthesis to control the order of a boolean expression

 - Wrap the selected text in quotes to make a string literal.
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 - Basic operators to compare values when used int he If function.

 - Basic boolean operator (AND or &, OR or |, NOT or !) to help construct boolean

expressions.

 - Like operator that follows the syntax of the Visual Basic Like Operator . This operator

supports matching a single character (?), zero to many characters (*), a digit (#), and ranges ([-list of
chars-] or [!-not in list of chars-]).

Understanding Formula Syntax
The formula editor supports prompting with type ahead auto-completion to make it easier to build the
formulas properly. When creating a formula, inputs will come first followed by options as defined in the
individual calculations' documentation pages.

This includes...

Typing a column or variable name while in a formula allows that field to be selected through a tab
or double click of the value.

Typing a comma after the required inputs have been entered in a formula will sometimes bring up
the additional options to be included.

https://docs.microsoft.com/en-us/dotnet/visual-basic/language-reference/operators/like-operator
https://docs.microsoft.com/en-us/dotnet/visual-basic/language-reference/operators/like-operator
https://docs.microsoft.com/en-us/dotnet/visual-basic/language-reference/operators/like-operator
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If Function (Conditional)
The If function is a three part function: If (expression, true value, false value). If the expression is true, the
true value is returned, otherwise the false value. Another If statement can be embedded in either true or
false positions to construct a decision tree. The function can be formatted across multiple lines with
embedded comments to make the statement easier to manage.

Filter Function
Syntax: Filter(Value, Filter condition)
Return: Boolean
Parameters:

Value: a literal value, a reference to a column, parameter, or variable
Filter condition: Filter field syntax

The Filter function is a special function that is used to evaluate a conditional filter on a value. For
example,

will return true if the order date for the given row is within the specified user provided date range. Such
a function would usually be used in the following if function:

NOTE

A great way to learn the formatting of formulas can be to utilize the Formula Conversion on a
standard calculation, thus seeing the syntax used for a formula that might be created again in the
future.



Filter([Order Date], <Period Range>)

Where
<Period Range> = >1/15/19:<2/14/19

If(Filter([Order Date], <Period Range>), "Order in Range", "Order out of Range")
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Non-Formula Calculation to Formula Calculation
Conversion
Often it is desired to convert a non-formula calculation to a DAS Formula Calculation or it might be
desired to convert all non-formula calculation in a report.

Single Calculation Conversion
Converting a single non-formulation calculation will convert just the selected calculation to its formula
equivalent. Any column references will become column references in the formula. Consider a 'Division'
calculation that depends on a 'Difference' calculation. The 'Difference' calculation is hidden and is only
used by the 'Division' calculation.

Converting just this 'Division' calculation...

will result in a new column with this formula:
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The old column would need to be deleted and any columns dependent on the old column should be re-
hooked to the newly converted column.

Whole Report Conversion
Converting a single calculation makes sense while developing. However, there are two main reasons to
convert all the non-formula calculations to formulas:

In-place conversion. Unlike a single calculation conversion, a new calculation object is not created
but instead the existing one is converted to a formula preserving existing dependencies.
Column Optimization. Whole report conversion will eliminate unnecessary calculations that are only
used to hold temporary results.

Consider a simple report with two 'Division' calculations dependent on a single 'Difference' calculation:

Converting all calculations...
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results in two formula calculations with the old 'Difference' calculation ([Extended Price]-[Extended Cost])
embedded in each one. The old Difference calculation has been removed as it is no longer necessary.

Criteria for a Converted Calculation to be Embedded in Other
Formulas
A calculation will be embedded into other converted calculations if the following conditions are met:

1. Calculation can be converted to a formula
2. Calculation is only referenced by other calculations that can be converted to a formula

NOTE

An embedded transformed calculation will be embedded in all formulas that depended on it before.


NOTE

The conversion process will not convert variables. Variable calculations must be converted manually.

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3. Column is hidden, unsorted, un-grouped, and unfiltered
4. Column is not referenced by a parameter or additional criteria

Limitations on Conversion
Not all calculations can be converted. Any calculation that operates over multiple input rows, either for
functional or performance reasons, is not eligible for conversion.

As such, these calculations cannot be converted to a formula:

Database
Table Lookup

Enterprise One
Account Category
Associated Description
Chart of Accounts
Current mailing address
JDE email address
JDE phone number
JDE user name
Media Objects
Model Account
Period Amounts
Relative Period
Unit Conversion
Work Days

Math
Running Total

System
Burst
De-duplicate
Group Rank
Group Row Index
Group Summary
Parent Child Hierarchy
Random Row Index
Row Index
Spacer
Type Converter
XPath Query

Text
List
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Replace
Split
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Database Calculations
Table Lookup : Will perform a table fetch off another table and that table's fields, returning that data
to an existing report.
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TABLE LOOKUP
Description
Will perform a table fetch off another table and that table's fields, returning that data to an existing
report. A table lookup is similar to a left outer Table Join, but offers much more flexibility such as joining
columns with differing data types. For example, this calculation is the only method to join in data from
external data sources such as SalesForce or NetSuite.

Calculation Editor
Options

Input
Parameter
Values Input Values

Datasource
(optional)

Name of the data source to use when retrieving data. If left blank, DAS will use the
JDE default data source and tables. Note: If you defined External data sources (see
External Data), you can select that data source here. Once selected, DAS will load
the valid Target Table/ View list (see below) for that data source.

Target
table/view

Name of the table or business view from JDE or a defined data source or external
connection to query. You also have the ability to define a join by clicking the special
DASVIEW object name listed first in the visual assist.

Index (Optional) Name of the index to use for the query. When you select an index, the
calculation editor populates the key fields from that index in the Specify how to
query target table/view.

Sort Order
(optional)

Select how you want to sort the target data set. Use this option when the target
data set has many values for what you want to query and you need a specific value
based on the sort. Can be sorted ascending or descending.

Row to Fetch (Optional) Default value is set to 1. This defines the relative row that you want.
1=First, 2=Second, etc. This is useful when you need to select rows other than the
first row from the target table, or when specifying a Sort Order.

SummaryType (Optional) If you query a target table with multiple rows, you can elect to
summarize the values into one value.
Average - the average value of all the records returned by the query. Works for
numeric data types only.
Count - count of the records returned by the query
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Input
Parameter
Values Input Values

Count distinct - count the distinct number of records returned by the query (NULL
counts as 1)
Filter: list of values - creates a list of distinct values in a filter format (separated by a
semicolon)
Filter: not in list - creates a list of distinct values to be excluded in a filter format
(separated by a colon and uses an exclamation to signify "not")
First - returns the first result fetched from the query
Maximum - returns the largest element of the query. Works for numeric data types
only.
Minimum - returns the smallest element of the query. Works for numeric data types
only.
Multi-row - returns all detail rows of the query
None - returns the Row to Fetch number of the query (default is the first row)
Sum - returns the sum of the query. Works for numeric data types only.

Bulk Fetch Keys This is the number of unique queries to batch together before actually querying the
database. This reduces the number of network requests and usually speeds up
reporting. We generally recommend leaving this setting blank to use defaults.
Occasionally design notes will recommend a change to the bulk keys setting.
Administrators may influence the default for all users in Preferences for all Users.
When using Column as Filter or Sort Order in Table Lookups, default is 50.

De-duplication Default is no de-duplication. The Table Lookup automatically de-duplicates lookup
values if you select the Fetch unique target row only once. This only works in
conjunction with the the multi-row summary type.

Authentication
timing

(Only applies for certain External Data Connections)
On Report open - Indicates to authenticate the connection when the report is
opened. This is the default option.

When first used - Indicates to authenticate when the connection is first used.

Only Rollup If Just like any other calculation, this criteria determines if the table lookup should
even query the target table or view for a given row. Use this mainly to optimize
report performance by skipping unnecessary queries to the database.

Input
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Specify how to query target table/view
This is how you build the relationship between the data on your report and the target table/view. You
can use a combination of data columns, calculated columns, and literal values (including parameters and
variables) from your report to build the relationship. Depending on your target table/view, you may only
need to use one column to build the relationship or you may need more than one. See samples below.

Column to column
Address Number to Address Number

Column to literal
In this example, the Target Table/View has multiple Cost Methods (LEDG), and we only want to bring
back 07. This is the method that will be used to filter on any fields in the Target Table/View.

Column as filter

Column as filter will interpret the contents of an input column as a filter expression.

In this example, the Range Filter calculation is used to construct a date range filter to be used when
filtering the order date column of the table lookup.

Assignment Behavior

Use the Assignment Behavior input option to ignore a filter on a column if the incoming value is blank.
Normally, a blank value from a incoming parameter or column will be interpreted as a literal blank by a
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table lookup input. In other words, the table lookup will only return rows where the filtered column is
blank.

In this example, the order number will be used as filter on the table lookup only if the user entered a
value in the parameter.

Check the Bypass formatting option to use an unformatted value from your filter criteria to match
against the target table.

By default, Data Access Studio automatically applies formatting including zero or blank padding to
certain JD Edwards data dictionary aliases. For example, the ASID alias used to store serial numbers is
zero padded to 8 characters by default, though not all tables use such padding for the ASID alias.
Selecting the Bypass formatting option ensures that exact matches can be found without automatic
formatting and padding.

Output
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Specify which columns you need back from the target
table/view Input Values

Define column caption Columns you want to bring
back

Result Columns Under Specify which columns you need back from the target table/view, select columns
from the target table that you want to return to your report. If you selected a Summary Type, above,
then the output columns will show the summary values for all the selected rows. The system will attempt
to convert numeric strings to numbers before attempting a summary function.

Remarks
A Table Lookup requires three design elements:

Table name – The database source and table where data will be retrieved.
The matching criteria – The matching filtering criteria between the target table and the original table
to retrieve correct data based off “like” index/ key fields.
The columns that will be returned – Selecting the column(s) to return from the lookup table.

If you are only fetching the first record of a sorted set of records (most recent sales order of a customer
for example) you will want to set Bulk Fetch Keys to one. A value of one and a Summary Type of 'First'
will alter the query to the database and improve performance in this case.

Examples
Example 1: Adding a Table Lookup to a Table Join
Current Table Join: Accounts Payable Ledger (F0411) simple join via Address Number to Supplier Master
(F0401)
This is a Table Lookup to the Address Book - Phone Numbers (F0115) where we could have multiple
phone numbers for the same address number. We can also have multiple voucher records for the same
address number. With traditional joins, this could lead to duplication. Using the Table Lookup as shown
below will allow you to avoid that.

WARNING

Make sure to include the main JDE address book column alias (AN8) (if the table includes such a
column) if your company has implemented address book security. If this column is not included
with this type of security enabled, any columns designated to be masked will be completely masked
even for address book numbers the user is allowed to view.


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Go into the Design Menu → Calculations → add a new calculation → Table Lookup.
After building the relationship between the two tables (Address Number to Address Number), we're
going to change SummaryType to "Multi row" and De-duplication to "Fetch unique targets only once".
Doing this will ensure that you are not getting duplication like you would if you did a Table Join to the
F0115, with no additional calculations. The calculation editor should look as follows:

The columns you chose to bring back from the F0115 will show up on the report. You now have the
option to use them in calculations and move them around as needed. Because they are from the Table
Lookup calculation, they will also have the calculator icon in the top right of each column caption. The
calculation will only show data from the target table in new rows beneath the information from the initial
report. The report will look as follows, assuming you have hidden columns from the previous Table Join:
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Example 2: Ignore a Blank Value in a Parameter used by a Table
Lookup
Using the same report and Table Lookup from Example 1, we're going to add the Phone Number Type as
a parameter.
In the Table Lookup, we're going to add an additional "Specify how to query" field between Phone
Number Type and this new parameter. Because Table Lookups will always query with blank values when
fetching, we need to take an extra step and tell the Table Lookup to ignore the value. We do this by
clicking on the blue arrow square between the target table/view and filter criteria columns and changing
it from the default to "no filter".

Example 3: Adding a Table Lookup to bring back a sum
Starting with the Item Branch File (F4102) we're going to do a Table Lookup to the Item Location File
(F41021). When we do this Table Lookup, we want to join by more than one field and return the sum. We
will be connecting the tables via Short Item Number (ITM) and the Business Unit/Branch Plant (MCU).
The key to this one is changing the SummaryType to "Sum".
We're going to bring back the Quantity on Hand (PQOH) column. The calculation editor should look as
follows:
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You will see the sums for the Quantity on Hand being returned from the F41021. The output for this
looks as follows:
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Date Calculations
Convert Time : Converts a date/time from the report’s time to UTC or vice versa
Date Difference : Will give mathematical difference of the span between two date columns, e.g. Due
Date - Invoice Date
Date Offset : Will take a date parameter and offset it based on an input date, an offset unit type like
Day or Week, and the offset value, e.g. 1 for one day and 2 for two days, etc.
DateTime to Numeric : Will take a date format and convert it to Excel Numeric, HHmmss, Hours,
Minutes, Seconds, or yyyyMMddHHmmss formats
Day of Month : Will take a date and extract the day of the month
Day of Week : Will take a date and extract the day of the week
Day of Year : Will take a date and determine the day of the year off the calendar date
First Day of Month : Will take a date and convert the value to the first day of the month
First Day of Year : Will take a date and convert the value to the first day of the year
Indexed Month Description : Will take a date and display it as period number and month description
Julian Date : Will convert date format to a Julian date used as a standard time measure to calculate
computer data by a scientific numeric date in lieu of Gregorian Date Formats
Julian to Date : Will convert Julian date format to a Gregorian Date format
Last Day of Month : Will take a date and convert the value to the last day of a month
Last Day of Year : Will take a date and convert the value to the last day of a year
Month : Will take a date and display it as period number
Month Description : Will take a date and display it as period description
Relative Date : Conditionally returns a value if a date falls within a specified date range. This uses
Smart Filtering to select records by date. This feature is used by the Organized Date Trend wizard
and is an Advanced Calculation
Today's Date : Will use chose the variable for "today's date" and return today's date in the system.
Used in Quick Calculations for corresponding data field type and to create date offsets
Week Number : Will take a date and provide the week number for the date
Year : Will take a date and display it as year
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Convert Time
Description
Converts a date/time from the report’s time to UTC or vice versa.

Calculation Editor
Options

Input Parameter Values Input Values

Target TimeZone Reports TimeZone or UTC

Input
Input Input Values Required

Date/Time to be converted Column or Literal ✔

Remarks
Data Access Studio classifies columns as being either in the report's time zone or in UTC. Using UTC is
best to ensure that daylight savings changes do not result in incorrect time based calculations, but using
the report's time zone is often preferable for user display purposes. Using this calculation allows the
report designer to convert between the two time classifications and apply the necessary time offset.

The output of this calculation will be classified with its time zone.
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Example
For example, once a date/time is converted to UTC, a conversion to UTC will not undergo an additional
transformation.

If the input column is JDEUTIME, it is possible to retrieve the raw UTC time of a JDEUTIME column
instead of starting with the report's time zone. Go to the date format dialog of that JDEUTIME column
and select the 'Fetch UTC' option. This is useful if you need to perform time calculations such as adding
up hours and you need to avoid daylight savings adjustment errors that would be caused if the
date/time column starts in the report's time zone/daylight savings rule.

If the input column is external data, DAS will assume the time zone of the data is the report's time zone.
If it is known that the column data is in UTC, you can indicate this fact to DAS by setting the 'Assume
UTC' option on the date format dialog.
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DATE DIFFERENCE
Description
Will give the mathematical difference of the span between two date columns

Parameters
Options

Input Parameter Values Values

Time Span Units Days, Hours, Minutes, Months, Seconds, Years (Required)

Only Rollup If Generic Criteria

Input
Date Input Values Required

Input 1 Date Column or Literal ✔

Input 2 Date Column or Literal ✔

The system knows to take the date format value from days and extract only that field.

Remarks
The default data type of this calculation is integer. When measuring days between columns that contain
time, you will want to use a decimal type to capture the fraction of days.

Example
To see the Date/Time difference between two dates:

1. Multi-select two date columns
2. Right-click either column header
3. Select Quick Calculation > Date > Date Difference
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Date Offset
Description
The Date Offset calculation offsets a date or a date/time by seconds, hours, days, weeks, months,
quarters, or years.

Parameters
Options

Input Parameter Values Input Values

Relative Offset Numeric Value

Offset Unit Year, Second, Quarter, Month, Week, Day, Hour, Minute (Required)

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type. A common use of this calculation is when
creating Variables, where you want to take Today's Date and go back one month. The end result of the
variable is then used as a filter for setting dynamically scheduled reports based on less than or equal to
last month.

Example
User chooses to offset the invoice date by offset unit 'Weeks' and offset value of -2. The calculation will
offset the invoice date by two weeks (prior).
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DateTime to Numeric
Description
The DATETIME TO NUMERIC will take a date with an optional JDE time added to it and format it to
several numeric formats.

Parameters
Options

Input Input Values

Output Format Excel Numeric Date, HHmmss, Hours, Minutes, Seconds, yyyyMMddHHmmss

Date Column or Date Literal

JDE Time Column or Date Literal

Only Rollup If Column or Date Literal

Remarks
Format of the 'Excel Numeric Date'. From Excel doc : Excel stores dates as sequential serial numbers so
that they can be used in calculations. By default, January 1, 1900 is serial number 1, and January 1, 2008
is serial number 39448 because it is 39,447 days after January 1, 1900

JDE Time format. Its format is HHmmss. Note that is used often in JDE ERP tables.

Example
1. Input:

Date: 06/01/2017
Time: 152705

2. Design > Calculations > DateTime to Numeric
Output Format: yyyyMMddHHmmss
Fill in Date and Time as seen above

3. Output: 20170601152705
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DAY OF MONTH
Description
Will take a date and extract the day of the month. Used in Quick Calculations for corresponding data
field type.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The system knows to take the date format value from days and extract only that field.

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > Day of Month
3. Output: 31
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DAY OF WEEK
Description
Will take a date and extract the day of the week. Used in Quick Calculations for corresponding data field
type.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The system knows to take the date format value from days and extract only that field.
Returned text is in English only.

Example
1. Input: 03/31/2016
2. Quick Calculations > Date > Day of Week
3. Output: Thursday
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DAY OF YEAR
Description
Will take a date and determine the day of the year off the calendar date. Used in Quick Calculations for
corresponding data field type.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The system knows to take the date format value from days and extract only that field.

Example
1. Input: 04/30/2016
2. Quick Calculations > Date > Day of Year
3. Output: 121
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FIRST DAY OF MONTH
Description
Will take a date and convert the value to the first day of the month. Used in Quick Calculations for
corresponding data field type.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The system takes the date value for a given month back to day 1 of the month. This calculation is often
used to make it easier to construct the lower bounds of a month-to-date filter.

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > First Day of Month
3. Output: 12/1/2017
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FIRST DAY OF YEAR
Description
Will take a date and convert the value to the first day of the year. Used in Quick Calculations for
corresponding data field type.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The system takes the date value for a given month back to day 1 of the year. This calculation is often
used to make it easier to construct the lower bounds of a year-to-date filter

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > First Day of Year
3. Output: 01/01/2017
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INDEXED MONTH DESCRIPTION
Description
Will take a date and display it as month number and month description.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The month number will be padded with a zero. Note that this calculation often is used to make it easier
to sort by month.

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > Indexed Month Description
3. Output: 12.December
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JULIAN DATE
Description
Converts a standard Gregorian formatted date to JDE's custom CYYDDD Julian-like date number.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The returned Julian date format includes leap years. This is JDE's own special Julian Date Format

Example
1. Input: 12/31/2016
2. Quick Calculations > Date Julian Date
3. Output: 116366

https://docs.oracle.com/cd/E59116_01/doc.94/e58813/julian_date_conv.htm#WEAWX259
https://docs.oracle.com/cd/E59116_01/doc.94/e58813/julian_date_conv.htm#WEAWX259
https://docs.oracle.com/cd/E59116_01/doc.94/e58813/julian_date_conv.htm#WEAWX259
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JULIAN TO DATE
Description
Will convert a JDE formatted Julian date format (CYYDDD) to a Gregorian Date format.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
The returned Julian date format includes leap years. This is JDE's own special Julian Date Format

Example
1. Input: 116366
2. Quick Calculations > Date > Julian to Date
3. Output: 12/31/2016

https://docs.oracle.com/cd/E26228_01/doc.93/e21961/julian_date_conv.htm#WEAWX260
https://docs.oracle.com/cd/E26228_01/doc.93/e21961/julian_date_conv.htm#WEAWX260
https://docs.oracle.com/cd/E26228_01/doc.93/e21961/julian_date_conv.htm#WEAWX260
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LAST DAY OF MONTH
Description
Will take a date and convert the value to the last day of a month.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type. This calculation is often used to make it
easier to construct the upper bounds of a full month filter.

Example
1. Input: 04/15/2016
2. Quick Calculations > Date > Last Day of Month
3. Output: 04/30/2016
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LAST DAY OF YEAR
Description
Will take a date and convert the value to the last day of a year.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type. This calculation is often used to make it
easier to construct the upper bounds of a full year filter

Example
1. Input: 04/15/2016
2. Quick Calculations > Date > Last Day of Month
3. Output: 12/31/2016
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MONTH
Description
Will extract the calendar month number from the date field

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type.

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > Month
3. Output: 12
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MONTH DESCRIPTION
Description
Will provide you with the name of the month based off a date column

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type.

Example
1. Input: 12/31/2017
2. Quick Calculations > Date > Month Description
3. Output: December
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RELATIVE DATE
Description
Conditionally returns a value if a date falls within a specified date range. This uses Smart Filtering to
select records by date.

Parameters
Options

Input Parameter
Values Input Values

Date Column or Date Literal (Required)

Compare to Date Column or Date Literal

Relative Offset Numeric Value

Offset Measure Inception to Date, Inception to End of Month, Month, Quarter, Week, Year,
Year to End of Month, or YTD

Value to Roll Up Column or Literal

Only Rollup If Generic Criteria

Remarks
This feature is used by the Organized Date Trend wizard and is an Advanced Calculation.

The Relative Date calculation and Organized Dates Trend are only relevant for calendar year reporting,
not non-calendar or 445 fiscal year reporting. The Relative Date calculation is not typically used without
using the trend first.

Note: for those users who want to clear out the default smart column value created by a Trend Wizard,
""show"" the selected date column in the grid, e.g. Invoice Date, and clear the filter default <> associated
to the QBE filter.

Will control the selection of the report to optimally return just the records required by the calculation.

Example
You want to see the Gross Amount for the past year, depending on a specific date, 06/22/2017. Create a
Reference Date parameter, then link it to a Relative Date calculation. The Reference Date parameter
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should look like the image below.

Once you have created the parameter, enter the date you want to see the Gross Amount for, in this case
06/22/2017. Go into the calculation editor and create a Relative Date calculation link the "Compare to
Date" to the Reference Date parameter/ variable, along with inputting the other required values. If you
want to bring back the Gross Amount for the past year from the date you input into the Reference Date
parameter, according to the Due Date, your values should be as follows in the Calculation Editor.

You should now be seeing the QBE of the Due date filtered on the past calendar year (Between
01/01/2016 and 12/31/2016) for the date you've input into the Reference Date Parameter(06/22/2017).
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TODAY'S DATE
Description
Will use chose the variable for "today's date" and return today's date in the system.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Remarks
Used in Quick Calculations for corresponding data field type and to create date offsets.

Returns it in the current time zone of the client machine.

Example
The system retrieves today's calendar date

NOTE

This calculation differs from the TODAY variable that is used in filter expressions in that this
calculation will return the current date in the system's time zone, while the TODAY variable will
return the current date in the user's time zone.


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WEEK NUMBER
Description
Will take a date and provide the week number for the date.

Parameters
Options

Input Parameter Values Input Values

Calendar Week Rule First Day of Year, First Four-Day Week, or First Full Week (Required)

Week Count Start Index Column or Literal (Required)

First Day of the Week Day of the Week Selections (Required)

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type.

We do not support ISO 8601 Week of Year.

To create an ISO 8601 Week of Year, create a formula calculation with the logic similar to this:

If (Day of Week([Order Date] ) = 'Monday' 
    OR Day of Week([Order Date] ) = 'Tuesday' 
    OR Day of Week([Order Date] ) = 'Wednesday', 
Week Number(Date Offset([Order Date], Offset unit:"Day", Relative offset:3) ), 
Week Number([Order Date]))
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Calendar week rule. This option indicates what will be designated the first 'week' of the year.

Is it...

the week containing January 1st for current year
the first week with at least 4 days in it for current year
the first full week of the year

Example
1. Input: 01/23/2015
2. Quick Calculations > Date > Week Number
3. Output: 4

NOTE

Review Microsoft information  regarding week of year formatting for additional information


https://docs.microsoft.com/archive/blogs/shawnste/iso-8601-week-of-year-format-in-microsoft-net
https://docs.microsoft.com/archive/blogs/shawnste/iso-8601-week-of-year-format-in-microsoft-net
https://docs.microsoft.com/archive/blogs/shawnste/iso-8601-week-of-year-format-in-microsoft-net
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YEAR
Description
Will take a date and display it as year.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal ✔

Remarks
Used in Quick Calculations for corresponding data field type.

Example
The system takes the value of date like 6/28/05 and pulls the year value which is 2005.
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Enterprise One / World Calculations
The calculations below apply specifically to the JD Edwards system. As you know, the JDE system has
internal logic that can be difficult to calculate. These calculations hide the complexity of the internal logic
and allow you to focus on the business requirements.

Account Category: This calculation, on its own, does not have any direct use by a customer in a
report. It is, however, important when creating Financial, Job Cost, and Fixed Asset reports that
leverage the JD Edwards Automatic Accounting Instructions (AAI).
Associated Description: Derives meaningful descriptions for many JD Edwards data columns and can
be accomplished through a simple double-click of the column caption.
Chart of Accounts: Used by DAS for Quick Reports using rows by "Chart of Account" rollup. In the
context of creating Quick Reports for Financials, Job Cost, or Fixed Assets, this calculation is created
through the wizard. This calculation utilizes the Level of Detail Rollup that can be created inside of
the JD Edwards F0901 Account Master table to create grouping levels that roll up in a tree structure
based on the designer's settings.
Current Mailing Address: Retrieve either the current or as-of-a-date mailing address for an Address
Book Number.
Date to Period: Take a date and extract the Period Number or Fiscal Year as an output. The date is
compared against the F0008 Fiscal Date Patterns and F0010 Company Names & Numbers tables to
establish the output based on each data row record.
E1 Time to DateTime: Converts JD Edwards Date Updated and Time Updated columns into a single
DateTime column.
Get Short Item Number: Efficiently retrieve the Short Item Number given the 2nd Item Number. This
negates the need to join the Item Master table to your report.
JDE Email Address: Return a selected email address for an Address Number.
JDE Phone Number: Return a selected phone number for an Address Number.
JDE User Name: Leverages JD Edwards' F0092 Library Lists table to retrieve the JDE User Name. This
calculation is for administrators of DAS only.
Media Objects: Displays text media object information for a media object enabled JDE table. These
calculations are usually created for you using the 'Quick Media Object' command.
Model Account: This calculation is used by Quick Reports for Financials, Job Cost, and Fixed Assets
to compare to the F0901 Account Master for use as a filter, obtaining a business unit's Chart of
Accounts as the model account Level of Detail (LD) roll-up structure.
Offset Between Two Periods: Allows a user to identify the number of periods between two periods.
Period Amounts: Allows a user to make multiple period amounts appear as one period amount
column for the use case of the JD Edwards balances table like the F0902 GL Account Balances and
the F1202 Fixed Asset Balances.
Period to Date Range: Allows you to take a Period, Fiscal Year, and Century and create a Date or
Date Range span for desired output and use - mainly used in variables to set filter ranges.
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Relative Period: Take the calculation's parameter criteria and return balances from a balance table,
most often the F0902 GL Account Balances table.
Unit Conversion: Returns the conversion factor between two units of measure for a given item
number.
Work Day Offset: Offsets a date input by a certain amount of work days based on the F0007
Calendar Information table in JD Edwards.
Work Days: Allows you to identify if a date is a work day based on the F0007 Calendar Information
table in JD Edwards with a 1 or 0 output. This calculation also allows a user to identify the number of
work days in a date range.
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Account Category
Description
This calculation, on its own, does not have any direct use by a customer in a report. It is, however,
important when creating Financial, Job Cost, and Fixed Asset reports that leverage the JD Edwards
Automatic Accounting Instructions (AAI).

Calculation Editor
Options

Input Parameter Values Input Values

Display Option Description, GLG Code

Only Rollup If Generic Criteria

Input
Input Input Values Required

Company Column or Literal ✔

Remarks
Utilize "Display Option" to determine which criteria will be selected within the Relative Period
Calculations in your Financial Reports when the Reverse Sign Criteria, Add Begin Balance Criteria, or Add
Original Budget Criteria options are in use. The default option will be "GLG Code" that results in filtering
of the signs on certain general ledger guidelines and filtering on beginning balance criteria when
applicable. If you adjust the Display option to "Description", be sure to adjust the filtering in your relative
period calculations as well.
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Associated Description
Description
Derives meaningful descriptions for many JD Edwards data columns and can be accomplished through a
simple double-click of the column caption.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
While this calculation is accessible inside of Design > Calculations and by right-clicking to go to
Quick Calculations > JDE > Associated Description, the easiest way to apply an associated
description is a simple double-click of the column caption.
Enable the default preferences setting called "Double-click concatenates associated description" to
automatically use this calculation to bring together a code column and its associated description
when double-clicking the code column. This type of 'code - description' column format is common
for many report writers.
Additional associated description relationships can be added by a DAS Administrator, but many
associations are already mapped.

Example
1. Input: Address Number (1001)
2. Double-click the Column Caption
3. Output: Address Number Description (AB Common)
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Chart of Accounts
Description
Used by DAS for Quick Reports using rows by "Chart of Account" rollup. In the context of creating Quick
Reports for Financials, Job Cost, or Fixed Assets, this calculation is created through the wizard. This
calculation utilizes the Level of Detail Rollup that can be created inside of the JD Edwards F0901 Account
Master table to create grouping levels that roll up in a tree structure based on the designer's settings.

Calculation Editor
Options

Input
Parameter
Values Input Values

Grouping Mode Financial: OBJ, SUB or Job Cost: SUB, OBJ

Start Level of
Detail

Integer between 3 and 9

End Level of
Detail

Integer between 3 and 9

Consolidate Check Box that removes duplication of grouped fields with the same names by
consolidating all similar fields under one bucket (ex: one instance of Petty Cash
rather than 5 visible)

Group by
Description

Check Box that sets up the grouping structure to be alphabetical by level and
description name rather than the default structure order

Strip Blanks Check Box that removes the blank characters in a field description before making
the groups visible.

Group Outputs Check Box ensures all levels of grouping for your Chart of Accounts are displayed
in a tree structure

Only Rollup If Generic Criteria

Multiple Input
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Input Input Values Required

Input 1 Column or Literal with Default of the Model Account Column ✔

Remarks
Adjust the Start and End Level of Detail inputs to determine which parts of the chart of accounts
structure will be displayed and how many grouping levels there are.
When utilizing the Chart of Accounts calculation and grouping structure, no other column
groupings can be added before or after.
The Chart of Accounts grouping automatically collapses the lowest level of grouping with no
method of keeping that expanded due to the nature of the Chart of Accounts logic in JD Edwards.
This calculation constructs hidden grouping columns to create the visible account hierarchy. Use the
"Show System Columns" option from the Hide/Show Columns dialog to view these columns. At that
time, the additional Account calculations will appear with the level of grouping number attached at
the end of their alias (ex: CALC_3_7 for group level 7 of your chart of accounts).
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Current Mailing Address
Description
Retrieve either the current or as-of-a-date mailing address for an Address Book Number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Address Number Column or Literal ✔

As of Date Column or Literal - Default set to Today's Date ✔

Add name Check Box

Add Country Check Box

Remarks
This calculation will always use the mailing name for line ID zero in the F0111.
Mailing address (stored in the F0116) is formatted in a region-specific format using values from the
CTR column in the F0116 (UDC 00/CN). Current specified formats: US, EU, UK, ZH (China), RU, CA,
GB, CN, TW, SG, UZ. The US format will be used for undefined formats.
Language specific addresses will attempt to be retrieved from the F0116D and F0111D tables
matching the signed-on user's language preference (specified in user preferences). This is supported
starting with JDE Applications 9.2 Update 7.

Example
1. Input: 1001

2. Quick Calculations > JDE > Current Mailing Address

3. Output: (Format using the US format with line breaks)

J.D. Edwards & Company (<NAME> skipped if Name is unchecked)
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8055 Tufts Avenue (<ADDR>)

Suite 1331 Denver, CO 80237 (<CITY>, <STATE> <ZIP>)

(<COUNTRY> skipped if Country is unchecked)
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Date to Period
Description
Take a date and extract the Period Number or Fiscal Year as an output. The date is compared against the
F0008 Fiscal Date Patterns and F0010 Company Names & Numbers tables to establish the output based
on each data row record.

Parameters
Options

Input Parameter Values Input Values

Company Column or Literal

Result As Century, Fiscal Year, Period, Two-Digit Fiscal Year

Accounting Interval 12-Period or 52-Period

Only Rollup If Generic Criteria

Input
Input Input Values Required

Date Column or Date Literal ✔

Remarks
Leaving the calculation's Company field blank will imply to use the default company's fiscal date
pattern for Company 00000. Specifying a literal value number in the company field will force all rows
to use that company's date pattern, ex. 00010. And using a table's Company field will then choose
the fiscal date pattern per data row record for that company as it relates to that record's fiscal date
pattern. If a table does not have a Company field, you will have to create a table lookup or table join
to the F0010 table linked by business unit (branch plant).
In the case of 52-period date patterns, the F0008B table is used.

Example
Let's say you are on a non-calendar fiscal year starting October 1st and following the monthly cadence
for periods.

If you want to identify what period a specific date falls in, you can utilize the Date to Period calculation.
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1. Select Design > Calculations > Date to Period
2. Input: G/L Date (let's say this specific example looks at the date 4/1/2023)
3. Output: 7

The reason that the output is 7 rather than 4 fo the period is because period 1 for the example above is
actually October of 2022.
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E1 Time to DateTime
Description
Converts JD Edwards Date Updated and Time Updated columns into a single DateTime column.

Parameters
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Date Literal (Date Input) ✔

Input 2 Column or Date Literal (6 Digit Number) ✔

Remark
The JDE time format is an integer in the form of hhmmss.

Example
1. Input: 12/31/2017 for Date Input and 230021 for Time Input
2. Quick Calculations > JDE > E1 Time to DateTime
3. Output: 12/31/2017 11:00:21 PM
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Get Short Item Number
Description
Efficiently retrieve the Short Item Number given the 2nd Item Number. This negates the need to join the
Item Master table to your report.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

2nd Item Number Column or Literal ✔

Remarks
This method will retrieve the Short Item Number (ITM) from the Item Master (F4101) using the value of
the 2nd Item Number (LITM).

Example
1. Input: 2nd Item Number (2001)
2. Quick Calculations > JDE > Get Short Item Number
3. Output: Returns Primary Short Item Number (60062)
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JDE Email Address
Description
Return a selected email address for an Address Number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Address Number Column or Literal ✔

Who's who line ID Column or Literal with default of 0

Email Type (E, I, W) Column or Literal

Remarks
Gets the email address for the given Address Number from the F01151 table.
If Email Type is not specified, the order of search for an email address for a given line ID is E > W > I.
If multiple email addresses exist that meet the settings criteria, the calculation will prefer an email
address that is marked as primary with a value of 1 in the 'Messaging Indicator' column (EHIER) of
the F01151 table. After checking the 'Messaging Indicator' column, the calculation will also prefer
email entries with a lower line number (RCK7) field.
This calculation will only operate for EnterpriseOne users - World is not supported. (World uses a
different table, F01018, for email address information.)

Example
1. Input: 3333
2. Quick Calculations > JDE > JDE Email Address
3. Output: ContinentalInquiries@CICorp.com
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JDE Phone Number
Description
Return a selected phone number for an Address Number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Address Number Column or Literal ✔

Who's who line ID Column or Literal with default of 0

Related person ID Column or Literal with default of 0

Phone type Column or Literal

Remarks
Phone number information is stored in the F0115 table.
Phone types are listed in the 01/PH UDC. It is common for the JD Edwards phone type to be blank.
To find phones where the phone type is blank, use the <BLANK> token. If no value is specified for
the phone type setting, the first entry by line number (RCK7 field) will be returned.
Who's who line ID comes from the IDLN field in the F0115 Address Book - Phone Numbers table.
Related person ID comes from the CNLN field in the F0115 Address Book - Phone Numbers table.
'Related Person ID' only works for E1. For World users, this field will be ignored.
Related persons of an Address Book entry are defined in the F01112 Related Person table. A
common example of this is a dependent of an employee.

Example
1. Input: 4242
2. Quick Calculations > JDE > JDE Phone Number
3. Output: (404) 555 - 6389
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JDE User Name
Description
Leverages JD Edwards' F0092 Library Lists table to retrieve the JDE User Name.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Address Number Column or Literal ✔

Example
1. Input: 4242
2. Quick Calculations > JDE > JDE User Name
3. Output: ANNA
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Media Objects
Description
Displays text media object information for a media object enabled JDE table. These calculations are
usually created for you using the 'Quick Media Object' command.

Calculation Editor
Options

Input Parameter Values Input Values

Generic Text Name Generic Text Record in the Object Librarian Master Table F9860

Text Sequence Column or Literal

Language Language Code from User Defined Code Values Table F0005

Adjust Row Height Check Box

Only Rollup If Generic Criteria

Map values to the Generic Text Data structure
Generic Text Field Filter Criteria Required

Selected Media Object Column or Literal ✔

The Generic Text Field will be an input for each member of the specific media object data structure.
All Generic Text Fields will link to a column or literal input.
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Remarks
This is a calculation only accessible for JD Edwards E1.
Only text Media Objects are supported by this calculation.
It is recommended that instead of utilizing the Media Objects calculation as the first course of action
for including this type of information in DAS Reports, a user should right-click their designated
columns that have Media Object information (like the Document Number in the A/P Voucher Detail
F0411 Table for example) to view the Media Objects quickly under the Quick Media Object section.
The options listed under the Generic Text Name are found inside of the F9860 using a filter to only
review Object Types of GT which is the Media Object Data Structure records. By utilizing the Quick
Media Objects section in a report (right-clicking a column), the Generic Text Name and additional
information in the Media Objects calculation will be auto-generated.
To review all Media Objects inside of DAS that come from JD Edwards, utilize the F00165 Media
Objects Storage table.
The F98MODAT Media Object File Data Storage table was introduced in JDE Tools Release 9.2.1.
A blank language indicates the use of language as specified in your user preferences in DAS. The list
of Language options available from the ellipses on that input option comes from the User Defined
Code Values Table F0005 with the filters of Product Code 01 and Us Cd LP.
Media Objects are created and managed in JD EDwards. For more information, the JD Edwards
Oracle Guide  has a section on Media Objects.

Example
1. Open the F4211 Sales Order Detail Table
2. Right-click on the column caption for Order Number
3. Select "Quick Media Objects" > Choose the Media Object item that you want to include.

https://docs.oracle.com/en/applications/jd-edwards/cross-product/9.2/eotfo/prerequisites-1.html
https://docs.oracle.com/en/applications/jd-edwards/cross-product/9.2/eotfo/prerequisites-1.html
https://docs.oracle.com/en/applications/jd-edwards/cross-product/9.2/eotfo/prerequisites-1.html
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For a more in-depth example of how to utilize Media Objects effectively in Data Access Studio, refer to
the ReportsNow Academy free webinar  starting at 21:07.

NOTE

If a user manually creates a Media Objects calculation, then the corresponding media type input
and pass-through parameters would need to be created.



https://academy.reportsnow.com/Course/Start?courseId=15&lessonId=913
https://academy.reportsnow.com/Course/Start?courseId=15&lessonId=913
https://academy.reportsnow.com/Course/Start?courseId=15&lessonId=913
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Model Account
Description
This calculation is used by Quick Reports for Financials, Job Cost, and Fixed Assets to compare to the
F0901 Account Master for use as a filter, obtaining a business unit's Chart of Accounts as the model
account Level of Detail (LD) roll-up structure.

Calculation Editor
Options

Input Parameter
Values Input Values

Model Business Unit Literal Value of a Business Unit - Default is linking Model Business Unit
parameter into this calculation

Only Rollup If Generic Criteria

Remarks
The Chart of Accounts in JD Edwards is typically tied to the specific account information (MCU, OBJ, SUB)
rather than a "Model" account (just OBJ and SUB). Sometimes it can be handy to view balance
information, for instance, with a different chart of accounts. So, for instance, you may want to compare
different business units or consolidations of business units to one "master" chart of accounts. The Model
Account calculation solves this issue.

The Model Account calculation is going to be automatically created when you select the Chart of
Accounts option with a Consolidated Business unit in the Quick Reports wizard.

After your report is created, the Model Business Unit parameter is linked automatically into the model
account calculation that then produces the input for your Chart of Accounts calculation.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 310 / 480



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 311 / 480

Offset Between Two Periods
Description
Allows a user to identify the number of periods between two periods.

Calculation Editor
Options

Input Parameter Values Input Values

Company Column or Literal

Period 1 Column or Literal

Century 1 Column or Literal

Fiscal Year 1 Column or Literal

Period 2 Column or Literal

Century 2 Column or Literal

Fiscal Year 2 Column or Literal

Accounting Interval 12-Period or 52-Period

Only Rollup If Generic Criteria

Examples
Example 1

1. Design > Calculations > Offset Between Two Periods
2. Inputs:

1. Company: Co
2. Period 1: 6
3. Century 1: 20
4. Fiscal Year 1: 17
5. Period 2: 7
6. Century 2: 20
7. Fiscal Year 2: 17
8. Accounting Interval: 12-Period

3. Output: 1 (Period 6 of 2017 to Period 7 of 2017 is only a 1 period offset)
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Example 2
Imagine the case in a balance table where you may want to show an actual amount if the period meets a
certain threshold or a budget amount otherwise. Or let's say that if the period is in a period threshold
range you want to show an amount, otherwise you want to show 0.

To solve this problem, you will need a reliable way to count the number of periods between two points:

(century + fiscal year + period)B - (century + fiscal year + period)A

For instance, point A could be the reference period and point B could be the current period.

To perform the Offset Between Two Periods calculation:

1. Open a table with period information (e.g. Account Balances (F0902))

2. Click Design | Calculations

3. Enter Offset Between Two Periods

4. In the Parameters, enter a static Company, grid column company or blank (for default JDE
company)

5. Enter values for the reference period: Period 1, Century 1, Fiscal Year 1

6. Enter values for the other period: Period 2, Century 2, Fiscal Year 2

When you run your report, the Offset Between Two Periods column will contain the number of periods
between 2 and 1.
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Period Amounts
Description
Allows a user to make multiple period amounts appear as one period amount column for the use case of
the JD Edwards balances table like the F0902 GL Account Balances and the F1202 Fixed Asset Balances.

Options
Input Parameter Values Input Values

Period Column or Literal

End Period Column or Literal

DateItem Prefix (Advanced) Column or Literal two-digit code

Accounting Interval 12-Period or 52-Period

Only Rollup If Generic Criteria

Remarks
The DateItem Prefix option is utilized when there are multiple period balance columns available in the JD
Edwards table being used and you want to specify the Alias prefix that will result in those periods being
looked at. For example, in the F06136, there are four different period bin segments. By right-clicking on
one of the column captions and going down to the Column Caption section, a user can see that the
segments of columns start with aliases of BW, BX, BE, BY. These two-digit alias codes would be what
goes into the DateItem Prefix section of the calculation input to determine which period columns are
being looked at.

In the case of the F0902 or the F1202 which are the two most common balance tables, there is only one
set of period columns and therefore nothing needs to be set in the DateItem Prefix section.

Example 1
1. While on an F0902 Accounts Balances table, Select Design > Calculations > Period Amounts
2. Inputs:

1. Period: 1

NOTE

You may consider utilizing the Relative Period Calculation instead as it has more features.

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2. End Period: 6
3. Summarizes Period 1 - Period 6 on the F0902 into a single "Period Amounts" calculated column

Example 2
When working with balances tables such as the Account Balances (F0902) or Asset Account Balances
(F1202), it can be a challenge to work with the amount fields (AN01 through AN14). Rather than deal
with 14 amount columns, it would be much simpler if you could combine all the columns into one
column. This is what the Period Amounts calculations does.

So what are the advantages of using Period Amounts over say summing the amount columns
manually? Plenty:

1. Easier to change the period value: Any time you want to change which period or which through
period, just change the value of the Period Amount calculation. If you manually summed the
columns, then every time you needed a different period, you would have to delete the old sum, re-
select the columns you wanted to add, and add the new sum calculation.

2. Easier to build a report foundation: With Period Amounts you only have to create one
calculation. This means that any calculation you need to do off the period value can reference the
one calculation. This makes maintaining and building your amount-based report much more simple.

3. Hook up to Report Parameters: You can hook up the Period Amount parameters to your Report
Parameters. This lets you prompt the user for the period number when they run the report.

To add a Period Amounts column:

1. Open a table or view with AN01-AN14 (such as the Account Balances or Asset Account Balances
tables).

2. Click the  Calculation Editor button on the main toolbar.

3. Type in Period Amounts under the Type of Calculation.

4. On the Parameters, enter 1 for Begin Period. Enter any number from 1 through 14 for End Period.

5. (Optional) Specify Ledger Type to only rollup values for a specific ledger type (e.g. AA).
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6. (Optional) Specify a DateItem prefix. By default, the calculation will rollup AN01-AN14 (or though
AN12 if AN13 and AN14 do not exist). Some tables, however, have other arrays of balance amounts
that can be rolled up similarly. For example, the Tax History (F016136) table defines BW01-BW12. To
use Relative Period on this table, enter BW for this parameter. If this parameter is blank, the
calculation will default to the AN prefix.

NOTE

If Begin Period and End Period are the same number, then the calculation represents the
amount for that period. If Begin Period is 1 and End Period is another number, then the
Period Amount is the "through" period amount (e.g. such as Year-to-Date depending on the
year start period).


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Period to Date Range
Description
Allows you to take a Period, Fiscal Year, and Century and create a Date or Date Range span for desired
output and use - mainly used in variables to set filter ranges.

Calculation Editor
Options

Input Parameter Values Input Values

Company Column or Literal Integer

Period Column or Literal Integer

Century Column or Literal Integer

Fiscal Year Column or Literal Integer

Side Both, End, or Start

Accounting Interval 12-Period or 52-Period

Relative Offset Column or Literal

Only Rollup If Generic Criteria

Remarks
1. These period inputs utilize the F0008 Fiscal Date Patterns and F0010 Company Names & Numbers

tables to establish the date outputs. In the case of a 52-period calendar, the F0008B table will be
used rather than the F0008.

2. Leaving the calculation's Company field blank will imply to use the default company's fiscal date
pattern for Company 00000. Specifying a literal value number in the company field will force all rows
to use that company's date pattern, ex. 00010. Using a table's Company field will then choose the
fiscal date pattern per data row record for that company as it relates to that record's fiscal date
pattern. If a table does not have a Company field, you will have to create a table lookup or table join
to the F0010 table linked by business unit (branch plant).

3. Side determines which part of the date range you want returned. Selecting End will return
something like <=6/30/2023 while selecting Start would return >=6/1/2023 based on your other
inputs. The example below shows what selecting Both would look like.
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Example
1. Design > Calculations > Period to Date Range
2. Input: Period 6, Century 20, Fiscal Year 17, Side Both
3. Output: >=6/1/2017:<=6/30/2017
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Relative Period
Description
Take the calculation's parameter criteria and return balances from a balance table, most often the F0902
GL Account Balances table.

Calculation Editor
Options

Input Parameter
Values Input Values

Relative Offset Literal Integer

Organize By Inception to Date, Job to Date, Period, QTD, Quarter, Year, Year + Adjustment
Periods, or YTD Fiscal Period

Company Column or Literal

Period Literal

Fiscal Year Literal

Date Column or Literal

DateItem Prefix
(advanced)

Column or Literal

Reverse Sign Criteria Field and Criteria inputs

Add Begin Balance
Criteria

Field and Criteria inputs

Add Original Budget
Criteria

Field and Criteria inputs

Accounting Interval 12-Period or 52-Period

Only Rollup If Generic Criteria

Remarks
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The relative period calculation will either take Period and Fiscal Year inputs or a Date input, but it
does not need both options.
The 'Add Begin Balance Criteria' setting is required to be set to properly evaluate an 'Inception to
Date' total. Without it, The 'Organize By' settings 'Inception to Date' and 'YTD Fiscal Periods' options
will return the same totals.

DateItem Prefix
The DateItem Prefix option is utilized when there are multiple period balance columns available in the JD
Edwards table being used. Specify the Alias prefix (two-digit code) to tell the calculation which period
balance columns to utilize.

For example, in the F06136, there are four different period bin segments. By right-clicking on one of the
column captions and going down to the Column Caption section, a user can see that the segments of
columns start with aliases of BW, BX, BE, BY. One of these two-digit alias codes would be what goes into
the DateItem Prefix section of the calculation input to determine which period columns are being looked
at.

In the case of the F0902 or the F1202 which are the two most common balance tables, there is only one
set of period columns and therefore the DateItem Prefix section can be left blank.

General Ledger Guidelines used in Quick Reports
For the "Reverse Sign Criteria" and "Add Begin Balance Criteria", an Account Category calculation is
created as a part of the Quick Report wizard. This calculation can then adjust necessary object account
ranges based on the General Ledger Guidelines that have been set up in JD Edwards' Automatic
Accounting Instructions.

If the GLGs have not been properly set up in JD Edwards, a user can adjust the field and criteria being
used to determine which records will either reverse the signs or contain beginning balances.

Examples
How to utilize Relative Periods in Quick Reports (Financials)
Relative Period calculations are automatically created when you utilize Quick Reports to create financial
statements, fixed asset reports, or job cost reports. This means that while there are still methods of
manipulating the relative period calculations in the editor, this example will not include the physical
creation of the relative period calculation.

Let's say you've created an income statement inside of Quick Reports that returns the current Fiscal
Period based on the parameter inputs you select. You would now like to turn your report into a rolling
12-period income statement. You can do this utilizing the settings of a relative period calculation.
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1. Start by selecting the existing relative period calculated column and copying it 11 times for a total of
12 relative period calculated columns.

2. Go into Design > Calculations to view all relative period calculations at once.

3. Start going down the list and adjust the "Relative Offset" of each calculation 1 forward. Example: if
your first relative period calculation has a relative offset of 0, your second one will have a relative
offset of 1, third will be 2, fourth will be 3 and so on up to 11.

4. Return to your report and enter in Fiscal Period of 1 and Fiscal Year of your choosing to see an
Income Statement showing Periods 1 - 12.

Note: Some users choose to set up their rolling 12-period income statement in the negative instead.
This means that whatever Fiscal Period is put into the parameter, the 12 periods that show up are
going backwards from the selection. To do the report that way, the Relative Offsets in the calculated
columns will be 0 through -11 rather than 0 through 11.

If you wanted to add in a Fiscal Year column at the end that includes the entire current fiscal year based
on the parameter inputs of your report viewer, copy a relative period calculation from what already exists
and adjust the "Organize By" option to be "Year". The name will dynamically adjust as well, but feel free
to right-click to select "Rename" as well if an adjustment is needed beyond the default.

How to utilize Relative Periods in HR Reports (F06136 - Tax
History)
Let's say you want to create a report in your Tax History table that allows users to analyze employees for
specific time frames (Current Fiscal Period and Year to Date for example) and review their Gross Pay, you
can utilize relative period calculations to accomplish this.

1. In the F060136 table, start by selecting the columns that you want to be always visible in your
report. This will not include any gross pay period bin columns. I have included Address Number (and
its associated description of Employee name), Employee Tax ID, Work Tax Area, and Statutory Code
in my example.

2. Because you would like these period and YTD relative period bins to adjust the returned column
outputs based on user selection, create a parameter for Fiscal Period set to integer editor type and
another for Fiscal Year set to integer editor type.

3. Select Back on the Parameter Editor and go to Design > Calculations
4. Create a Relative Period Calculation with the following inputs:

1. Relative Offset: 0
2. Organize By: Period
3. Company: Co (Data Column)
4. Period: <Fiscal Period> (This is your parameter)
5. Fiscal Year: <Fiscal Year> (This is your parameter)
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6. DateItem Prefix: Because we are looking to analyze Gross Pay rather than one of the option
options available in this table, we will use the code "BW" which is visible when you go to Design
> Columns and review the alias names for the Gross Pay columns.

5. Repeat the above step again, but in Organize By, select YTD Fiscal Period which summarizes the
values of all periods from the period 1 to your Fiscal Period parameter selection for the given Fiscal
Year.

Now, as you adjust your report parameters, you can watch as your two relative period calculations adjust
as well.

Advanced Note: A designer could create a parameter for DateItem Prefix that links to the relative period
calculations to allow the end user to adjust the period bin columns they are viewing without having to
enter the calculation editor.

Note: The F41112 Item As Of table is another commonly used table for the Relative Period calculation
outside of Quick Reports due to its period bins.
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Unit Conversion
Description
Returns the conversion factor between two units of measure for a given item number.

Calculation Editor
Options

Input Parameter Values Input Values

Short Item Number Column or Literal

Business Unit Column or Literal

Input Units Column or Literal

Output Units Column or Literal

Maximum Hops Integer with default of 6

Only Rollup If Generic Criteria

Remarks
Allows you to take a value based on the Unit of Measure's User Defined Code value and convert the
value using the F41003 Unit of Measure table to get a conversion rate into your desired new unit
value.
The calculation may include the F41002 table as well as it provides item and branch plant specific
unit conversions.
The system will attempt to chain together conversions (ex: KG > OZ would go through KG > LB >
OZ). The 'Maximum Hops' setting provides a cut-off. If a conversion did not occur before 'Maximum
Hops', then 0 is returned for the conversion.
An item-specific conversion (F41002) is preferred over a general conversion (F41003).
A mixture of item and branch plant specific and general conversions can be chained together.

Example
Imagine that you have transactions for various items in various units. What if you wanted to see those
transactions in one unit? Let's say you wanted to see everything by kilograms or cases. This topic
explains how to use the Unit Conversion calculation to solve this problem.
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JD Edwards allows users to enter transactions for items in various units. Although JD Edwards provides
unit conversions for items, it is fairly difficult to actually query this conversion information and provide
the correct conversion. The Unit Conversion calculation lets you convert any unit to any other unit
seamlessly. To convert the units of an item:

1. Right-click the item number in your grid.
2. Select Quick Calculation | EnterpriseOne/World | Unit Conversion.
3. Data Access Studio will create a new column called "Unit Conversion". Double-click this new column

to edit.
4. You will see that the Short item is already populated with the Short Item Grid Column setting.
5. If business units affect your conversions, select a business unit column for the Business unit setting.
6. Select Input units if your table has transactional units (usually the UM field). If you leave Input

Units blank, then the calculation will use the base unit of the item as the input unit.
7. Select the desired Output unit. This can be a parameter or hard-coded value.

Once you get data, you will see that the Unit Conversion column has the correct unit conversion for
each item. Simply multiply your transaction quantity by this conversion to get the converted quantity.
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Work Day Offset
Description
Offsets a date input by a certain amount of work days based on the F0007 Calendar Information table in
JD Edwards.

Calculation Editor
Options

Input Parameter
Values Input Values

Day Offset Number of work days to offset the input by.

Branch Typically the grid column value for a business unit. This will be the branch that
the calculation uses when looking up the work day information.

Default Branch If no branch is specified or if it has a blank grid column value, then use this value.

Shift Valid shift code (F0007.SHFT). Default is blank for no shift code.

WorkDay code W=workday, E=weekend, H=holiday. Default is workday (W).

Calendar Type Valid calendar type (F0007.WDCT). Default is blank for no specific type.

Calendar Key Valid calendar name (F0007.WDCK). Default is blank for no name.

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
If the offset is set to 0, then the calculation will return the date if the date matches the work day code
provided. However, if the date does not match then it will return the next available day that matches the
code. This will also return blank if the work day calendar is not set up for the given branch/date
combination.
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Example
Offset an Invoice Date field by an offset value of -2. The calculation will offset the invoice date by two
work days (prior).
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Work days
Description
If you need to report how many days a resource has worked, then the Work Days calculation is for you.
JD Edwards allows one to define various work day patterns. The problem is that this information can be
difficult to utilize in a report. The Work Days calculation simplifies the information so that you can get
relevant information into your report such as:

Work days, holidays, or weekends per month
Whether a given day is a weekend, holiday, or weekend
Work days, holidays, or weekends per year
Calculate by branch plant and default branch plan
Calculate by shift

Calculation Editor
Options

Input
Parameter
Values Input Values

Work date(s) Input a single date or Any valid date range using the range notation. e.g.
>=1/1/2017:<=12/13/2017 or <6/1/2016, etc. When this field has a valid range, it
overrides any other date specification setting and the WorkDay calculation uses this
date range to compute the workday count.

Branch Typically the grid column value for a business unit. This will be the branch that the
calculation uses when looking up the work day information.

Default
Branch

If no branch is specified or if it has a blank grid column value, then use this value.

Year Four-digit year that represents the year you are interested in getting the workday
information for.

Month 0=all months, 1 = jan, 2 = feb ... 12= dec.

Day of the
Month

0=all days in month, 1 = day one ... 31 = day 31.

Shift Valid shift code (F0007.SHFT). Default is blank for no shift code.
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Input
Parameter
Values Input Values

WorkDay
code

W=workday, E=weekend, H=holiday. Default is workday (W).

Calendar Type Valid calendar type (F0007.WDCT). Default is blank for no specific type.

Calendar Key Valid calendar name (F0007.WDCK). Default is blank for no name.

Only Rollup If Generic Criteria

Examples
Example 1 - Identify Work Days
Let's say you want to identify if any of your invoice dates are non-work days which would be an anomaly
to be called out.

To do this, you can utilize the work days calculation.

1. Start by going to Design > Calculations > Work Days
2. For the input Work Day(s), change Column as Filter to Column and link in Invoice Date
3. Link Branch to your Branch Plant or Business Unit column with MCU alias
4. Type *ALL into the Default branch literal input
5. Save and Close the calculation to see 1's returned anywhere the invoice date is a work day.

Any instance of 0 means that the date code for that specific date is not equal to "W" which means it
could be an "E" for weekend, "H" for holiday or something else.

Example 2 - Determine the number of work days between two
dates
Let's say you want to identify the number of work days between your due date and invoice date in order
to understand the average amount of days between the two.

To do this, you can utilize the work days calculation.

1. Start by going to Design > Calculations > Concatenation
2. Create a concatenation that connects these four elements with the name "Date Range"

1. Literal value of >=
2. Column of Invoice Date
3. Literal value of :<=
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4. Column of Due Date
3. Select Save on your Calculations Window
4. Create a Work Days calculation next
5. For the input Work Day(s), link the "Date Range" concatenation column you just created
6. Link Branch to your Branch Plant or Business Unit column with MCU alias
7. Type *ALL into the Default branch literal input
8. Save and Close the calculation to see the number of days between the two dates. For positive

values, the earlier date will go first in your concatenation.
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Math Calculations
Absolute Value : Returns the distance of a number from zero, without considering its sign.
Average : Finds the mean of a set of numbers. It is the sum of all the numbers divided by the total
count of the numbers.
Ceiling : Rounds up a number to the nearest whole number.
Difference : The result of subtracting one number from another.
Division : The result of dividing one number by another.
Floor : Rounds down a number to the nearest whole number.
Ln : A specific type of Logarithmic function that uses the mathematical constant e (approximately
2.71828) as its base. The natural logarithm is the inverse of the power (exponential) function with
base e. This is solving for x in the equation y = b^x when y is your input and b is the mathematical
constant e.
Log : The inverse of the power (exponential) function where the base is 10. This is solving for x in the
equation y = b^x when y is your input and b is 10.
Margin : Difference between the cost price and the selling price of a product. Usually expressed as a
percentage of the cost price.
Maximum : Highest value in a set of numbers.
Median : Middle value in a set of numbers. If there is an even number of values, it is the average of
the two middle values.
Minimum : Lowest value in a set of numbers.
Multiplication : The result of multiplying one number by another.
Power : Raising a number to a specific power resulting in the base number being multiplied by itself
as many times as the power number states. Also known as the "exponential" function.
Random Number : A number that is generated between a specified range by a random process.
Remainder : The result of dividing one number by another and taking the remainder (leftover values
that don't total the divisor).
Round : Rounds a number to the nearest integer.
Running Total : Sum of a set of numbers up to a certain point.
Sign : Returns the sign of a number, either positive, negative or zero.
Square : The result of multiplying a number by itself.
Square Root : Calculates the square root of a number, which is the number that, when multiplied by
itself, gives the original number. This is the opposite of squaring a number.
Standard Deviation : Measure of the spread of a set of numbers. Square root of the variance, which
is the average of the squared differences from the mean. High standard deviation indicates that the
data points are spread out, while a low standard deviation indicates that the data points are close
together. This helps outline the variability of a set of data.
Sum : The result of adding a set of number together to get a total value.
Truncate : Removes the decimal part of a number and returns the integer part.
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Uniform Buckets : Method of diving a range of values into a specific number of equally sized
buckets. Each bucket contains a range of values that is the same size as the other buckets.
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Absolute Value
Description
Returns the distance of a number from zero, without considering its sign.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Examples
Example 1

1. Input: -125.43
2. Quick Calculations > Math > Absolute Value
3. Output: 125.43

Example 2
1. Input: 24
2. Quick Calculations > Math > Absolute Value
3. Output: 24



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 332 / 480

Average
Description
Finds the mean of a set of numbers. It is the sum of all the numbers divided by the total count of the
numbers.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Example
1. Input: January Gross Amount (125), February Gross Amount (100), March Gross Amount (180)
2. Highlight all columns: Quick Calculations > Math > Average
3. Output: 135
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Ceiling
Description
Rounds up a number to the nearest whole number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This calculation is the opposite to Floor.

Examples
Example 1

1. Input: 3.18
2. Quick Calculations > Math > Ceiling
3. Output: 4

Example 2
1. Input: 214.96
2. Quick Calculations > Math > Ceiling
3. Output: 215
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Difference
Description
The result of subtracting one number from another.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Operation Input Values Required

+ or - sign toggles when selected Column or Literal ✔

+ or - sign toggles when selected Column or Literal ✔

Remarks
If the difference calculation is used from the Design > Calculations window, you will need to
manually the second operation to a - sign to ensure a difference calculation is being performed
rather than a sum.
The Difference and Sum calculations are identical in nature and can be used interchangeably.

Example
1. Input: Actual Amount (100), Budget Amount (90)
2. Quick Calculations > Math > Difference
3. Output: 10
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Division
Description
The result of dividing one number by another.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Examples
Example 1

1. Input: Total Price (1000), Units Ordered (100)
2. Quick Calculations > Math > Division
3. Output: 10

Example 2
You can easily calculate the percentage between two columns. Select the columns you need by clicking
the column headers while holding down the CTRL or SHIFT keys.
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Right-click the column header on the selection and select Quick Calculation > Math > Division.

Notice that the division calculation shows divisions across Summaries and Grand Total automatically.

Right-click the new column header and select Custom Numeric Format.

Choose Percent and click OK.
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Floor
Description
Rounds down a number to the nearest whole number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This calculation is the opposite of Ceiling.

Examples
Example 1

1. Input: 3.18
2. Quick Calculations > Math > Floor
3. Output: 3

Example 2
1. Input: 214.96
2. Quick Calculations > Math > Floor
3. Output: 214
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Ln
Description
A specific type of Logarithmic function that uses the mathematical constant e (approximately 2.71828) as
its base. Good for displaying rapidly changing data.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Utilize Custom Numeric Formatting to adjust the number of visible decimal places.

Example
1. Input: 50
2. Quick Calculations > Math > Ln
3. Output: 3.91

1. Reasoning: e^3.91202300543 = 50
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Log
Description
The inverse of the power (exponential) function where the base is 10. Good for displaying rapidly
changing data.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Utilize Custom Numeric Formatting to adjust the number of visible decimal places.

Example
1. Input: 50
2. Quick Calculations > Math > Log
3. Output: 1.70

1. Reasoning: 10^1.69897000434 = 50
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Margin
Description
Difference between the cost price and the selling price of a product divided by the selling price to return
a decimal value that should then be analyzed as a percent.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Remarks
Default output is a decimal value, but you can utilize Custom Numeric Formatting to adjust the format to
be percent.

Example
1. Equation: Gross Margin = (Revenue - Cost of Goods Sold) / Revenue
2. Input: Revenue ($25,000), Cost of Goods Sold ($12,500)
3. Quick Calculations > Math > Margin
4. Output: 1.70

1. Reasoning: Gross Margin = ($25,000 - $12,500) / $25,000 = 0.5 > 50%
2. Adjust the format of the output to percent using the Custom Numeric Format option
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Maximum
Description
Highest value in a set of numbers.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Example
1. Input: Quantity Column 1 (400), Quantity Column 2 (750), Quantity Column 3 (114)
2. Quick Calculations > Math > Maximum
3. Output: 750
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Median
Description
Middle value in a set of numbers. If there is an even number of values, it is the average of the two middle
values.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Examples
Example 1

1. Input: Quantity 1 (400), Quantity 2 (750), Quantity 3 (114)
2. Quick Calculations > Math > Median
3. Output: 400

Example 2
1. Input: Amount 1 (15), Amount 2 (7), Amount 3 (19), Amount 4 (3)
2. Quick Calculations > Math > Median
3. Output: 11

1. Reasoning: Even number of values result in the average of the two middle values : 15 and 7
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Minimum
Description
Lowest value in a set of numbers.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Example
1. Input: Quantity 1 (400), Quantity 2 (750), Quantity 3 (114)
2. Quick Calculations > Math > Minimum
3. Output: 114
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Multiplication
Description
The result of multiplying one number by another.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Example
1. Input: Unit Price (15), Units Ordered (100)
2. Quick Calculations > Math > Multiplication
3. Output: 1500
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Power
Description

Raising an number to a specific power resulting in the base number being multiplied by itself as
many times as the power number states.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Remark
Exponential functions are useful for such problems like determining the total cost of a loan over time.

Example
1. Input: Input 1 (4), Input 2 (2)
2. Quick Calculations > Math > Power
3. Output: 16

1. Reasoning 4^2 = 4*4 = 16
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Random Number
Description
A number that is generated between a specified range by a random process.

Calculation Editor
Options

Input Parameter Values Input Values

Minimum Value Column or Literal (Required)

Maximum Value Column or Literal (Required)

Only Rollup If Generic Criteria

Remarks
The behavior for the maximum value is "less than", not "less than or equal to" meaning that number
won't be included in the options for random number.
The default Random Number range is greater than or equal to 1 and less than 100.
If improper values are inputted, the default range will be applied (Ex: Didn't give a maximum value
OR returned a string as a minimum value).
The random numbers generated will return different results every time the report returns new data
(Get Sample Data or Run Report).
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Remainder
Description
The result of dividing one number by another and taking the remainder (leftover values that don't total
the divisor).

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Example
1. Input: Input 1 (10), Input 2 (3)
2. Quick Calculations > Math > Remainder
3. Output: 1

1. Reasoning 10/3 = 3.33 where 3 * 3 = 9 and 10 - 9 = 1
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Round
Description
Rounds a number to the nearest integer.

Calculation Editor
Options

Input Parameter Values Input Values

Digits Literal Whole Number (Required)

Divisor Column or Literal (Required)

Midpoint Option Round Up or To the nearest even (Banker's rounding)

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Default behavior is no decimal places (Digits), divisor of 1 and midpoint option of Round Up.
Divisor: This will divide your value by whatever number the divisor states (default is 1)
"To the nearest even" is only related to numbers that have .5, otherwise, rounding will work as usual.

Examples
Example 1

1. Input: 3.49
2. Quick Calculations > Math > Round

1. Default Selections: Round Up
3. Output: 3

Example 2
1. Input: 3.50
2. Quick Calculations > Math > Round
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1. Default Selections: Round Up
3. Output: 4

Example 3
1. Input: 2.50
2. Quick Calculations > Math > Round

1. Change Rounding Behavior: To the nearest even (Banker's Rounding)
3. Output: 2

Example 4
1. Input: Input 1 Column (3.51)
2. Quick Calculations > Math > Round

1. Default Selections: Round Up
3. Output: 4



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 350 / 480

Running Total
Description
Sum of a set of numbers up to a certain point.

Calculation Editor
Options

Input Parameter Values Input Values

Column to group by Column (Optional)

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
If Column to group by is left blank and the report has no groupings, the running total is calculated
based on the report's current sort order, if one exists.
If Column to group by is left blank and the report has groupings, the lowest grouping level is
automatically used as the Column to group by.
If a column is specified for Column to group by, the running total resets and recalculates within
each distinct value of that column.
Sort order affects all running total calculations, as it determines the sequence in which values are
accumulated.

Example
1. Input: Gross Amount (Respective Records: 20, 15, 45)
2. Quick Calculations > Math > Running Total
3. Output: Running Total (Respective Records: 20, 35, 80)
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Sign
Description
Returns the sign of a number, either positive or negative or zero.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Output options include 1, 0, -1 to indicate positive, zero or negative sign.

Example
1. Input: -250
2. Quick Calculations > Math > Sign
3. Output: -1
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Square
Description
The result of multiplying a number by itself.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This is the opposite of the Square Root calculation.

Example
1. Input: 25
2. Quick Calculations > Math > Square
3. Output: 625

1. Reasoning: 25^2 or 25 * 25 = 625
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Square Root
Description
Calculates the square root of a number, which is the number that, when multiplied by itself, gives the
original number. This is the opposite of squaring a number.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This is the opposite of the Square calculation.

Example
1. Input: 16
2. Quick Calculations > Math > Square Root
3. Output: 4

1. Reasoning: 4 * 4 = 16
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Standard Deviation
Description
Measure of the spread of a set of numbers. Square root of the variance, which is the average of the
squared differences from the mean. High standard deviation indicates that the data points are spread
out, while a low standard deviation indicates that the data points are close together. This helps outline
the variability of a set of data.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Remarks
Inputting only one value will result in a blank output.

Example
1. Input: Literal Values - 10, 1, 7, 8, 9, 3
2. Design > Calculations > Input based on above
3. Output: 3.55902...
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Sum
Description
The result of adding a set of numbers together to get a total value.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 (+ or - sign toggles when selected) Column or Literal ✔

Input 2 (+ or - sign toggles when selected) Column or Literal

Remarks
Although this is a Sum calculation, the operations are able to be switched to - signs by selecting
them.
The Difference and Sum calculations are identical in nature and can be used interchangeably.

Examples
Example 1

1. Input: Actual Amount (100), Sales Tax (7)
2. Quick Calculations > Math > Sum
3. Output: 107

Example 2
Data Access Studio lets you easily sum up multiple columns into a new totals column.

To sum columns, multi-select the columns you need by clicking the column headers while holding down
the CTRL or SHIFT keys.
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Right-click any column header in your selection, and select Quick Calculation > Math > Sum.

Note: If your layout is grouped, the sum column will show totals for each summary line and grand totals
as well.

If you want to add a grand total at the bottom of the sum:



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 357 / 480

Truncate
Description
Removes the decimal part of a number and returns the integer part.

Calculation Editor
Input Parameter Values

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 3.86
2. Quick Calculations > Math > Truncate
3. Output: 3
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Uniform Buckets
Description
Method of diving a range of values into a specific number of equally sized buckets. Each bucket contains
a range of values that is the same size as the other buckets.

Calculation Editor
Options

Input Parameter Values Input Values

Bucket Size Literal Whole Number

Lower Limit (Optional) Literal Number

Upper Limit (Optional) Literal Number

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Make sure to change the Bucket Size from 0 as this will output only blank values.

Examples
Example 1

1. Input:
1. Bucket Size: 10
2. Lower Limit: 0
3. Upper Limit: 100
4. Input: Gross Amount with values ranging from 1 to 100

2. Output: [0,10], [11,20],... [>=100]

Example 2
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Let's say you want to create a histogram to evaluate the frequency that different quantities of product
are ordered in your business. You can utilize the Uniform Buckets calculation to create a calculated
column that can be used for your bar chart. This example will utilize a Sales Order Detail Table (F4211
and the quantity ordered field)

1. Start by going to Design > Calculations and creating a Uniform Buckets Calculation.
2. Set your bucket size to 100 (or whatever is appropriate for your quantity range). Feel free to set an

upper and lower limit as needed.
3. Create a dashboard off of this report.
4. Create a Bar chart where your argument is the uniform bucket and your value is quantity ordered.
5. Format your dashboard as you see fit, but note that you can now analyze the frequency that

different bins are selected based on quantity ordered.
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System Calculations
Burst: Used to build a burst report which can either allow distributions, sub-reports accessible as
drill-downs, or the ability to return fields from other reports.
Conditional: Allows for "If/Then/Else" logic to be used to produce a true or false result.
De-Duplicate: Handle redundant information by clearing duplicate records in a column based on
how data is grouped.
Formula: A method of performing calculations that allows for typing of expressions to calculate new
values from existing values.
Group Rank: Returns the relative rank of a value within a numeric column.
Group Row Index: An index or numbering applied to rows within a group to indicate their position
or order.
Group Summary: An aggregated result or computation that summarizes the data for a specific
group, like a total or average.
Hyperlink: A reference or navigation element that allows users to easily jump to a URL with a single
click.
Mask: Allows a user to determine which data is to be allowed or disallowed based on specific
conditions. This calculation is only utilized for Administrators using masking security.
Parent Child Hierarchy: Allows you to create a tree level grouping of records when a parent-child
relationship exists leveraging two fields.
Random Row Index: A random index assigned to each row, often used for random sampling or
shuffling data.
Range Filter: Allows date range filters to be more easily created with in between ranges or exclusion
ranges.
Row Index: A unique identifier assigned to each row in a table to indicate position or order.
Spacer: An empty or blank column used to create space between columns for better readability,
formatting or organization.
Security Audit: Security Audit is used by ReportsNow to grab the User ID and Role from the JDE
security table, F0092, and create the Security Audit Report Grouping on Identity.
Type Converter: A function that changes a column's data from one data type to another, for
example, converting a text string to a date type.
URL Encoder: A process that converts characters into a format that can be transmitted over the
Internet within a URL.
XPath Query: Allows for querying data from XML documents using the XPath 1.0 specification.
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Conditional
Description
Allows for "If/Then/Else" logic to be used to produce a true or false result.

Calculation Editor
If

Field Criteria Filter or Chain Required

Column Value Input Literal (utilize valid filter syntax) Filter ✔

Then
Input Input Field Required

Value if true Column or Literal

Multiply by Column or Literal

Add Column or Literal

Value if false Column or Literal

Multiply by Column or Literal

Add Column or Literal

Treat empty as BLANK Check Box

Remarks
The caption of the conditional will be the same as the grid column mapped to the 'Value if true'
setting. If it is a literal, the caption will be the text of the literal.

NOTE

The Chain option allows AND or OR criteria to be added if advanced condition logic needs to be
met in the calculation. If two rows of filters are included in the IF section, they are assumed to be
joined by an AND criteria automatically.


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Treat empty as BLANK indicates that if the criteria is blank the condition is effectively ignored. If
checked, the value must match blank for it to be true.
Conditional calculations can be easily converted to Formulas, making it easier to implement more
advanced logic like nested if statements.
The Replace Calculation is a great use of conditional logic as well.
There are certain Trend Wizards that utilize the conditional calculation to produce the desired
output. See Turn Row Values into Column Values.

Example
Let's say you want to conditionally label a row as "High Priority Check" when the Gross Amount for a
customer is above $10,000.

1. Select Design > Calculations > Conditional

2. Fill in the criteria:

1. If:
1. Field = Gross Amount
2. Criteria = > 10000

2. Then:
1. Value if true = High Priority Check (this is a literal value)
2. Value if false = <BLANK> (there should be nothing here - a blank literal value)

3. Ensure the Type of calculation is set to String

4. Select Save and Close

5. View output - Confirm that any gross amount records greater than $10,000 have a value of "High
Priority Check"

NOTE

Default return type for a conditional is a decimal. While this is more frequently used, the
example here demonstrates a need for the return type to be changed to string.


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De-duplicate
Description
De-duplicate is a powerful System calculation that helps you manage data duplication. Data duplication
is common with LEFT OUTER joins and RIGHT OUTER joins. Recall that you do a LEFT OUTER join when
you have a 1-to-many or many-to-many relationship between one table (the left table) and another
table (the right table).

Calculation Editor
Options

Input Parameter Values Input Values Required

Column to de-duplicate Column or Literal ✔

Value if false Column or Literal ✔

De-duplicate method Distinct Values, First value in group, or Up to first level break ✔

Grouped column Column

Only Rollup If Generic Criteria

Remark
If you are using a Table Lookup calculation, there is an option to "Fetch Unique Targets Only Once"
which simulates a de-duplicating of the output. See Table Lookup.

Example
Suppose you create a table join: F0411 left outer F0911 join. This is an example of a many-to-many
relationship in JD Edwards:
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Notice that when duplication is present in your query, you can usually see it immediately. Notice the AP
Amount Dup duplicates within the Pay Items (001, 002, 003). Notice the G/L Amount Dup duplicates
the pattern: 100.00, 100.00, 300.00 with each Pay Item.

Because of the many-to-many relationship, the highlighted amounts duplicate (and in two different
ways). Although the 1,500 totals match, the value of 1,500 is in fact the wrong number. Now look at the
AP Amount and G/L Amount columns. The AP amount de-duplicates its column (AP) to take just the first
values in the group (which is correct for the LEFT table in the join). The G/L Amount de-duplicates its
column by taking the values only up to the first level break (which is correct for the RIGHT table in the
join).

De-duplicate is outlined on the following:

1. Column to de-duplicate (in the Example above AP Amount Dup, G/L Amount Dup).

2. Value if false: What value to use as a "filler" (e.g. blank or 0).

3. De-duplication method:

1. First value in group - Applies the first value in group once and uses the "filler" value for the
rest.

2. Up to first level break - Applies all the values until the first group level break occurs. In the
example above, the first level break occurs when the Pay Item goes from 001 to 002.
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3. Distinct values - Applies a value if it is distinct within the group. Otherwise it applies the "filler".
4. Group column: If blank, the calculation uses the lowest level group when performing the de-

duplication. If a grouped column is specified, the de-duplication will use that grouping as its
reference for groups and level breaks.
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Group Rank
Description
Returns the relative rank of a value within a numeric column. Often used in conjunction with a Group
Summary calculation to perform Top-N rankings.

Calculation Editor
Options

Input Parameter Values Input Values

Rank Largest to Smallest Checkbox (Default Checked)

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
Let's say you want to quickly see all of your suppliers ranked by their Amount Vouchered YTD from
largest to smallest.

1. Open the F0401 report with Address Number (or the associated description - Vendor Name field)
grouped and Amount Vouchered YTD.

2. Right-click on the Amount Vouchered YTD column and select Quick Calculations > System > Group
Rank (This will ensure the ranking is based on the Amount Vouchered YTD totals)

3. Once that calculation has completed, right-click on it and select "Sort Ascending" to see your
Suppliers listed out from largest amount vouchered to smallest.

Now you are able to see the full list of suppliers ranked based on the unique Amount Vouchered YTD
values.

For a more complete use case, please reference the Top N Trend as well, which also utilizes the Group
Rank calculation.
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Group Row Index
Description
An index or numbering applied to rows within a group to indicate their position or order.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Column Input Values Required

Input 1 Column ✔

Example
Let's say you want to only return the first record found within each grouping of a column. You can do
this using the Group Row Index calculation.

1. Create an F0411 report with Address Number (or the associated description - Vendor Name field)
grouped.

2. Right-click on the Address Number column and select Quick Calculations > System > Group Row
Index

3. Notice that in the expanded group state, you are able to easily view the row index only within that
grouping. As soon as a new grouping starts, the row index resets to 1 as well.

4. To only return the first record from each grouping, you can then filter the Group Row Index field to
1. Once the filtering is complete, feel free to hide that field so it's not visible in your report.
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Group Summary
Description
An aggregated result or computation that summarizes the data for a specific group, like a total or
average.

Calculation Editor
Options

Input Parameter Values Input Values

Column to group by Column

Summary Type Average, Count, First, Maximum, Minimum, None, or Sum

Column Total Check Box

Only Rollup If Generic Criteria

Input
Input Input Values Required

Field Input Column ✔

Remarks
The Top N Trend utilizes the Group Summary to rank fields based on grouped totals.

Example
When you Group and Summarize your report and you need to query on the summary values themselves,
add the Group Summary calculation to your report.
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In the example above, if we want to filter for Amount balancing to 0, we cannot filter on the Amount
summary directly. We can only filter on the detail rows. We need to move the summary into detail rows
to allow filtering. This is done by adding the Group Summary calculation:

1. Right-click the Column Header for the summary you need to filter (in this example right-click the
Amount column)

2. Select Quick Calculations > System > Group Summary

You can now type 0 in the Group Summary Amount filter box to get only those groups whose summary
is 0.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 371 / 480

Hyperlink
Description
The Hyperlink calculation is a reference or navigation element that allows users to easily jump to a URL
with a single click.

Calculation Editor
Options

Input Parameter Values Input Values

URL Column or Literal

Displayed Text Column or Literal

Only Rollup If Generic Criteria

Remarks
The Hyperlink calculation is maintained as an active link in the Embed Excel Presentation Layer, Excel
Data Output, PDF Data Output, and HTML Data Output.
The Hyperlink calculation cannot be utilized inside of Dashboards or ProReports directly from the
underlying report. Instead, utilize functionality specific to those areas of the system.

For dashboarding, include the 'URL' and 'Displayed Text' settings as separate report columns to
use as a Hyperlink in a grid. Review Hyperlinking in dashboards for more information.
For ProReports, review Add Cross References and Hyperlinks

Example
The example below defines a hyperlink such that for each user, clicking the link will bring up the Address
Book Revision form for that user in JD Edwards.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 372 / 480

To add a Hyperlink calculation to your report:

1. Open the calculation editor
2. Select the Hyperlink calculation.
3. Specify the URL. This input is typically a Concatenation calculation that combines the static part of

the URL with the dynamic part (for example, the address number column as in the figure above). You
will typically use the URL Encode calculation as well to ensure your URL string is always URL friendly.

4. Specify the Displayed Text. The displayed text can be the URL itself or a more user-friendly text
representation of the hyperlink (which can also be the result of a calculation).

Once a hyperlink calculation is created for a report, the user will be able to export the functioning
hyperlink to these formats: PDF, Excel, and HTML (See Export and Print Results). Also, the DAS Automatic
Presentation feature preserves the hyperlink behavior (See Automatic Presentation).
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Mask
Description
The Mask calculation allows a user to determine which data is to be allowed or disallowed based on
specific conditions. This calculation is mainly utilized for Administrators using masking security.

Calculation Editor
If

Field Criteria

Grid column Filter or Chain (Filter: Literal Value; Chain: AND or OR)

Then
Input Input Values Required

Mask
column

Grid column ✔

With value Column or Literal

Action Mask if condition is met, Mask if condition is not met, Remove row if
condition is met, Remove row if condition is not met

✔

Remarks
This calculation is regularly used to set up the Masking Security Report available for DAS
Administrators.
The column selected for "Mask Column" will be hidden or changed to the "With value" selection in
accordance with the filter condition and the "Action".

Example
While the mask calculation is most often used by Administrators, it can be used in other reports as well.
The example below shows how a designer can utilize the mask calculation to hide information they don't
want a subscriber to see. For this example, let's say a designer created a report off of the F060116 that
they want to share with some fellow employees, but any employees labeled with Job Typ of A1 or 1M-3
(executives) should have their Annual Salary hidden.

1. Open your report (F060116 for this example)
2. Limit the columns in the report to only what is needed.
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3. Select Design > Calculations > Mask
1. Review this picture to see what options were selected and inputted

2. 

4. Save and Close
5. Review report. Notice that there is a Mask column where each row is labeled as Masked or

Unmasked. Additionally, notice that whenever the Job Type is A1 or 1M-3, the Annual Salary is
blanked out due to the calculation criteria.
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Parent Child Hierarchy
Description
Allows you to create a tree-level grouping of records when a parent-child relationship exists, leveraging
two fields.

Calculation Editor
Options

Input Parameter Values Input Values Required

Parent Column Column ✔

Child Column Column ✔

Parent Label Column ✔

Child Label Column ✔

Max tree depth Literal integer (Default is 10)

Show Parent Detail Check box

Auto format Check box

Start point Literal integer

Running Factor Column or Literal integer

Remarks
Max tree depth: Defaulting to 10, max tree depth determines the maximum number of grouped
levels that will appear in the Parent Child Hierarchy grouping.
Show Parent Detail: Default checked. When checked, the calculation will show the parent detail for
each level. Sometimes you will want to show this detail line and other times not. To suppress the
parent row, uncheck this option.
Auto format: By leaving Auto format checked, the hierarchical structure for the parent and child
relationships is created. If the Auto format is unchecked at the initial creation of the Parent Child
Hierarchy calculation, there will be no grouping created and the outputted column information will
include Parent Column and Parent Label (or Child Column and Child Label) concatenated into one
record output.
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Start Point: Enter any value, list of values, range, or valid filter to define which items to show at the
top of the tree. If blank, the tree top will be all the items that have no parent.
Running Factor: When parent items scale quantities of child items, then set the Running Factor to
the quantity column.

Understand JDE Tree Structures
JD Edwards has many tree-formatted data tables: Organization Charts, Bill of Materials, Menu Structure,
Company structure. The common pattern between each of these tables is that the table information has
these two columns: a parent column and a child column. In this pattern, the parent column can have
multiple children. Each child in turn can be a parent of even more children. Furthermore, in some cases
such as the Bill Of Materials table, a child can belong to more than one parent. In general this pattern
looks like:

A1

|

|---B1

| |

| |---C1

| |---C2

|

|---B2

etc.

The Parent Child calculation in Data Access Studio transforms the linear data in the table to a dynamic
tree structure like above. Once in the tree form, you will immediately see the structure of the information
in your tables. Furthermore, you can create reports that roll up information per this structure. For
example, you can do head count by supervisor.

Example
To use the Parent Child calculation:

WARNING

The Auto Format option does override any existing groupings in the report.

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1. Open a table with a parent column and a child column (e.g. the employee master F060116 (address
number and supervisor)).

2. Optional, but recommended: get the Associated description for the child column and parent
column.

3. Click Design > Calculations

4. Select Parent Child Hierarchy

5. In the Parameters tab, select the parent grid column in the Parent column

6. Select the child grid column in the Child column

7. Select the Associated Descriptions you created in step two for the Parent label and Child label

8. Click Save and Close

When you click Run Report, you will see the structure of the information in the table as seen below.
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Random Row Index
Description
A random index assigned to each row, often used for random sampling or shuffling data.

Calculation Editor
Options

Input Parameter Values Input Values

Mode All, Threshold or less, Threshold percent or less

Threshold Column or Literal (Default is 0)

Remarks
Mode: Indicates the amount of records (rows) in the report that will receive a Random Row Index
that's not zero.
Threshold: Threshold is only relevant when Mode is not set to All.

When Mode is set to Threshold or less and Threshold is set to "20", only 20 randomly selected
rows will receive a number (1 - 20) while the rest of the records will receive a 0.
When Mode is set to Threshold Percent or less and Threshold is set to "20", only 20% of the
total number of records will receive a number while the rest of the records receive 0.
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Range Filter
Description
Allows date range filters to be more easily created with in between ranges or exclusion ranges.

Calculation Editor
Input Parameter Values

Input Parameter Values Input Values

Filter Type Is between or Is not between

From option From or From and excluding

Through option Through or Through and excluding

Only Rollup If Generic Criteria

Range Inputs
Input Input Values Required

From Value Column or Literal ✔

Through Value Column or Literal ✔

Remarks
From Value – lower bounds of the range filter
Through Value – upper bound of the range filter
Filter type:

Is Between – Construct an inclusive range filter. “>=A:<=B”
Is Not Between – Construct an exclusion range filter. “<=A;>=B”

From option:
From – Indicates the ‘From Value’ in the range. (>=)
From and excluding – Indicates to not include the ‘From Value’ in the range. (>)

Through option:
Through – Indicates the ‘Through Value’ in the range (<=)
Through and excluding – Indicates to not include the ‘Through Value’ in the range. (<)

This is an easy to use method for constructing range filters to be used for such things as Table Lookup
calculations (make sure to use the Column as filter setting as opposed to just Column when specifying
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how to query the target table). Behaves like the Range Filter visual assist dialog with the added option of
creating an exclusion range. If either option is blank, that part of the filter will be omitted.

Example
1. Design > Calculations > Range Filter

1. Filter Type: Is between
2. From option: From
3. Through option: Through
4. From Value: Invoice Date (ex: 06/30/2024)
5. Through Value: Due Date (ex: 07/30/2024)

2. Output: >=<DATE 06/30/2024>:<=<DATE 07/30/2024>



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 381 / 480

Row Index
Description
A unique identifier assigned to each row in a table to indicate position or order.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Example
1. Design > Calculations > Row Index
2. Save and Close
3. View Results: Each row will have a numbered index
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Security Audit
Security Audit is used by ReportsNow to grab the User ID and Role from the JDE security table, F0092,
and create the Security Audit Report Grouping on Identity. There is no typical use for this aside from
ReportsNow internal use.
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Spacer
Description
An empty or blank column used to create space between columns for better readability, formatting or
organization.

Remarks
This calculation is most commonly used for formatting within Financial Statements to space out sections
of columns.

Example
1. Design > Calculations > Spacer
2. Save and Close
3. View the column with no row fields
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Type Converter
Description
A function that changes a column's data from one data type to another, for example, converting a text
string to a date type.

Calculation Editor
Options

Input Parameter Values Input Values

Use Input Column Format Checkbox

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
The Use Input Column Format check box is not checked by default. By checking this option,
whatever format the input column is currently in (ex: changing date format appearance for "January
2024" instead of "1/1/2024") will be reflected in the output of this calculated column.
The default Type is set to String.

Examples
Example 1

1. Right-click on Column > Quick Calculations > System > Type Converter
2. Double-click into the Type Converter Calculated Column to open the editor
3. See the default output type is set to "String". Change Output type to desired value.

NOTE

The output type of the column or literal input is based on the Type set on that calculation. This is on
the left hand side of the calculation editor screen.


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Example 2
Let's say you would like to utilize a date field in a concatenation with another field for your grouping.
You can use the type converter to get the date field into a string format before including that new
calculated column in your concatenation.

1. Right-click on your date field > Select "Custom Date Format" > Choose a format that looks different
than the default format.

2. Go to Design > Calculations > Type Converter
3. Input the Date field as the input and set the output type to String.
4. Save and Close > See that the date format is appearing in its original format rather than the custom

date format.
5. Return to your Type Converter calculation editor > Select the "Use Input Column Format" checkbox
6. Save and Close > See that the date format now reflects the custom date format selected.
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URL Encode
Definition
A process that converts characters into a format that can be transmitted over the Internet within a URL.

The URL Encode calculation (which typically works in conjunction with the Hyperlink calculation) formats
an input string into an URL parameter friendly format.

Calculation Editor
Input Parameter Values

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Inputs
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
When creating links to your physical reports, check out the Report Links option.

Example
1. Right click your column > Select Quick Calculations > System > URL Encode
2. Review Output.

Original Text URL-Friendly

Mountain Bike Red Mountain+Bike+Red

Men's Suit Jacket Men%27s+Suit+Jacket

NOTE

This URL encoded output is now ready to be used inside of a hyperlink. This is a great way to ensure
your dynamic hyperlinks (based on differing row values) are going to function correctly.


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XPath Query
Description
The XPath Query calculation allows for querying data from XML documents using the XPath 1.0
specification.

Parameters
Options

Input Input Values

Root XPath
Query

Common XPath root query to a subset XML document that allows for easier querying
by the output columns. (Required)

XML Column or Date Literal representing a valid XML document. (Required)

Only Rollup If Column or Date Literal

Output Columns
One to many XPath queries of the XML data produced by the Root XPath Query.

Input Input Values

XPath XPath query of the XML data produced by the Root XPath Query. This query can
produce a single or multiple values. (Required)

Summarization None (Default), 'First value of the set', or 'Comma delimited string'

Output
Processing

None (Default), 'unescape XML' - If an XML node contains xml-escaped XML data,
output valid XML data.

Remarks
This calculation uses the .NET Framework XML library's XPath implementation that follows the XPath 1.0
specification.

This calculation will produce a row for each returned node of an XPath query if the 'None' summarization
is selected.

Example
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Example 1
Consider the following document:

Input:
Root XPath Query: /books
XML: above document

Output Grid Column1
Column 1

XPath: book/title/text()
Summarization: None
Output Processing: None

Output:

Column 1

Title

Title 2

Example 2
Consider the following document:

<books>  
    <book>  
        <title>Title</title>  
        <author>Author Name</author>  
        <price>5.50</price>  
    </book>  
    <book>  
        <title>Title 2</title>  
        <author>Author Name 2</author>  
        <price>10.50</price>  
    </book>
</books>  

<books xmlns="http://www.contoso.com/books" xmlns:p="http://www.contoso.com/books/prices">  
    <book>  
        <title>Title</title>  
        <author>Author Name</author>  
        <p:price>5.50</p:price>  
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Input:
Root XPath Query: /books
XML: above document

Output Grid Column1
Column 1

XPath: book/title/text()
Summarization: 'Comma delimited string'
Output Processing: None

Column 2
XPath: book/p:price/text()
Summarization: 'First value of set'
Output Processing: None

Column 3
XPath: book/author/text()
Summarization: 'None'
Output Processing: None

Output:

Column 1 Column 2 Column 3

Title, Title 2 5.50 Author Name

Title, Title 2 5.50 Author Name 2

    </book>  
    <book>  
        <title>Title 2</title>  
        <author>Author Name 2</author>  
        <p:price>10.50</p:price>  
    </book>
</books>  
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Text Calculations
Comment : Allows the user to input and edit string values in a column's rows by typing directly into
cells in the DAS grid. This comment capability is available for Private and Public reports and can
apply to detail, subtotal, or grand total row levels.
Compare Strings : Allows two columns to be compared as strings by returning a value of -1, 1, or 0
based on the outcome of the comparison.
Concatenation : Allows two or more inputs to be concatenated and formatted into one output
column.
Contains : Allows for search of specific values or strings of text within a column's values.
Pad : Allows for padding of characters before or after an input column's values.
Replace : Acts as a simplified nested conditional or "true/false" calculation where multiple True
conditions may be presented within one calculation.
Split : Allows splitting of columns' details into segments based on delimiter(s) which present as new
calculated columns.
String Length : Determines a column's total string length per row.
String Match : Allows for parsing by searching strings for explicitly things like emails, parts of filter
expressions, or any other custom defined string. This calculation uses a textual searching language
called Regular Expressions (regex). This language uses a small set of special characters --[^.|?*+() to
allow for defining the criteria of the search.
Substring : Select a specific portion of an input by choosing the beginning and end points for all
characters in that column.
To Lowercase : Allows any string input to be standardized to all lowercase values.
To Uppercase : Allows any string input to be standardized to all uppercase values.
Trim : Trim characters before or after a value.
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Comment
Description
Allows for adding comments/annotations to a report that persist with the report itself. Including
comments/annotations is possible for designers and subscribers in a published report. These string
values can apply to detail, subtotal, or grand total row levels.

Calculation Editor
Associated Column(s)

Input Input Values Required

Input 1 Column No

Remarks
The values of the calculation's associated columns in a row determine the uniqueness of the
comment (see examples). To create a column where every row has a unique comment, the
associated columns should be set to the primary key of the table the report is based on.
If no associated columns are added, then the user will only be able to input and edit comments in
subtotal and grand total rows.
Once this calculation is saved, the associated columns cannot be changed.
In a published report, subscribers with the Edit Comments permission can edit and save comments
as well. Learn more about publishing comment behavior in the Publish Your Report to Others
section.
Unlike editing comments in a published report, comments edited in a private report are not saved
immediately to the database. Instead, comments are saved when the report is saved.
If comments are changed but need to be reverted, selecting Undo will return to the previous
comment. At the time of saving a report, the Undo action is no longer available.

Limitations
In ProReports and Dashboards, only detail row comments will be brought over.
Master Burst Bring Backs do not support Comment calculations being used as return values.
Comment columns cannot be grouped on.

Audit Information
Hovering over a comment will show the date, time, and user who last edited the comment.
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Clearing Comments
It may be necessary to remove comments in a column as a whole rather than deleting them on a row-
by-row basis. There are three options to clear comments in selected columns.

1. Clear all comments: Completely remove all comments in the selected column(s) regardless of
filters.

2. Clear visible comments: Only removes visible comments in the selected column(s).
3. Clear nonvisible comments: Only removes comments not currently visible in the selected

column(s). Be aware of what filtering is being done on a report's data before selecting this action.

NOTE

Entering into a comment cell and deleting an individual comment will save audit information for
that deletion. To remove audit information when deleting comments, use one of the Clear Comment
options.


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To identify the total number of comments and the number of comments currently visible in a column
after a report run, go to Design Notes and scroll to the comment calculation. There, a Visible and Total
Comments value can be seen.

Keyboard Navigation with a Comment Calculation
In addition to being able to click into any editable comment cells in a report, users may be able to utilize
keyboard navigation to help type a series of comments faster.

1. Selecting Enter will place your cursor one row below the current row. This makes typing in
comments one after another easy.

2. Selecting Tab will place your cursor one column to the right of the current cell.
3. Utilize the Arrow keys to navigate from cell to cell easily.
4. When in edit mode on a specific comment cell, right and left arrow keys are accessible to move the

cursor between characters.

Examples
Create a Comment Calculation with Unique Row Comments
Let's say you want every row to have a unique comment.

1. Select Design > Calculations > Comment
2. Select all columns that compose the table's primary index as the associated columns
3. Select Save and Close

Or using a Quick Calculation:

1. Select all columns that compose the table's primary index
2. Quick Calculations > Text > Comment

If you then comment on a row, that comment will be unique to that row and will not show in any other
rows.

NOTE

These options only become available after a report is saved with the current groupings.

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Create a Comment Calculation based on two Associated
Columns
Let's say you want to leave comments on rows based on the Document Type and Approver Number.

1. Select Design > Calculations > Comment
2. Select Document Type and Approver Number as the associated columns
3. Select Save and Close

Or using a Quick Calculation:

1. Select Document Type and Approver Number
2. Quick Calculations > Text > Comment

Now, if you comment "Needs reapproval" on a row where the Document Type is AA and Approver
Number is 0, every row with those values in Document Type and Approver Number will show "Needs
reapproval".

Create a Comment Calculation only for Total Rows
Let's say you want to leave comments only on subtotal and grand total rows.

1. Select Design > Calculations > Comment
2. Select Save and Close without adding any associated columns

Now, only subtotal and grand total comments will be editable.

Clear Comments with Specific Text Only
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Take this sample report below. Let's say you wanted to delete every comment that says 'Needs re-
evaluated'.

1. Filter the comment column on 'Needs re-evaluated'

2. Right-click on the Evaluation column

3. Comment > Clear visible comments
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4. Remove the filter on the Evaluation column

Visible comments will have been cleared while comments hidden by the filter are preserved.
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Compare Strings
Description
Allows two columns to be compared as strings by returning a value of -1, 1, or 0 based on the outcome
of the comparison.

Calculation Editor
Options

Input Parameter Values Input Values

Strip Blanks Check Box

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal ✔

Remarks
This calculation performs a culture-sensitive and case-sensitive comparison based on your DAS (or
JDE) language setting.
Strip Blanks will remove the blank characters in a column before doing the calculation. For example,
the business unit column frequently has leading spaces. If you want those spaces to be maintained
in the comparison of values, uncheck the "Strip Blanks" check box.
The result is a new calculated column where the result is:

Result Meaning

-1 Input 1 precedes Input 2 in a sorted list based on culture rules

0 Input 1 equals Input 2

1 Input 2 precedes Input 1 in a sorted list based on culture rules
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Culture Rules include Alphabetic order, uppercase before lower case, numbers before alpha, punctuation
before numbers

Examples
Example 1 (Mismatched Text)

1. Inputs: Clothing Incorporated & Clothing Inc.
2. Quick Calculations > Text > Compare Strings
3. Output: 1

Example 2 (Mismatched Integers)
1. Inputs: 17 & 24
2. Quick Calculations > Text > Compare Strings
3. Output: -1

Example 3 (Matched Text)
1. Inputs: Bikers R Us & Bikers R Us
2. Quick Calculations > Text > Compare Strings
3. Output: 0
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Concatenation
Description
Allows two or more inputs to be concatenated and formatted into one output column.

Calculation Editor
Options

Input Parameter Values Input Values

Strip Blanks Check Box

Skip Delimiter for Blank Values Check Box

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Input 2 Column or Literal

Remarks
Strip Blanks will remove the blank characters in a column before doing the concatenation. For
example, the business unit column frequently has leading spaces. If you want those spaces to be
maintained in the concatenation, uncheck the "Strip Blanks" check box.
Skip Delimiter for Blank Values: If this is selected, any field value that's a column with the cell value
of BLANK will ensure that the following concatenated input of a literal will be skipped.
Every concatenation created from Quick Calculations will default to having " - " delimiters in
between each column value. You can edit the calculation after the fact in favor of a different
delimiter.
Enable the default preferences setting called "Double-click concatenates associated description" to
automatically use this calculation to bring together a code column and its associated description
when double-clicking the code column. This type of 'code - description' column format is common
for many report writers.

Example
1. Input: Co, Business Unit, Subsidiary, Description (00001, 20, SUB, Liabilities)
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2. Quick Calculations > Text > Concatenation
3. Output: Co - Business Unit - Subsidiary - Description (00001 - 20 - SUB - Liabilities)
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Contains
Description
Allows for search of specific values or strings of text within a column's values.

Calculation Editor
Options

Input Parameter Values Input Values

Text to Find Column or Literal (Required)

Input String is a Filter: List of Values or Simple Text

Case Sensitivity Case Sensitive or Ignore Case

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Input String is a "Filter: List of Values" will search a filter list of values (a list of values separated by
semicolons) for a specific "Text to Find" value and return 1 only if it finds an entire field in the list
that matches. Review example below.
Case Sensitivity indicates whether capital and lowercase characters will be taken into account as a
match or not.

Examples
Example 1

Design > Calculations > Contains
Inputs:

Text to Find: Supplies
Input String is a: Simple Text
Case Sensitivity: Case Sensitive
Input: Vendor Name (ex: ABC Supplies, Alphabet Homes)
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Output: ABC Supplies = 1 and Alphabet Homes = 0

Example 2
Design > Calculations > Contains
Inputs:

Text to Find: 00004
Input String is a: Filter: List of Values
Case Sensitivity: Ignore Case
Input: Document Numbers (ex: 00001;00004, 00001;00002;00003)

Output: 00001;00004 = 1 and 00001;00002;00003 = 0

NOTE

If the above example had "Text to find" set to '4' instead of '00004', all resulting contains outputs for
the example would result in 0 records because it is only checking for whole one to one matches
inside the filter: list of values.


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Pad
Description
Allows for padding of characters before or after an input column's value.

Calculation Editor
Options

Input Parameter Values Input Values

Left or Right Side Left or Right

Strip Blanks Check Box

Padding Character Literal Value

Total Width Literal (Integer Value)

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Pad will only evaluate the sides that you select. It will not pad characters in the middle of an input
value.
It is possible to pad columns with spaces as the padding character as well.
Strip Blanks will remove the blank characters in a column before doing the pad. For example, the
business unit column frequently has leading spaces. If you want those spaces to be maintained in
the pad, uncheck the "Strip Blanks" check box.

Example
1. Input: 45032
2. Design > Calculations > Pad

Left or Right Side: Left
Padding Character: 0
Total Width: 8
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3. Output: 00045032
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Replace
Description
Acts as a simplified nested conditional or "true/false" calculation where multiple True conditions may be
presented within one calculation.

Calculation Editor
Options

Input Parameter Values Input Values

Source String Column or Literal (Required)

Default Value Column or Literal (Required)

Only Rollup If Generic Criteria

Specify multiple patterns to replace
On the left-hand side, enter text or text patterns (you may use any valid filter to define what you want to
replace). On the right-hand side, specify the value to replace with if the match occurs.

Replace This Pattern With This Value Required

Literal Value Column or Literal ✔

Literal Value Column or Literal

Remarks
Source String: Column to use as the input for the text replace.
Default Value: Column value or literal value to use if none of the text replace criteria matches.
Replace calculation inputs under the "Replace This Pattern" section of the calculation can include
wildcards (*) or filter field operation syntax (><:;).

Example (Substitute Text with Labels)
Let's say you have an Employee Jobs report to create that creates labels for employees based on various
job types, but your job types right now are too specific and you need more general labels.

See example data below to start:
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1. Design > Calculations > Replace
Source String: Job Type Description
Default Value: Literal Value = Miscellaneous
Replace This Pattern with this value

Engineer = Engineering
Manager = Management
Analyst = Analytics
Employment = Human Resources
Benefits = Human Resources
Purchasing = Purchasing

This example utilizes wildcards as you can see in the screenshot below (*) to indicate any records that
include those text values. Wildcards are not required for inputs in your replace calculation.
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This would be a larger example, but the replace calculation can have as many or as few replaced patterns
as you need for your use case. At any time, the designer can return to the replace calculation to add
more in the future as well.

Output Shown Below:
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Split
Description
Allows splitting of column's details into segments based on delimiter(s) which present as new calculated
columns.

Calculation Editor
Options

Input Parameter Values Input Values

Delimiters Literal or Column (Required)

Delimiters is one string Check Box

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Specify 1 for first split, 2 for second, etc.
For the Split Number column, you need to enter a number for each piece of the splits that you want. For
instance, if you want the first two parts of the split, enter 1 and 2 as respective split numbers.

Grid Column Split Number Required

String Value Integer Value ✔

String Value Integer Value

Remarks
The Caption for the Split calculation in the Calculation Designer Window is not linked to the names
of the output columns. The outputted calculated column names come from the "Grid Column"
section of the Split Calculation editor.
Check "Delimiters is one string" if the whole delimiter setting represents a single delimiter instead of
a set of single character delimiters.
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You are not limited to a specific number of splits - the example below shows 2 splits, but a larger
number of splits is possible with this calculation.

Example
Let's say you have a column that includes first and last names in this format: Last Name, First Name. If
the user wants to just see the last name returned they can use the split calculation.

Design > Calculations > Split

Delimiters: ,
Input: Full Name Column
Split Number: 1 = Last Name

This will simply return the last name (everything before the comma) in a new column called "Last Name".

If you choose to return the first name as well, add the following...

Split Number: 2 = First Name
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This will now return an additional calculated column called "First Name" (everything after the comma).

Lastly, let's say you only wanted to return first name from the start. You can simply have the Split
Number = 2 without having any first value returned. The value will only show one column that's
everything after the first comma.
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String Length
Description
Determines a column's total string length per row.

Calculation Editor
Options

Input Parameter Values Input Values

Strip Blanks Check Box

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Strip Blanks will remove the blank characters in a column before doing the String Length calculation.
For example, the business unit column frequently has leading spaces. If you want those spaces to be
maintained in the string length count, uncheck the "Strip Blanks" check box.

Example
1. Input: 48AC83
2. Quick Calculations > Text > String Length
3. Output: 6
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String Match
The String Match calculation searches strings for emails, parts of filter expressions, or any other custom
defined item.

Input
Match Type

Filter Range: Parses a range expression (ex. >10:<50) into discrete elements (see below).
Email: Parses an email string (tom@acme.com) into 'name' and 'domain' elements.
Custom Regular Expression: Opens a regular expression editor that allows for regular expression
matching of strings.

Ignore Case will ignore case matching for the entire search string
Right-to-Left will search from the end of the string to the beginning
For advanced users, see other supported in-line options  that can be used.

The Match Type can also be passed in using Column Input to support dynamic regular expressions.

Output

https://docs.microsoft.com/dotnet/standard/base-types/miscellaneous-constructs-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/miscellaneous-constructs-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/miscellaneous-constructs-in-regular-expressions
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Matched String: Based on the match type.
Filter Range

CompleteMatch: The entire match (ex. '>10:<50')
StartOperator: The start range operator (ex. '>')
StartRange: The start range value (ex. '10')
Separator: The boolean separator value (';' for OR and ':' for AND)
EndOperator: The end range operator (ex. '<')
EndRange: The end range value (ex. '50')

Email
CompleteMatch: The entire match (ex. 'tom@acme.com')
Email: Same as 'CompleteMatch' (ex. 'tom@acme.com')
Name: (ex. 'tom')
Domain: (ex. 'acme.com')

Custom Regular Expression
CompleteMatch
The output is based on the number of capture groups defined in the regular expression.

Match Occurrence: In the case the match criteria finds more than one match in the string, this
option indicates what match to return. Setting this property to zero will return a single concatenated
string of all matches (useful to globally scrub a string).

Summary
This string matching calculation uses a textual searching language called Regular Expressions (aka
'regex'). This language uses a small set of special characters -- [\^.|?\*+() to allow for defining the
criteria of the search. Acquiring a basic understanding of these characters is key to effectively using
regular expressions.

TIP

Using any of these characters [\^$.|?\*+() in your criteria requires escaping by prefixing the special
character with the back slash character \.


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The back slash \ special character is the escape character of the language. In other words, it allows us to
search for these special characters if we need to. For example, use \? to search for a question mark.

Wild Cards and Quantifiers - The Dot ., the Question Mark ?, the
Asterisk *, the Plus +, and the curly brackets {}
The most basic search technique is to search for any character.

The dot . matches any single character. For any string with one or more characters, a regex of . will
always return the first character. The other characters: ?,*,+,{} are for controlling how many characters
to match.

?: Matches zero or one character. While . will match any non-empty string, it won't match an empty
string. .? will match an empty string too.
*: matches zero to many characters. .* will match any string, empty or not.
+: matches one to many characters. .+ will match any non-empty string.
{min matches, max matches}: controls how many matches. For example, .{2}, will match the first two
characters of any string with at least two characters. .{3,5} will match the first three and up to five
characters of any string with at least three characters. .{5,} will match the entire string of any string
with at least five characters.

Character Ranges - The square bracket []
Now that we know that a dot . can match anything, the square brackets allow us to define specific
characters to search for. The definition inside the brackets define the different types of characters that
can be matched. For example, [ab] will match an 'a' or a 'b' (but not 'ab'). Like the dot ., the question
mark ?, asterisk *, plus +, and curly brackets {} work exactly the same to match more than one (or no)
character.

Key examples:

[1-9]: Match any digit 1 - 9 (but not zero)
[^1-9]: Match anything but 1 - 9. The hat ^ inside a square bracket means 'NOT'.
[A-Za-z] - Match any upper or lower case character
[\s]: Any whitespace character. This is an example of a 'character class'. Other common character
classes:

\w: Any word character
\d: Any decimal character
For advanced users, please see these supported character classes .

[\t]: Any tab character. This is an example of a 'character escape'. Other common character escapes:
\n: New line
\r: Carriage return
For advanced users, please see these supported character escapes

https://docs.microsoft.com/dotnet/standard/base-types/character-classes-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/character-classes-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/character-classes-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/character-escapes-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/character-escapes-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/character-escapes-in-regular-expressions
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Anchors - The hat ^ and dollar sign $
Anchors allow for controlling what part of the string the search criteria will focus on. The ^ anchors the
criteria to the beginning of the string and the $ anchors the criteria to the end of the string. For example,
^Bike would match 'Bike Pump' but not 'A Bike Pump' while Bike$ will match 'Bike' but not 'Bike Pump'.

For advanced users, there are more advanced anchors  that can be used.

Groups - The parentheses () and Bar |
The above sections provide the techniques to be able to perform basic searches for a single string. The
last set of special characters allow for searching for multiple strings within a string.

Surrounding a valid regular expression with parentheses creates a capture group. For example, the
regular expression Bike(.*) with an input string of 'A Bike Pump' would have an overall match of 'Bike
Pump' and a capture group of ' Pump' called '1'. Adding a second capture group would be referred to as
'2'. In the string match calculation, these numbered groups will be seen in the output column dialog:

To make it easier to identify a matched group, the group can be named using a question mark and angle
bracket. For example, Bike (?<BikeItem>.*) would change the capture group name from '1' to
'BikeItem'.

TIP

The dot and the square brackets, along with the matching quantifiers ?,*,+,{} make up the core of
most all regular expressions.



https://docs.microsoft.com/dotnet/standard/base-types/anchors-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/anchors-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/anchors-in-regular-expressions
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Grouping also supports the following useful techniques:

Alternative searches: The | is an OR operator between different searches. For example
(Bike|Bicycle) will find either 'Bike' or 'Bicycle'.
Non-capturing groups: The ?: syntax at the beginning of a group makes it a non-capturing group.
In other words, this capture group will not be seen in the output dialog. This can be a useful
performance or simplification solution.
For advanced users, please see other supported grouping constructs .

References
See the .NET Regex Language Overview  for the full documentation on the regular expression
engine we use.
See our Knowledge Base Article  for example usages of the calculation.

https://docs.microsoft.com/dotnet/standard/base-types/grouping-constructs-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/grouping-constructs-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/grouping-constructs-in-regular-expressions
https://docs.microsoft.com/dotnet/standard/base-types/regular-expression-language-quick-reference
https://docs.microsoft.com/dotnet/standard/base-types/regular-expression-language-quick-reference
https://docs.microsoft.com/dotnet/standard/base-types/regular-expression-language-quick-reference
https://support.reportsnow.com/hc/en-us/articles/4403449071763-Using-the-String-Match-Calculation
https://support.reportsnow.com/hc/en-us/articles/4403449071763-Using-the-String-Match-Calculation
https://support.reportsnow.com/hc/en-us/articles/4403449071763-Using-the-String-Match-Calculation
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Substring
Description
Select a specific portion of an input by choosing the beginning and end points for all characters in that
column.

Calculation Editor
Options

Input Parameter Values Input Values

Start Index Column or Literal (Required Integer)

Length Column or Literal (Required Integer)

Handle Errors Auto-correct, Blank resulting value, Report error

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Handle Errors Options: View examples below.

Auto-correct: If your start index or length do not match the input value(s) that are being used, the
auto-correct option will identify the needed fix and evaluate the substring calculation accordingly.

If the start index is greater than the length of the string, return a null string.
If the start index is less than one, the start index will be set to one automatically.
If the length is greater than the remaining characters in the string, just the remaining characters
will be returned.

Blank Resulting Value: If your start index or length do not match the input value(s) that are being
used, the blank resulting value option will return blank values in those records.
Report Error: If your start index or length do not match the input value(s) that are being used, the
report error option will return a grey box in all cells that had errors. This grey box will explain the
error if selected so the calculation can be edited.
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Examples
Example 1

Input: CAL87105SUB
Design > Calculations > Substring

Start Index: 4
Length: 5
Handle Errors: Auto-correct

Output: 87105

Example 2
Input:

Row 1: 8502Vendors Incorporated
Row 2: 9133ABC Vending

Design > Calculations > Substring
Start Index: 5
Length: 25
Handle Errors: Auto-correct

Output:
Row 1: Vendors Incorporated
Row 2: ABC Vending

The auto-correct handled the length being 25 even though the values weren't 25 characters long by
using the following logic: If the length is greater than the remaining characters in the string, just the
remaining characters will be returned.

Example 3 (Utilizing alternative Handle Error methods)
Input: 4423USX14K
Design > Calculations > Substring

Start Index: 5
Length: 8
Handle Errors: Blank Resulting Value

Output: Shows as blank
Reasoning: The number of total characters in the input string is shorter than 13 which is how
much the start index and length requested.

Next, let's just change the "Handle Errors" setting to "Report Error".

Output: See below.
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To Lowercase
Description
Allows any string input to be standardized to all lowercase values.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This calculation is culture sensitive and will use the culture identified by the user's Language setting in
default settings.

Example
1. Input: Suppliers National Association
2. Quick Calculations > Text > To Lowercase
3. Output: suppliers national association
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To Uppercase
Description
Allows any string input to be standardized to all uppercase values.

Calculation Editor
Options

Input Parameter Values Input Values

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
This calculation is culture sensitive and will use the culture identified by the user's Language setting in
default settings.

Example
1. Input: smile
2. Quick Calculations > Text > To Uppercase
3. Output: SMILE
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Trim
Description
Trim characters before or after a value.

Calculation Editor
Options

Input Parameter Values Input Values

Trim Delimiters Literal (Required)

Side Both, End, Start

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Remarks
Trim will only evaluate the sides that you select. It will not trim characters in the middle of an input value.

Example
1. Input: 00045032000
2. Design > Calculations > Trim

Trim Delimiters: 0
Side: Both

3. Output: 45032
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Trig Calculations
Arccosine : The inverse trigonometric function that gives the angle whose cosine is a given number.
Arcsine : The inverse trigonometric function that gives the angle whose sine is a given number.
Arctangent : The inverse trigonometric function that gives the angle whose tangent is a given
number.
Cosecant : The reciprocal of the sine function; for an angle in a right triangle, it represents the ratio
of the hypotenuse to the opposite side.
Cosine : A trigonometric function representing the ratio of the adjacent side of a right triangle to the
hypotenuse.
Cotangent : The reciprocal of the tangent function; for an angle in a right triangle, it represents the
ratio of the adjacent side to the opposite side.
Secant : The reciprocal of the cosine function; for an angle in a right triangle, it represents the ratio
of the hypotenuse to the adjacent side.
Sine : A trigonometric function representing the ratio of the opposite side of a right triangle to the
hypotenuse.
Tangent : A trigonometric function representing the ratio of the opposite side to the adjacent side in
a right triangle.
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Arccosine
Description
The inverse trigonometric function that gives the angle whose cosine is a given number.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Arccosine
3. Output: 38.46392
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Arcsine
Description
The inverse trigonometric function that gives the angle whose sine is a given number.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Arcsine
3. Output: 51.53607
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Arctangent
Description
The inverse trigonometric function that gives the angle whose tangent is a given number.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Arctangent
3. Output: 38.06094
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Cosecant
Description
The inverse trigonometric function that gives the angle whose cosine is a given number.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Cosecant
3. Output: 73.17696
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Cosine
Description
The inverse trigonometric function that gives the angle whose cosine is a given number.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Cosine
3. Output: 0.99990
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Cotangent
Description
The reciprocal of the tangent function; for an angle in a right triangle, it represents the ratio of the
adjacent side to the opposite side.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Cotangent
3. Output: 73.17013
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Secant
Description
The reciprocal of the cosine function; for an angle in a right triangle, it represents the ratio of the
hypotenuse to the adjacent side.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Secant
3. Output: 1.00009
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Sine
Description
A trigonometric function representing the ratio of the opposite side of a right triangle to the
hypotenuse.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Sine
3. Output: 0.03666
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Tangent
Description
A trigonometric function representing the ratio of the opposite side to the adjacent side in a right
triangle.

Calculation Editor
Options

Input Parameter Values Input Values

Units Degrees or Radians

Only Rollup If Generic Criteria

Input
Input Input Values Required

Input 1 Column or Literal ✔

Example
1. Input: 0.783
2. Quick Calculations > Trig > Tangent
3. Output: 0.01366
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Find Trends in Your Data
Trending gives you the power to find hidden, yet important, patterns in your data.

Quick Facts

You perform a trend by selecting a column, right-clicking it and selecting: Trending | ...

You specify your Trend using business language

Once you apply your Trend, you will see the results immediately

You can undo your trend by pressing the Undo button

You can modify the columns in the Trend by using Quick Calculations or Edit Calculations with the
Editor

Each trend has common options explained below

This section discusses many of the Calculation Columns that let you transform your data into the
format you need

Common Trend Options
The dialog box for each trend operation has the following options in common:

Option Effect

Show
summaries
only

Default checked. When checked, the resulting trend will collapse all groupings to the
summary level (thereby hiding the detail lines). When unchecked, the Trend will
show summaries and details.

Hide unused
columns

Default checked. When checked, the Trend will hide any column that does not have a
filter and is not a part of the Trend. When unchecked, the Trend will not hide any
columns.
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Show Your Top Ten and Bottom Ten Performers
Imagine you want to see your top ten customers or products. You can create this type of report with the
Rank Top Ten Trend:

1. Right-click a column in your grid that you would like to rank.

2. Select Trending | Rank Top Ten.

Sample screen shot

3. Enter the number of rankings you want to see: e.g. top 10, 25, 100, etc.

4. Select the column you want to rank. Data Access Studio will automatically populate this field with
the column you select in step 1.

5. Choose how you want to rank: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. E.g. Quantity Shipped. If you selected
Count in the previous step, then this field will be hidden.

7. Click  Ok.

To show the Bottom Ten, repeat the same steps above, except select Trending | Rank Bottom Ten.
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Organize Date Information
Imagine you want to see your items sold by last three months, current quarter, year-to-date, or year and
compare to the previous year. Organize Dates lets you do this over any reference date as follows:

1. Right-click a column in your grid that you would like to organize.

2. Select Trending | Organize Dates.

Sample screen shot

3. 3. Select the column you want to rollup for the year trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select how you want to calculate the date difference:

1. For the first date, select between a control panel date (recommended), a date grid
column or today's date.

2. For the second date, select a grid column. Note: the second date will be subtracted from
the first date.
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5. Choose how you want to trend: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. If you selected Count in the
previous step, then this field will be hidden.

7. Select the date organization you want. All choices that begin with Current do not have a
Number value. All other choices let you specify a Number. For instance, if you want the last
three months, enter Last Months and 3.

8. Enter a number in Compare to previous years to compare the defined organization for this
year to past years.

9. Click  Ok.
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Show Month Trends
If your data contains date information, you may want to see how your data changes by month. To see
month trends in your data:

1. Right-click a column in your grid that you would like to trend.

2. Select Trending | Month Trend.

Sample screen shot

3. Select the column you want to rollup for the month trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select the date column you want to use.

5. Choose how you want to trend: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. E.g. Sales Quantity. If you selected
Count in the previous step, then this field will be hidden.

7. Click  Ok.
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Show Day Trends
If your data contains date information, you may want to see how your data changes by day. To see day
trends in your data:

1. Right-click a column in your grid that you would like to trend.

2. Select Trending | Day Trend.

3. Select the column you want to rollup for the day trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select the date column you want to use.

5. Choose how you want to trend: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. E.g. Sales Quantity. If you selected
Count in the previous step, then this field will be hidden.

7. Click  Ok.
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Show Year Trends
If your data contains date information, you may want to see how your data changes by year. To see year
trends in your data:

1. Right-click a column in your grid that you would like to trend.

2. Select Trending | Year Trend.

Sample screen shot

3. Select the column you want to rollup for the year trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select the date column you want to use.

5. Select the year range you would like to run.

6. Choose how you want to trend: Sum, Count, etc.

7. Choose the column you want to use as the ranking quantity. If you selected Count in the previous
step, then this field will be hidden.

8. Click  Ok.
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Organize Your Data into Aging Ranges
If your data contains date information, you may want to see how your data changes by a user-defined
time interval. To see aging trends in your data:

1. Right-click a column in your grid that you would like to trend.

2. Select Trending | Aging.

Sample screen shot

3. Select the column you want to rollup for the year trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select how you want to calculate the date difference:

1. For the first date, select between today's date, a date grid column or a report parameter.

2. For the second date, select a grid column. Note: the second date will be subtracted from the
first date.

3. Select the units for the date difference: Days, Months, or Years.
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5. Choose how you want to trend: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. If you selected Count in the previous
step, then this field will be hidden.

7. Select the bucket ranges you want. You may edit the existing ones and add and delete ranges as
you need.

8. Click  Ok.
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Turn Row Values into Column Values
When you need to do side-by-side comparisons, you can use the Cross Tabular Trend to convert row
values into column values:

1. Right-click a column in your grid whose distinct rows you would like to convert into columns.

2. Select Trending | Cross Tabular.

Sample screen shot

3. Select the column you want to rollup for the year trend. Data Access Studio will automatically
populate this field with the column you select in step 1.

4. Select the column whose distinct rows you want to convert to columns. E.g. if your rows had Union
Code information, then the Trend will create a new column for each distinct Union Code.

5. Choose how you want to trend: Sum, Count, etc.

6. Choose the column you want to use as the ranking quantity. If you selected Count in the previous
step, then this field will be hidden.

7. You can append multiple Cross Tabular Trends to create Dashboards. If you want to replace the
previous Cross Tabular Trend, click Remove previous CrossTab columns.

8. Click  Ok.
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Only Rollup If
Most calculations will have a parameter named Only Rollup If. You can edit this parameter to have any
condition you need that specifies whether you want the calculation value to apply. For instance, let's say
you had a calculation that calculates the total price. You could edit the Only Rollup If parameter to
specify that you only want the total price to apply if the customer has paid on time. Once you set the
condition, then the total price will only have a value if the condition is met.
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Export and Print Results
Data Access Studio provides quick and easy exporting and printing.

See Export and Print for instructions on how to export your grid data.
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Set Default Printing Preferences
Data Access Studio provides the ability to specify printing preferences for each layout:

1. Open a Layout

2. Click Design | Printing Preferences...

To Do this

Change margins Enter values for Left, Right, Top, or Bottom.

Change the orientation of the printout Click Portrait or Landscape.

Hide or show the filter row on the
printout

Check Show Filter Values to show filters. Uncheck to hide
filters.

Change the paper size Click on the Paper Size options box. Select paper size from
list.

Change the Embed Excel Print Driver Use the visual assist to select a print driver on your
workstation. If you are the administrator on your workstation
(or if your administrator installed the ReportsNow PDF print
driver) you can select this print driver to print to PDF.

If you have another PDF print driver, you can select it here so
that when you print from Embed Excel, the print
automatically converts it to a PDF. You can also click the
Preferences... button to change the settings of the print
driver.
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Define Basic Header and Footer
Data Access Studio provides the ability to specify a report header and footer to any Layout. Once
defined, the header information such as page numbers and title will export to formatted types such as
PDF, HTML and printer outputs. When you press save on the layout, the header/footer information will
be saved with your layout.

To define a header and footer for your layout, click on Export | Header and Footer... on the main menu
bar.

This form has six areas for you to add text: 3 areas in the header representing left, center, and right; and
3 areas in the footer for left, center, and right.

In addition to typing text into these areas, you may double-click the Variables listed in the window to
the left to add dynamic information such as:

Page number and total number of pages

Page number

Date printed

Time printed
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User

Layout name

Published or private

Date and time that the layout was last saved

Date and time that the last fetch operation from the server began

Date and time that the last select operation from the server began

Report Parameters - shows all Report Parameters as a block of field/value pairs

System level variables (See: SystemVariables)

By default, a layout will have the Layout Name in the center of the header and the page number in the
right hand corner of the header.



03/23/2026 Data Access Studio User Guide 8.0.16

© 2026 - ReportsNow Inc. 449 / 480

Specify an Area to Print
Data Access Studio allows you define a set of grid columns as the "Print Area" of the layout. This feature
is useful if you need to see certain columns in the interactive grid but not in the printout.

To Do this

Define a
Print
Area

Highlight the grid columns that you want to print. Click each
desired Column Header. SHIFT+click will select all columns
between clicks. CTRL+click will add each column to the selection.
Right-click on the selected column headers and choose: Print
Area

Set To
Selected
Columns.

Clear the
Print
Area

Select Design Print Area Clear.

Show the
Print
Area

Once the print area is defined for a layout, you may want to see
which columns comprise the Print Area. To highlight these
columns, select: Design

Print Area Show.
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Set export options
To set preferences for each export operation, select Export | Export Settings...

To Do this

Change the default directory
where Data Access Studio will
store exports

Enter a path under Export Directory. You may use the Visual Assist
to find the directory visually.

Open file after export Check Open file after export. If unchecked, the export will write file
to the export directory and only notify you that the export has
finished.

Automatically name the export
and export to default directory

Default checked. When checked, the export will name your
exported file automatically and copy it do the default directory.
When unchecked, the export will prompt you for the file name.
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Document Your Report
You can place How to Use Notes and Design Notes in any report.

 

Additionally, DAS generates "at-a-glance" design information about any report including:

Filters (hidden or shown)
Grouping
Parameters and variables
Calculations
Hidden columns
Sorting
Template information
and more
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How to Use Notes
How to Use Notes are available for all viewers of a report in DAS as a mechanism for viewing notes
created by a designer.

These notes could include things like...

The purpose of the report
The meaning of the report's parameters/filters
How to interpret results

To add or edit How to Use notes for a report:

1. Open a report
2. Click How to Use Notes button on main toolbar

Understand How to Use Icon States
There are three different appearances the How to Use icon can take on based on what information is
present in that report.

Icon Description

If the icon looks like this, it means the report is private and there is no text inside of the
How to Use notes

If the icon looks like this, it means there is text inside of the How to Use notes (this will
show up for Private or Public reports)

If the icon looks like this, it means the report is public and there is no text inside of the
How to Use notes

How to Use Notes Options
Inside of How to Use Notes, the window will appear similar to Microsoft Word with tabs at the top to
assist in formatting.
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Design Notes
Design Notes are available for Designers in DAS as a mechanism for viewing Generated Notes and User
Notes related to the report.

View Design Notes
1. Open a private report
2. Click Design > Design Notes

Generated Notes
DAS automatically generates "at-a-glance" information about the report in the Generated Notes tab.

Important information included in the Generated Design Notes includes...

Table of Contents: Selecting any header in the table of contents will scroll the user to that location in
the Generated Notes. Includes all sections listed.

Query Table & Last Select: This returns the specific tables utilized in the report (ex: F0411) as well as a
list of the filters utilized in the Report Run process.

DAS Report Performance: This critical section shares the processing time for the report. Once the Select
and Load process occur, any calculations in a report are processed. As a default behavior, DAS generates
processing times for each calculation. It then highlights the fastest third in green and slowest third in red.
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Calculations: To learn more about a calculation, go to Design > Calculations. This view simply gives the
user an idea of what calculations are used and what inputs were provided to the calculations.

Compare Report Run Times Easily
Let's say a user wants to compare the processing speed of a report based on two different filters.

To compare multiple runs of the same report, do the following:

1. Run a report (Or Get Sample Data)
2. Select Design > Design Notes
3. See the Generated Notes tab
4. Minimize the Design Notes window or simply select back to your report without closing
5. Adjust the report as needed (Ex: Adjust a filter)
6. Run the report again (or Get Sample Data)
7. Select Design > Design Notes again to see the additional tab of Generated Notes with the time it

was run

NOTE

Be sure to check the processing times rather than relying on the color coding, red calculations could
still be extremely fast.


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User Notes
The User Notes tab available at the bottom of your Design Notes dialog looks the same as the How to
Use notes. The difference is because these User Notes are only accessible within the Design menu, they
are a better place to type information about the creation and structure of the report rather than
information good for the Subscriber to view to understand the report.
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Make Your Report Run Faster
Data Access Studio uses many automatic performance techniques to make your report run fast. You can
do the following additional techniques to make your report go faster as well:

Symptom Do This

Report takes a long time to
Select or Count

Use the Quick Form Assistant to create parameters for filtering that
match database indexes. Additionally, analyze Design Notes to
confirm what filters are being applied at the database and match those
against known database indexes.

Reports take a long time to
load large number
(>100,000) of rows

1. Add more filtering. Try to reduce the number of rows by adding
more filters.

2. In a single table report, hide any unused columns. The fewer
columns you have, the faster a larger data set load will go.

3. A DASVIEW is automatically created for table joins, but one can be
created on singular table reports by selecting Design > Table Joins. If
you are using a DASVIEW, remove columns from the table join selector
that are not used. The fewer columns in a report, the faster a larger
dataset load will go.

Calculating takes a long
time with Table Lookup
calculations

Consider using a Table Join instead of a Table Lookup. When Table
Lookups are required, users may consider adjusting the Bulk Fetch
Key setting. This setting determines how many queries are bundled
and sent to the database at one time. Learn more in the Table Lookup
calculation documentation.

Report loads > 100,000
records over a WAN
connection

If you are loading a large number of records over a slower network
connection, consider scheduling the report to run on the DAS Web
Server. Once the report runs there, the scheduler can email you the
result. You must have the Automator license for this option.

An interactive report that
summarizes a large amount
of data but does not require
the detail data

If allowed, leverage the Database and/or Server Summarization feature.
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Quick Form Assistant

The Quick Form Assistant lets you create better running queries on large tables. The Quick Form
Assistant option box shows a list of all valid indices for the currently active object. You should show all
columns before using the Quick Form Assistant. Upon selecting an index from this list, Data Access
Studio creates report parameters based on the index you choose (existing parameters will be left
untouched at the top).

Once you apply the index:

To take advantage of an index, select an index that most closely matches the query you require.

Notice the index columns appear as report parameters.

Fill in index values from top most to bottom most. Remember, the database will not use an index if
you do not fill in values from the beginning of the index. For instance, if your index is "Doc Type",
"Document Number", and "Doc Co", the index will not be used if you only specify values for only
"Document Number" and "Doc Co". All left-most index columns must be specified first for the index
to take effect.

Depending on the database, even if you specify all fields of an index, the database will not always
use that index. In this event, the database decides that another execution path will provide better
performance. If you notice that a fully specified index does not result in a fast query, please notify
your JD Edwards (EnterpriseOne/World) database administrator. Provide your Database
Administrator (DBA) with the index columns you used and the time the query took to run.

To undo the Quick Form Assistant, simply select the blank Index at the top of the combo box. DAS
will remove any Quick Form indexes from your report.

Server and Database Summarization
Many reports display summaries of large amounts of data. For example, a report may show the total
number of orders by customer or the average order amount by month. By default, DAS will download all

NOTE

To easily review performance metrics on your report, utilize Design Notes.

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the data to the client and then summarize it. This can take a long time and use a lot of bandwidth. But
what if the recipients of this type of report only need the summary information? In this case, it is much
faster to summarize the data on the server or database and then download only the summary
information.

DAS provides the capability for different types of server-side summarization (via group-by SQL
operations and/or DAS server summarization):

Summarize on Server: This option summarizes the data retrieved from the database on the DAS
server before sending it to the client. This may provide improved performance for allowed reports
(see report restrictions below), but it may not be as fast as summarizing on the database.
Summarize on Database: This option summarizes the data on the database server before sending
it to the DAS server. This will usually provide the best performance, but it is only available for certain
types of reports.

Key User Security Permissions
The following permissions are required to see the Summarize on Server and Summarize on Database
options in the right-click menu of a grouped column:

1. User must have the Can do grouping on server permission to see any Summarize on Server
options

2. User must have the Can enable sort and grouping at database permission to see the On
Database option

NOTE

The option to summarize on database or server is only shown on the group column right-click
menu. Since only summarized records are included on the report, reports that need to display detail
information cannot use this feature.


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Summarize on Server
Server-side summarization is different from database summarization in that this mode will query the
database with SQL that does not include groupings or aggregation. The DAS server will then summarize
the data before sending it to the client. This option is available for more report configurations, but it may
not be as fast as summarizing on the database. After selecting this option and re-running the report, you
should see fewer detail records under each group in the report. The report should also run much faster
and use less bandwidth and memory.

This option will consume CPU and memory resources on the DAS server but will not consume additional
resources on the database server.

Summarize On Server Requirements
Even with a grouped report and the appropriate permissions, the server summarization option is not
allowed on reports with any of the following conditions:

1. Report uses Count or Average summaries on any column (hidden or visible).
2. Report uses any of these calculations (hidden or visible):

1. De-duplication
2. Parent/Child

IMPORTANT

The reason these permissions are required is that summarization will impact CPU and memory
usage on the database and/or DAS server. Sending all detail data to the client and allowing it to
summarize is much less resource-intensive for the shared server resources. Therefore, the DAS
administrator may choose to limit these permissions to only certain users or groups of users. If you
do not see the options in the right-click menu, please contact your DAS administrator for assistance.


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3. Random Row Index
4. Conditional that uses the multiplication option
5. Math and Statistical Functions: Absolute Value, Average, Ceiling, Floor, Ln, Log, Median,

Multiplication, Power, Sign, Square, Square Root, Remainder, Truncate, Uniform Buckets

Summarize on Database
This option will summarize the data on the database server using standard SQL Group By operations and
Aggregation functions. If the report structure fits the requirements, this option will usually provide the
best performance. After selecting this option and re-running the report, you should see far fewer detail
records under each group in the report. The report should also run much faster and use less bandwidth
and memory.

This option will consume CPU and memory resources on the database server but will not consume
additional resources on the DAS server.

Summarize On Database Requirements
The database summarization option is not allowed on reports with any of the following conditions:

1. All restrictions listed in the Summarize on Server section above
2. Report uses First summary on any data column (hidden or visible)
3. Report is based on a union
4. Report has any non-numeric data columns with summaries (hidden or visible) (E1 limitation only.

These columns are supported in World and with External Data)

Server and Database Summarization FAQ
1. Why is there more than one record under each group after summarization? Shouldn't each

group contain just a summary record?
The additional records are the result of additional hidden groupings added to the
summarization request. These additional groupings are from inputs into calculations or other
report features. These additional groupings result in additional records under the visible main
grouping of the report.
If there are a large number of dependencies in the report resulting in the detail rows not being
much smaller than when Summarize on Server is off, this feature may not be a useful technique.

NOTE

A report that has server or database summarization enabled will no longer summarize on the server
or database if one of these calculations is added. Therefore, it is important to carefully design and
maintain the report for summarization from the beginning.


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Instead, consider limiting dependencies before changing the summarization behavior.
2. Why are the summarization options still disabled after removing unsupported calculations?

Verify that only the needed columns have summaries. Even if a column is not visible, if it has a
summary, it will be considered in the summarization process. If the column is not needed,
remove the summary. Note that some calculations might auto-add summaries to the report in
possibly hidden columns.

3. Do subscribers need to have the same permissions as a designer to run a report with server or
database summarization?

No. A report leveraging server or database summarization will still execute on the server or
database even if the subscriber does not have the permissions.

4. Why are my report results different when I summarize on server than when I'm not
summarizing on server?

If you are performing computations on a summarized value whereas before the computation
was done on a detail value (which is no longer returned due to summarization behavior), the
results of the report may differ. Be sure to cross check any report results when switching to
summarize on server.

5. Why aren't Math or Statistical Functions allowed to be used for reports with summarize on
server?

Some math and statistical functions - like averages - require access to all the underlying data to
calculate accurate results. When Summarize on Server is enabled, the server may group and
total data early, before these functions are applied. This changes the order of operations and
can lead to unexpected results.
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Advanced Designers
User level JDE Knowledge Can Design Reports Technical Knowledge

Subscriber Not needed No Minimal

Quick Report Designer Minimal Yes Minimal

Ad Hoc Designer Yes Yes Some

Advanced Designer Yes Yes High

This section is for technical users who have mastered the basic Ad Hoc report techniques. This section
describes technical calculations and operations that you will need to create more challenging reports.

Topics in this section include how to:

Fine Tune Grouping and Summarization
Connect a Report Parameter to a Calculation
Create a Table Join from Scratch
Edit Calculations with the Editor
Perform Calculations
Show Additional Information About a Table
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Create a Table Join from Scratch
Data Access Studio lets you combine information from multiple tables -- which is referred to as a Table
Join:

1. On the Homepage click the New icon and click Custom join report. (Or click File | New | Custom
Join from the main menu.)

Select a Join Type:

Join - Joins combine columns from multiple tables together. You will use join operators to connect
rows together in your join. There might be duplicate rows.

Distinct Join - Same as a regular join except all duplicate rows are removed. This type will not
perform as well as a regular join.

Union All - Combines rows from multiple tables together. Because only rows are being combined,
the selected columns from both tables need to be exact. There might be duplicate rows. When
working with unions, the 'Suggested Joins' and 'Actual Joins' tabs are not needed and are hidden.
For JDE, not only do the selected columns need to be the same but the column order must be the
same. JDE Xe does not support Union All (but it does support Distinct Unions).
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Distinct Union - Same as a regular union except that duplicate rows are removed. This type will not
perform as well as a regular union.

Proceed to define your join as follows:

1. Select Tables to Join
2. Select Join
3. Select Columns
4. Working with Your Custom Table Join
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Select Tables to Join
The first step to combining multiple tables is to list the tables you want. Click the Tables tab:

To Do this

Add a table by its
description

Click on the Visual Assist in the Table column. From the resulting form, type
the table description in the Description field.

Add a table by its
object name

Directly type in the table name in the Table column.
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NOTE

As of JDE E1 Tools Release 9.1.5, you can join up to 15 tables in any type of join. Prior to that
release, you could only join up to 3 tables if you use a one-to-many (OUTER) join. If you only use
one-to-one (SIMPLE) joins, then you may only add up to 5 tables.

In JDE World and External Data, you join up to the maximum number of tables the database will
allow.


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Select Join
Once you have defined the tables you want to combine in the Tables tab, you can click the Suggested
Joins tab:

If Data Access Studio finds a relationship between your tables, it will list it on the Suggested Joins tab.
To select a join, highlight the join you would like to use and click Apply Suggested Joins. Depending on
the tables, sometimes information in the Suggested Joins may be blank. In this case, click the Actual
Joins tab to Define the join manually.
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Define a Join Manually
If you have more than one table, you must define at least one join condition for each table.

If there are no Suggested Joins or you need to edit your join:

1. Click the Actual Joins tab:

2. Select the type of join under the Join Type column
3. Enter the first table in Table 1
4. Enter the first field in Field 1
5. Enter the Relation (this is normally =)
6. Enter the second table in Table 2
7. Enter the second field in Field 2

Join concepts
There are four join types available: SIMPLE, LEFT OUTER, RIGHT OUTER, and SQL 92 LEFT OUTER.

SIMPLE JOIN
A SIMPLE join is a one-to-one relation: the value for Table 1 and Field 1 MUST match the value of Table
2 and Field 2 (these examples presume the Relation field is "="). When this match occurs the result is
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one row for that match. If the target table does not have a match for the source table row, then no row is
returned to the grid.

LEFT OUTER JOIN
A LEFT OUTER join is a one-to-many relation: the value for Table 1 and Field 1 matches the value of
Table 2 and Field 2. Unlike the SIMPLE join, if the Table 2 and Field 2 value does not match, then the
query still returns a row for Table 1 and Field 1. The Table 2 fields in this instance will all be null (you
can search for null fields using the <BLANK> filter). Use a LEFT OUTER join for:

1. Drill down reports - If you do a LEFT OUTER join between a header table and a detail table, then
your report will be able to drill down between the header (summary) records and the detail records.

2. Integrity reports - If you have a header table and want to know which headers have no child records,
then use a LEFT OUTER join.

RIGHT OUTER JOIN
A RIGHT OUTER join is the same thing as a LEFT OUTER join except Table 1 and Table 2 are swapped. Use
a RIGHT OUTER join, for instance, to identify detail rows that do not have a header row.

SQL 92 LEFT OUTER JOIN
The above outer joins are not SQL 92 compliant. Those joins will add an 'OR NULL' clause to all filtering
on the secondary table. This is to ensure that unmatched primary records are also returned. However, in
some cases, a SQL 92 compliant outer join is required. In such cases, use this join type but be aware that
row or masking security filters will cause unmatched primary table rows to not appear in the results.

IMPORTANT

Any filter on the secondary table (right table) will have 'OR NULL' added to it. This is to ensure that
unmatched primary (left table) records are also returned.
This also ensures that row or masking security filters do not unexpectedly cause unmatched primary
table rows to be omitted.



IMPORTANT

Any filter on the secondary (left table) table will have 'OR NULL' added to it. This is to ensure that
unmatched primary (right table) records are also returned.
This also ensures that row or masking security filters do not unexpectedly cause unmatched primary
table rows to be omitted.


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Special Considerations when Converting from a Native E1
Business View
Unmatched rows in non-string columns (such as numeric or date) will show blank instead of a default
value (like zero) when converting a native E1 view to a DASVIEW. A SQL 92 LEFT OUTER JOIN will behave
like native JDE views and continue to show default values for unmatched rows.

NOTE

This join type is only available for JDE E1 8.11 and later.

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Select Columns
Perhaps the easiest part is the last part: selecting the columns you want.

1. Click the Columns tab

This is where you select the columns that you want for your report.

To Do this

Search for a column by
name

Type in the name of the column in the Filter Box under Description

Select a column Check the columns you want in your join. The fewer columns that you
select for your report, the better your report will perform.

Hide all columns Click Hide All Columns.

To create the join based
on all information
entered

Click  Create report. Data Access Studio will attempt to create the join
with the information provided. If there are errors, Data Access Studio will
popup the errors and how to resolve each.
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To Do this

To cancel your changes Click  Cancel

This is an example of selecting columns for a union. Only the columns of the primary table will be shown.
All the selected columns of the primary table must exist in the other tables. For JDE E1 and Xe, the
columns must also be in the same order as the primary table.
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Working with Your Custom Table Join
After you create your join, you may edit it at any time:

1. Click Design | Table Joins

2. Edit the join as you need
3. Click OK to save changes and submit queries with your view
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Show Additional Table Information
Data Access Studio provides developer-related information about Tables and Views. To access this
information, click the Additional Table Information option box on the main toolbar:

To Do This

See detailed table information Select Summary.

See detailed column information Select Columns.

See detailed index information Select Indices.

See detailed join information (for business views) Select Joins.
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Web (mobie®) Publishing
Mobie (mobie®) is the ReportsNow data warehousing tool for dashboards and ProReports. When
publishing to mobie...  is selected from the designer, you are given the options to publish the user

interface (ProReport or dashboard), the data, or both.

mobie databox (database)

mobie portal

DAS Designer

Report 
Data

Dashboard 
or 

ProReport

The Portal provides internet access to view the Dashboard or ProReport in a URL. The mobie database
stores that data from the report. This data can then be routinely refreshed.

Publishing UI and Data
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The default mode is to publish both the user interface (ProReport or dashboard) and the underlying data
(regular DAS report). Most of the time, this is what you will want to use. Under Components, this is the
"Dashboard and Data" option.

Setting the data refresh schedule (Recurrence) will create an Automator task in the Scheduler. After its
creation, the schedule can be maintained here or in the Automator.

Considerations
The data refresh schedule (Recurrence) is tied to the underlying report (for a given snapshot name)
and not the user interface (dashboard or ProReport component). To update the appearance of a
dashboard or ProReport in mobie, the user must re-publish to mobie from DAS.
If you have more than one dashboard or ProReport over the same underlying report and snapshot
name's refresh schedule, all the viewers will be refreshed on that refresh schedule.
If you want different viewers to share the same underlying report, but have different data refresh
schedules and/or parameters, you must use different snapshot names when setting up the
schedules. Each snapshot name will be associated with it's own Automator task that allows for
parameter overrides as well as refreshing to apply only to viewers tied to that snapshot.

Data Snapshots
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Individual data snapshots by default are assigned to all mobie users. Un-checking 'Assign to all' allows
for individual assignment of snapshots. This is useful to assign snapshots to different groups for the
purpose of providing different snapshots of data to a user (assuming the user is part of multiple groups).
See prompting of snapshots for dashboards and/or ProReports for information on how you will select
snapshots on the portal.

Publishing Only UI
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Changing 'Components' to 'ProReport Only' or 'Dashboard Only' allows you to publish just the UI
component and not the underlying data. This is especially useful if it takes a long time to publish the
data or changing the data could upset a production component.

Publishing Only Data

NOTE

This mode is the default setting if the designer is set to databox mode ('Data Source' ribbon is set
to something other than 'Reports'). Databox mode is very useful and efficient once the data has
been mostly defined and there isn't a need to re-publish data.


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Changing 'Components' to 'Data Only' allows you to publish just the underlying data. You would do this
if you have changed the filtering of the data but do not want to publish a UI change. You can also
change the data refresh schedule in this mode.

NOTE

While you can publish to a new snapshot name, it is not possible to assign this new snapshot to any
user from this dialog.


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